
Trillium Software System™
Installation Guide

Version 15.7 December 2017



   
This manual, as well as the software described in it, are furnished under 
license and may be used only in accordance with the terms of such license. 
The content of this manual is furnished for informational purposes only, is 
subject to change without notice, and should not be construed as a 
commitment by Trillium Software. Trillium Software assumes no 
responsibility or liability for any errors or inaccuracies that may appear in 
this manual.

The customer shall not disclose, copy, reproduce, distribute, or display any 
portion of the Trillium Software System or this manual in any form to any 
third person without the prior written consent of Trillium Software, nor allow 
third parties to do the same. The customer shall keep the Trillium Software 
System and all confidential information in the strictest confidence.

Trillium Software System Installation Guide    
12617

Trillium Software, Inc. owns all rights in and to the marks "TRILLIUM 
SOFTWARE" and "TRILLIUM SOFTWARE SYSTEM," which marks are 
registered in various countries throughout the world (including, without 
limitation, the United States Patent and Trademark Office).

All other trademarks are the property of their respective owners.

© 2017 Trillium Software, Inc. 

Trillium Software, Inc
1700 District Avenue, Suite 300, Burlington, MA 01803, USA

978-901-0000 (Worldwide Headquarters)
+44 (0) 118-940-7676 (European Headquarters)



Contents 
Contents

Preface ........................................................................................................9

CHAPTER 1 Requirements and Checklists.................................. 11

TSS Important Changes.................................................... 11
TSS Components .............................................................. 14
System Requirements for TSS .......................................... 15

Minimum Requirements: Control Center ...................... 15
Minimum Requirements: Repository Server ................. 17

Installation Checklist for UNIX .......................................... 19
Installation Checklist for Windows .................................... 22
Defining User Accounts..................................................... 23

Defining User Accounts on UNIX .................................. 23
Defining User Accounts on Windows ............................ 26

Backing up Existing Repositories....................................... 32

CHAPTER 2 Installing the Repository Server ............................ 33

Installing the Repository Server on UNIX.......................... 34
Verifying the Installation Checklist on UNIX................. 34
Preparing to Re-use an Existing Repository.................. 35
Installing the Repository Server on UNIX..................... 38
Specifying Variables for UNIX ...................................... 45
Examining Directory Structures and Files on UNIX....... 46
Activating Trillium Software System License on UNIX .. 47
Starting the TSS Scheduler on UNIX............................ 48
Starting Apache Tomcat on UNIX................................. 48
Starting TSS Rest APIs on UNIX .................................. 49

Installing the Repository Server on Windows ................... 50
Preparing to Install the Repository Server on Windows 50
Preparing to Convert an Existing Repository Server on   
 Windows..................................................................... 51
Installation Steps on Windows ..................................... 53
Trillium Software System Installation Guide 3



Contents
Examining Directory Structures and Files..................... 68
Activating Trillium Software System License on  
 Windows.............................................................. 69
Starting TSS Scheduler on Windows ............................ 70
Starting Apache Tomcat on Windows........................... 71
Starting TSS RestAPIs on Windows.............................. 73

CHAPTER 3 Installing TSS Country Templates ......................... 74

Installing the Country Templates on UNIX ........................ 74
Using the InstallShield Wizard ..................................... 75
Using the Console Mode............................................... 80

Installing the Country Templates on Windows .................. 83

CHAPTER 4 Installing the Control Center .................................. 90

Installation Checklist ....................................................... 91
Installing the Control Center............................................. 92
Examining Directory Structure........................................ 100

CHAPTER 5 Installing the Batch Deployment Tool ................ 101

Installing the Batch Deployment Tool on UNIX................ 102
Installing the Batch Deployment Tool on Windows.......... 104

CHAPTER 6 Installing TS Reporting Adapter........................... 111

What Do You Need To Install? ........................................ 112
Installing ODBC 32-Bit Reporting Adapter....................... 113

Configuring ODBC DSN ......................................... 119
Installing ODBC 64-Bit Reporting Adapter....................... 122
Installing OLE DB 64-Bit Provider ................................... 125

CHAPTER 7 Installing EDQ ........................................................... 127

About EDQ...................................................................... 127
Installing EDQ on Linux .................................................. 128

Installing TS Quality for Real Time............................. 130
Installing TS Quality for SAP...................................... 135
Completing Installation.............................................. 140
Environment Variables - Linux ................................... 142

Installing EDQ on Windows............................................. 143
Installing TS Quality for Real Time............................. 148
4 Trillium Software System Installation Guide



Contents 
Installing TS Quality for SAP...................................... 155
Completing Installation.............................................. 165
Environment Variables - Windows.............................. 167

Starting the Apache Tomcat Web Server ........................ 167
Setting Table Locations................................................... 168
Running 64-Bit and 32-bit Concurrently.......................... 170
Improving Performance .................................................. 171

CHAPTER 8 Installing Postal Directories.................................. 172

File Naming Conventions ................................................ 173
EDQ Postal Tables........................................................... 176

EDQ Tables Directory................................................. 177
Default Installation Locations.......................................... 178
Defining Alternative Postal Table Locations..................... 179

Defining EDQ 64-Bit Table Locations.......................... 180
Defining 32-Bit Table Locations ................................. 182

Installing on Windows and UNIX..................................... 185
Installing the Files into a Temporary Directory........... 186
Validating File Integrity.............................................. 187
Installing the Files into the Production Directory ........ 189
Copying City Tables ................................................... 189

CHAPTER 9 Troubleshooting........................................................ 191

Error: Could not create file ............................................ 191
Error: Writing to File 
TrilliumSoftware.DirectorManagerLib.dll.......................... 192
Error: Permission Issues when Building Repository 
Environment on Linux..................................................... 193
Error: PANIC: Not enough space BDB Unable to join the 
environment ................................................................... 193

CHAPTER 10 Uninstalling TSS on UNIX ...................................... 194

Uninstalling the Country Templates ................................ 195
Uninstalling the Repository Server .................................. 196

Before You Begin ....................................................... 196
Stopping TSS Scheduler on UNIX............................... 196
Stopping TSS Rest APIs on UNIX ............................... 197
Trillium Software System Installation Guide 5



Contents
Removing Data Import Locations............................... 197
Removing TSS Binary Files ........................................ 198
Removing the TSS Repository.................................... 198
Removing Entries in Services File .............................. 199
Removing Entries from inetd.conf File........................ 199

Uninstalling the Batch Deployment Tool.......................... 200
Uninstalling Enterprise Data Quality (EDQ) 64-bit........... 201

CHAPTER 11 Uninstalling TSS on Windows ............................... 202

Uninstalling Country Templates ...................................... 203
Uninstalling the Repository Server .................................. 203

Removing Data Source Import Locations ................... 204
Stopping TSS Scheduler Service ................................ 204
Stopping TSS Apache Tomcat .................................... 205
Stopping TSS Rest APIs service ................................. 205
Stopping TSS inetd Service........................................ 205

Uninstalling the Control Center ....................................... 210
Uninstalling the ODBC 32-Bit Reporting Adapter............. 210
Uninstalling the OLE DB 64-Bit Provider.......................... 211
Uninstalling the ODBC 64-Bit Reporting Adapter............. 212
Uninstalling the Batch Deployment Tool.......................... 212
Uninstalling Enterprise Data Quality (EDQ) 64-bit........... 213
Removing Post-Installation Files ..................................... 213

Archiving Post-Installation Files ................................. 214

APPENDIX A   Installing TS Quality Core Only ............................ 215

Installing TS Quality Core Only on UNIX ......................... 216
Uninstalling TS Quality Core Only on UNIX ................ 217

Installing TS Quality Core Only on Windows ................... 218
Uninstalling TS Quality Core only on Windows .......... 222

APPENDIX B   Installing Standalone TS Web Server ................. 223

Understanding Configuration .......................................... 224
Installation Checklist ..................................................... 225
Installing Standalone TS Web Server.............................. 226
Starting and Stopping TSS Rest APIs Service ................. 231
6 Trillium Software System Installation Guide



Contents 
Uninstalling Standalone TS Web Server ......................... 231

APPENDIX C   Converting/Upgrading an Older Repository 
Server to v15.x.......................................................... 234

Converting Pre TSS v14 Repositories .............................. 234
Requirements ............................................................ 235
Converting an Older Repository to TSS v15.x ............ 236

Upgrading TSS v14 or v15 Repository ............................ 239
Requirements ............................................................ 239
Upgrading an Older Repository .................................. 240

APPENDIX D   Retaining Customizations During Upgrade ....... 241

Retaining Changes in config.txt Files .............................. 242
Retaining Changes in server.xml Files............................. 243

APPENDIX E   Configuring Vendor-Supplied ODBC .................... 244

Configuring ODBC Source Connections ........................... 244
Determining Configuration......................................... 245

Installing TSS Vendor ODBC Adapter ............................. 246
Create or Validate ODBC System DSN ....................... 251
Running the TSS ODBC Component on 64-Bit System251
Validate Login Access to the ODBC Source................. 251
Working with Excel Spreadsheets .............................. 251

Setting Up Oracle/IBM DB2 Data Source Connections..... 252
Validate Access to the Relational Source.................... 255

Troubleshooting Sybase.................................................. 255

APPENDIX F   Installing the SAP Add-On and  
  Support Packages .................................................. 256

Pre-Installation Checklist ................................................ 257
Supported SAP Versions ................................................. 259
Installing the SAP Add-On .............................................. 260
Installing the SAP Add-On for SAP ERP 6.0 ..................... 261

Initial and Upgrade SAP Add-On Installation .............. 261
SAP Add-On Support Package Installation (ERP)............. 275
Trillium Software System Installation Guide 7



Contents
Installing the SAP Add-On for SAP CRM ..................... 284
CRM WebClient Components........................................... 322
Post-Installation Checklist............................................... 323

Index ....................................................................................................... 325
8 Trillium Software System Installation Guide



Preface 
Preface

The Trillium Software System Installation Guide describes how to install TSS 
and components like TS Repository Server, Country Templates, Control Center, 
Batch Deployment Tool, EDQ, and so on. Included are checklists for you to ver-
ify the completion of each phase of the multi-level installation process. Also 
included are procedures for upgrading or converting existing repositories. Each 
chapter is organized by logical sequence of installation steps. 

The TSS installation paths documented in this guide are for Windows 
7 and UNIX environments only. If you are installing TSS in another 
environment, your installation path may differ from what is 
documented in the guide.

Intended Audience
This document is intended for system administrators who will install Trillium 
Software System. On UNIX systems, the system administrator needs root 
access for some configuration.

Related Documentation
To access the TSS manuals and TSS Help, click the Help option on the Control 
Center ribbon. Alternately, access documentation from the Windows Start 
menu. (Select Start > All Programs > Trillium Software > TSS 15 > Doc-
umentation.) The documentation set consists of the following guides:

 Technical Bulletin: Install and Directory Structure Changes in TSS 
v15.0.0 - contains information on changes in v15.0.0 to the installation 
paths and directory structures.

 TSS Repository Administrator’s Guide - contains instructions for setting 
up repositories, users, and loader connections. 

 TSS Beyond the Basics - provides supplemental information, sample 
tutorials and in-depth analysis of key TSS concepts and processes.
Trillium Software System Installation Guide 9
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 TSS Help 
You may also want to visit the Trillium website at:
http://www.trilliumsoftware.com 
This site is a comprehensive resource library of white papers, case studies, 
product descriptions, solution summaries, webcasts, and related information.

If you find errors in any Trillium Software documentation, have 
suggestions for additional topics, or have any other comments, 
please let us know. You can contact the Documentation team 
through Trillium’s Customer Support department.

Customer Support
Customer Support is available Monday through Friday, 24 hours a day, to help 
you with any questions you may have about Trillium Software System. This 
service is available to all customers who have active maintenance plans.

 E-mail: techsupport@trilliumsoftware.com
 Telephone: 978-901-0000 (Worldwide Headquarters)  

+44 (0) 118 940 7676 (European Headquarters)
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Requirements and Checklists 
CHAPTER 1 Requirements and 
Checklists

This chapter lists the software, hardware and other requirements for installing 
Trillium Software System on UNIX and Windows platforms. It includes the 
following topics:

 TSS Important Changes on page 11
 TSS Components on page 14
 System Requirements for TSS on page 15
 Installation Checklist for UNIX on page 19
 Installation Checklist for Windows on page 22
 Defining User Accounts on page 23
 Backing up Existing Repositories on page 32

TSS Important Changes
Note the following changes:

 Trillium Quality for Big Data. For TSS v15.7, Trillium Quality for Big 
Data is now available to deploy TS Quality projects to your Hadoop 
environment. Trillium Quality for Big Data integrates Trillium’s data 
quality application with Syncsort DMX-h to cleanse and match your data 
in the Hadoop framework. You install Trillium Quality for Big Data as a 
Trillium Software System Installation Guide 11



Requirements and Checklists
separate solution. For more information, see the Trillium Quality for Big 
Data Installation Guide.

As of v15.7, TS Quality for Hadoop is discontinued and is no 
longer installed with EDQ software.

 Trillium Discovery and Collibra Integration. New for v15.7, this 
solution is installed with the TSS Windows and Linux repository server 
software and includes a Collibra-Trillium.zip file that contains the 
integration project files. The solution is installed in the following default 
location:
•   Windows: C:\Program Files (x86)\Trillium Software\MBSW\15\ 

          svr\Collibra

•   Linux: install_path/server/metabase/svr/collibra

For more information, see the Trillium Discovery and Collibra 
Integration Administration and User’s Guide, installed with the solution.

 HP-UX Itanium. HP-UX Itanium systems are no longer supported. TSS 
v15.3 was the last release to support HP-UX. 

Support for HP-UX PA-RISC was previously discontinued.

 Apache Tomcat
•   As of v15.7, the version of Apache Tomcat installed with the TSS 

server has been upgraded to v8.0.47. 
•   After you install the TSS repository server, you must start Apache 

Tomcat server. 
•   Set Apache Tomcat Ports (New Installations Only). The TSS server 

installation sets the Apache Tomcat start port to 8080 and the stop 
port to 8005. After you install the TSS server, if you install 
Enterprise Connectivity Solutions (ECS) and you plan to use 32-bit 
TS Web Services, verify (and change if needed) the Apache Tomcat 
start and stop ports in the server.xml file on your server system. 
server.xml is located in the following location: 
 
Windows: C:\Program Files (x86)\Trillium Software\MBSW\ 
   15\Apache_Tomcat\conf  
 
UNIX: server_install_path/metabase/Apache_Tomcat/conf
12 Trillium Software System Installation Guide
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•   If you have an existing instance of TSS v15 installed, and you have 
made changes to the 32-bit Apache Tomcat server.xml file, to 
retain these changes:

a. Before you upgrade, rename the existing server.xml file as a 
backup file (for example, server.xml.bak) for reference.

b. Install TSS. The server will install a new server.xml file. 

c. After TSS is installed, update the new server.xml file with your 
modifications as needed.  
 
For more information and the full procedure, see Retaining Changes 
in server.xml Files on page 243.

 Java
•   Java is no longer installed with the TSS server software. 
•   TSS requires Java 1.8. Before you install TSS v15.7, you must install 

Java/JRE (or JDK) 1.8, 32- or 64-bit version depending on the 
components you install:

If you use the TS Director Software Development Kit (SDK) 
samples for Java, Java 1.6, 1.7, and 1.8 are supported. 
Ensure you select the correct version of the TrilTGenClient.jar 
executable in the \ProgramData\Trillium Software\ECS\15 
\samples\SDK\Java directory.

Repository Server and Enterprise Connectivity Solutions/TS Director

 Windows
 Linux
 AIX

JRE 1.8 32-bit

 Solaris Sun JRE 1.8 64-bit

Enterprise Data Quality (EDQ)

 Windows
 Linux

JRE 1.8 64-bit
Trillium Software System Installation Guide 13
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•   Install Java to the default install location on your server system. On 
Windows, the location is: C:\Program Files (x86)\Java. Restart 
your system after installation.

•   Set the JRE_HOME environment variable to point to the default Java 
installation.

 Solaris Sun. If you have a TSS v15.3 (or earlier) server installed on a 
32-bit Solaris Sun system and you are running 32-bit TS Web Services 
(part of TS Director/Enterprise Connectivity Solutions) you cannot 
upgrade to TSS v15.7 because Java 1.8 is unavailable for 32-bit Solaris 
Sun platforms. 

TSS Components
Depending on your license purchase, you will install some or all of the TSS 
components. For example, if you purchased TSS for profiling capability only, 
you will need to install:

 Repository Server (includes Discovery Center and Trillium REST APIs)
 Control Center

If you purchased TSS for cleansing or matching mainly for batch processing, 
you will need to install:

 Repository Server (or TS Quality Core only)
 Control Center
 Country Templates
 Postal Directories (Tables)
 Batch Deployment Tool
 Enterprise Data Quality (EDQ) 64-bit, if you are deploying TS Quality 

projects to a 64-bit environment

If you purchased TSS for cleansing or matching for real-time processing or for 
an enterprise deployment, you will need to install:

 Enterprise Connectivity Solutions 
 Repository Server (or TS Quality Core only)
 Control Center
 Country Templates
 Postal Directories (Tables)
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 Batch Deployment Tool
 Enterprise Data Quality (EDQ) 64-bit, if you are deploying TS Quality 

projects to a 64-bit environment

If you purchased and/or plan on using TS Quality for SAP, TS Web Services 
(for 64-bit), and/or 64-bit enabled core TS Quality modules and Trillium 
tables, install EDQ 64-bit. For more information about EDQ, see Installing EDQ 
on page 127.

Review the system requirements, the platform-specific checklists and verify all 
your requirements are met before you begin the installation. Trillium Software 
recommends that you update the checklist when you complete each task.

System Requirements for TSS
This section describes the hardware and software requirements for the Trillium 
Software System. It also lists the data requirements for both flat file data 
sources and relational data sources needed to use in Trillium Software System.

Minimum Requirements: Control Center

Supported Platforms
 Microsoft Windows 10
 Microsoft Windows 8, 8.x
 Microsoft Windows 7
 Microsoft Windows Server 2016
 Microsoft Windows Server 2012, 2012 R2
 Microsoft Windows Server 2008

Browser Software
Internet Explorer 10 and 11. If your client system is Windows 10, you must 
use IE 11; Microsoft Edge is not supported.
Trillium Software System Installation Guide 15
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Configuring Internet Explorer

Internet Explorer 10 and later browser versions in Windows Server 2012/2008 
have Internet Explorer Enhanced Security Configuration enabled by default. 
Therefore, you must:

 Add the Trillium URL: https://15.tss.trilliumsoftware.com to the 
list of trusted sites. 

 Specify the security level to Medium 

For more information, see: http://technet.microsoft.com/en-us/library/
dd883248%28v=ws.10%29.aspx.

 To add Trillium Control Center to the list of trusted sites

 1.   Select Tools > Internet Options from the Internet Explorer menu.

 2.   Click the Security tab. 

 3.   Select Trusted Sites, then click Sites. Then enter the following URL: 
https://15.tss.trilliumsoftware.com

The Control Center hosts an instance of Internet Explorer to render HTML and 
Javascript downloaded from the Repository Server. HTTP requests from the 
hosted IE that are directed at hosts in a sub-domain of 
tss.trilliumsoftware.com are routed to and serviced by the repository 
server by way of private proprietary protocol and connection. Trillium warrants 
that the domain tss.trilliumsoftware.com is reserved specifically for this 
purpose and no such domain is publicly registered. IE and other browsers 
running standalone (that is not hosted by Control Center) will not find 
tss.trilliumsoftware.com.

Microsoft Framework v4.5.2
The TSS Control Center requires Microsoft .NET Framework v4.5.2. If it is not 
present, installation will complete successfully but an error will occur when the 
user selects certain actions, such as deploying to real time.
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Hardware 

Minimum Requirements: Repository Server 

Supported Platforms

Component Minimum Requirement

Screen resolution 1024x768 pixels (1280x1024 pixels or above recommended)

Color depth 16-bit (65536 colors)

Processor Windows x86

Memory (RAM) 2 GB 

TCP/IP connection speed 10 Mbps 

Available disk space 20 GB 

Supported Server Platforms Required Patch (if any)

UNIX
AIX 6.1 Technology Level 1, Service Pack 1 or later.

AIX 7.1 No patch required

Solaris 10 Latest SUNWlibC patch

Solaris 11 Latest SUNWlibC patch

Red Hat Enterprise Linux 4 No patch required

Red Hat Enterprise Linux 5.5, 6, and 
7
(EDQ supports 6 and above only)

No patch required

Linux Suse Version 11.1 and above No patch required

Windows
Microsoft Windows Server 2008

Microsoft Windows Server 2012, 2012 
R2

Microsoft Windows Server 2016

Microsoft Windows 7

Microsoft Windows 8 and 8.x
Trillium Software System Installation Guide 17
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Patches are available from your operating system support provider.

Other Software Requirements
 Enterprise Data Quality (EDQ) requires the following:

•   Java/JRE 1.8 installed on the server system. 
•   For Windows, Microsoft Visual C++ 2013 64-bit (x64) Redistributable 

Package on the server system. Download from: https://
www.microsoft.com/en-us/download/details.aspx?id=40784

 If you install the TSS server on Microsoft Windows 8.1 or later, and you 
plan to use the Discovery Center and Administration Center, you must 
install Microsoft .NET Framework v3.5. 

 If you are running on a UNIX platform, you must have inetd (xinetd for 
Linux) installed.

 Gzip is required to install TSS on UNIX.
 GNU Compiler Collection (GCC)

•   If you are running on Solaris and have purchased the Global Postal 
Matcher or Geocoder process as part of your TS Quality license, you 
must have GCC Library Version 3.3.2. The library is available from 
the Sunfreeware archive at http://sunfreeware.com. There are 
different versions of the library depending on your version of Solaris.

•   The TSS server is a 32-bit application. If you plan to install the TSS 
server on Linux, you must also install 32-bit GCC libraries on the 
server system. These libraries are needed to run TSS 32-bit 
applications such as the repository server and the TSQ (core) 
modules. 

 If you are running on a UNIX platform (32-bit/64-bit), you must have 
the libuuid package installed.

Microsoft Windows 10

Supported Server Platforms Required Patch (if any)
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Hardware Requirements 

Installation Checklist for UNIX 
For the Windows platform, see Installation Checklist for Windows on page 22.

Parameter Minimum Recommended Power Server
Memory RAM: 16 GB

Processors: 1-4
Maximum Users: 2
Loads: Overnight 
Only

RAM: 32 GB
Processors: 4-8
Maximum Users: 5
Loads: Moderate 
Daytime

RAM: 64 GB
Processors: 8 or more
Maximum Users: 10
Loads: Daytime

Network TCP/IP 
Connection Speeds

100 Mbps 1 Gbps 1 Gbps

Disk Space Software: 1.5-2 GB  

Postal Table: Up to 
20 GB 

Data: Refer to the 
TSS Sizing Capacity 
Estimator

50 to 200 GB, depending on which postal 
tables and other options you purchase and 
on the number of records you will be 
processing. Check with your account 
manager for more information.

 Action Who1 How

REVIEW SYSTEM REQUIREMENTS any See page 15.

DEFINE USER ACCOUNTS

 1. TSS Application Administrator
 2.  TSS 15 Load User (optional)

root
tssadmin

See page 24.
See page 26.

INSTALL REPOSITORY SERVER

 1. Identify available port numbers. any See page 34.

 2.  Install required operating system patches. root See page 34.

 3.  Install the repository server. tssadmin See page 38.

 4.  Update tss_profile file. tssadmin See page 38.

 5.  Activate the TSS server license. tssadmin See page 47.

 6.  Start the TSS Scheduler. tssadmin See page 48.
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1root—UNIX root user (UNIX Administrator); tssadmin—TSS Application Administrator; 
winadmin—Windows Administrator; repadmin—TSS Repository Administrator.

Why Root Access?
As noted in the checklist for UNIX systems, some procedures must be 
performed by a user with root access. When you enter a root password during 
the UNIX software installation, inetd.conf or (xinetd.conf on Linux) file is 
updated to allow the correct processes to be called between the UNIX system 
and TSS. (The inetd daemon controls certain UNIX system processes.) No 
other configuration or services file is changed. 

 7.  Start Apache Tomcat. tssadmin See page 48.

INSTALL COUNTRY TEMPLATES tssadmin See page 74.

INSTALL THE CONTROL CENTER winadmin See page 90.

INSTALL BATCH DEPLOYMENT TOOL winadmin See page 101.

INSTALL ENTERPRISE DATA QUALITY tssadmin   See page 127.

INSTALL POSTAL DIRECTORIES

 1. Install postal directories. tssadmin See page 172. 

 2.  Validate file integrity. tssadmin See page 187.

CONFIGURE REPOSITORIES, LOADER CONNECTIONS, USERS

See the TSS Repository Administrator’s 
Guide.

repadmin
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The following are examples of changes made after the root password is 
entered: 

Next, go to Defining User Accounts on UNIX on page 23 for instructions of how 
to define user permissions on UNIX. 

OS
File or Service 
Entry

Change Example

Linux xinetd definition, 
typically written to  
/etc/xinetd.d/tss_
profile

service dscserv4_rel15
{
   disable           = no
   flags              = REUSE
   socket_type    = stream
   protocol         = tcp
   wait               = no
   user               = systest
   server            = /home/systest/tss15/repository/ 
                             bin/ mtb_server
   log_on_failure += USERID
   passenv          = 
   env                = HOME=/home/systest 
 LOGNAME         = systest
}

Service entry, 
typically written to  
/etc/services

# These lines are entered for Trillium Software 
Repository v15
dscserv4_rel15/tcp
dscserv4_lm_rel15/tcp

Sun 
Solaris

 inetd.conf
 xinetd definition
 Service entry

Follows either of the above conventions, depending 
upon the OS version. 

AIX inetd.conf # These lines are entered for Trillium Software 
Repository v15
dscserv2_rel15 stream tcp nowait systest /usr/bin/env 
env -i HOME=/home/systest LOGNAME=systest /
home/systest/tss15/repository/bin/mtb_server

Service entry, 
typically written to  
/etc/services

# These lines are entered for Trillium Software 
Repository v15
dscserv2_rel15/tcp
dscserv2_lm_rel15/tcp
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Installation Checklist for Windows

1tssadmin—TSS Application Administrator; winadmin—Windows Administrator; 
repadmin—TSS Repository Administrator.

 Action Who1 How

REVIEW SYSTEM REQUIREMENTS any See page 15.

DEFINE USER ACCOUNTS

 1.  TSS Application Administrator
 2.  TSS 15 Load User (optional)
 3.  TSS Repository Administrator

winadmin
winadmin
winadmin

See page 27.
See page 30.
See page 31.

INSTALL REPOSITORY SERVER

 1. Install required operating system patches. winadmin See page 50.

 2.  Identify available port numbers. winadmin See page 51.

 3.  Install the repository server application. tssadmin See page 53.

 4.  Activate the TSS server license. tssadmin See page 69.

 5.  Start the TSS Scheduler. tssadmin See page 70.

 6.  Start Apache Tomcat. tssadmin See page 71.

INSTALLING COUNTRY TEMPLATES winadmin See page 83.

INSTALL CONTROL CENTER winadmin See page 90.

INSTALL BATCH DEPLOYMENT TOOL winadmin See page 101.

INSTALL ENTERPRISE DATA QUALITY       tssadmin See page 127.

INSTALL POSTAL DIRECTORIES

 1. Install postal directories. tssadmin See page 172. 

 2.  Validate file integrity. tssadmin See page 187.

INSTALLING TS REPORTING ADAPTER winadmin See page 111.

CONFIGURE REPOSITORIES, LOADER CONNECTIONS, USERS

See the TSS Repository Administrator’s 
Guide.

repadmin
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Defining User Accounts
This section consists of 

 Defining User Accounts on UNIX
 Defining User Accounts on Windows

Defining User Accounts on UNIX 
TSS relies on two types of users: UNIX users and TSS users, as defined in the 
table below. You can create the TSS users during and after the installation 
procedure. However, you must define the UNIX users before you install TSS.

Type Description

TSS Application 
Administrator

UNIX ID for user who installs the TSS components and 
administers the TS Scheduler and License Manager. 
Needs root access.

TSS Repository Administrator TSS ID for user who maintains the TSS repository server, 
defines repositories and data connections, and manages 
users and security. 
You establish this ID during the installation of the 

repository server. This user is also called the boot 
user.

TSS Load User UNIX ID for user who will access (through a login screen in 
the Control Center) data import directories located on the 
server.
This type of user is required if you plan to load data from 
flat file sources (delimited, COBOL, Trillium sources).
It is not required if you plan to directly access data from 
relational sources (IBM DB2, Oracle, ODBC). You will, 
however, need a user ID that gives you access to each 
specific database.

TSS User TSS user account that accesses TSS repositories through 
the Control Center.
TSS users can be Windows-authenticated users or 

Trillium-specific users. Users are managed by the TSS 
repository administrator after installation.
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Defining TSS Application Administrator on UNIX
You must create a UNIX ID for the TSS application administrator and, if you 
are using sudo, grant sudo rights before installing TSS. This administrator 
installs the repository server, and administers the Scheduler and License 
Manager on the server. 

 To create a TSS application administrator

 1.   As the UNIX root user, create an administrator user account to perform 
TSS administrative activities.

 2.   Do one of the following:

 If you are not leveraging the security provided through sudo, make 
sure that the TSS administrator has read access to any data import 
directories that you define. Proceed to Defining TSS Load Users on 
UNIX on page 26.

 If you are leveraging the security features of sudo, proceed to  
step 3.

 3.   As the UNIX root user, type the command: visudo 

This brings up the file named sudoers for editing.

IMPORTANT: You must always edit this file through the 
visudo command.

 4.   In the Defaults: specification section, add the following entries:

Defaults:<user_id> targetpw
Defaults:<user_id> passwd_tries=1
Defaults:<user_id> timestamp_timeout=0

Example
If the TSS application administrator user_id is tssadmin, add the 
following entries:
Defaults:tssadmin targetpw
Defaults:tssadmin passwd_tries=1
Defaults:tssadmin timestamp_timeout=0
24 Trillium Software System Installation Guide



Requirements and Checklists 
 5.   In the User Privilege specification section, add:

<user_id> ALL=(ALL) ALL

Example

 6.   Save the file and exit.

 7.   Verify that sudo is correctly configured.

a. Log in as the TSS application administrator.

b. Issue the following command: 

sudo -u <TSS Loader User ID> id

c. When prompted, enter the password for the TSS load user.

d. Type the command:

 id
The operating system should return the UNIX uid of the TSS load 
user. If it does not, contact your system administrator.

After you have completed the installation of the repository server 
and definitions, add the sudo path to the tss_profile file. See 
Specifying Variables for UNIX on page 45 for more information.

If the TSS application administrator user_id is tssadmin, add:
tssadmin ALL=(ALL) ALL
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Defining TSS Load Users on UNIX
Define a TSS load user account on the UNIX server if you are planning to 
import data from a flat file. This account is necessary to access the data file 
using your UNIX user id. 

For example, when importing flat files residing on the /data directory of a 
repository server, you must use a TSS load user (UNIX user id) with read 
access to the repository server and the /data directory. 

You define the data storage locations when you create load 
connections after the TSS installation.

 To create a TSS load user 

 1.   Define a new UNIX user account or select an existing user account to 
act as a TSS load user. 

 2.   Give the account read access to the data import directory. 

All flat file data to be imported into TSS must reside on the 
local server disk. TSS load users will NOT be able to import 
flat file data into TSS without access to the data import 
directories.

Defining User Accounts on Windows
This section contains information on user accounts on Windows along with 
configuration instructions. 

The TSS software requires that an administrative user creates user 
accounts. 

About User Permissions (UAC)
User Account Control (UAC) improves security by limiting software usage for 
those with standard user privileges. On Windows 7, Windows 8, 2008 and 
2012, you must disable UAC for the following components to run without any 
issue/error:

 Data Comparison Calculator 
 Project Rule Analyzer
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 Exporting projects
 Postal Directory Browser
 Batch Export 

 To disable UAC for currently logged in user

 1.   Click Start > Control Panel > Action Center > Change User 
Account Control settings.

 2.   Disable UAC by moving the slider to the Never notify position.

 3.   Click OK to save your change.

Defining a TSS Application Administrator on Windows
You must assign a Windows administrator user with TSS application 
administrator permissions. The TSS administrator will install the Repository 
Server (and TS Quality), ECS and configure the TS Scheduler and License 
Manager.

 To create a TSS application administrator

 1.   As the Windows administrator, create a Windows user account for the 
TSS application administrator. 

 2.   Add the TSS application administrator user to the group Administrators.

 3.   Click Start > Control Panel > System and Security > 
Administrative Tools > Local Security Policy and expand the 
Security Settings > Local Policies > User Rights Assignment 
folder.

 4.   Add the TSS application administrator user to the following options:

 Log on as a Service 
 Act as part of the operating system
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Design Secure Flat File Data Sources on Windows
This is an optional configuration appropriate for securing flat file data sources.

For the secured directory, remove all security access and add the 
required group.

If you require security for flat file data sources, you must define at least one 
Windows user account that can act as a TSS 15 load user on the Windows  
server. When you create an entity in TSS (that is based on a flat file data 
source), you are:

 1.   Asked to choose a data connection. 

Data connections are created through the Repository Manager and the 
Administration Center. Consult the TSS Repository Administrator’s 
Guide and Administration Center help for more information. 

 2.   Prompted for a username and password to access the data source 
stored on the TSS 15 server.

Create a Secure Flat File Data Directory on Windows
To create a secure area for flat file data sources, you need to:

 Create a Windows group for each secure area.
 Create at least one Windows user ID for each Windows group that you 

created and add the user(s) to the appropriate group.
 Create a directory for each group.
 Edit the properties on each directory that you created and grant full 

access to the group that corresponds to the directory. 

If... Then...
No Windows Load User accounts are 
defined

You will not have to enter a username 
and password. All connections to flat 
file data sources are available to any 
TSS user.

At least one Windows Load User 
account is defined and has been 
granted read access to the directory 
defined by the data connection

You must enter a username and 
password to access those data sources 
through TSS.
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A user group is only required if you plan to access data from flat file data 
sources requiring secure directory locations. The following example 
demonstrates how this can is useful.

Example

 To add a Windows user group for each secure location

 1.   Before you begin, as the Windows Administrator, create a user group 
on the TSS repository server to contain Windows user IDs that can 
access a secure area. 

There are no naming restrictions for group names, but it is 
recommended that you name them something meaningful.

 2.   Click Start > Control Panel > Administrative Tools > Local 
Security Policy.

Assume that you have 2 teams—Accounting and Human Resources—that will 
create entities based on flat file data sources. 

If you do not want the Accounting team to have access to the data from 
Human Resources, you would:

 Create two Windows groups—one for Accounting and one for Human 
Resources.

 Create at least one Windows user ID for each group that you created 
and add the user(s) to the appropriate group.

 Create two separate directories—one for the Accounting team 
(C:\accounting) and one for the Human Resources team (C:\HR).

 Edit the properties on each directory that you created and grant full 
access to the group that corresponds to the directory.
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 3.   In the Local Security Policy window, expand Local Policies > User 
Rights Assignment > Log on as a batch job.

 4.   Add the user group you created in step 1. 

Ensure that the Group Policy item “Remove Run option from Start 
Menu” is not applied to the new secure Windows group. This setting 
is located in Local Computer Policy\User Configuration\ 
Administrative Templates\Start Menu & Taskbar.

Create TSS Load User on Windows
A Windows user account acting as a TSS load user is only required if you plan 
to access data from flat file data sources requiring secure directory locations. 

If you intend to directly import data from a relational data source 
instead of a flat file source, skip this procedure. 

 To create TSS Load User 

 1.   Determine whether you will create a single user account that the team 
will share or if each user will have their own user account.

 2.   Create the Windows user account(s).
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 3.   Add each user account (that will access the flat file data) to the 
appropriate Windows user group for each secure location. 

IMPORTANT: User accounts not contained in the Windows 
group will not be able to import flat file data for that data 
connection.

Create a Repository Administrator on Windows
As part of the TSS repository server installation, you designate the user who 
will be responsible for managing the repository, users, and data connections 
and will perform other administrative duties in TSS. You have three options for 
setting up this administrator:

 If you have Windows Active Directory services enabled, you can 
designate a user from the Windows Administrator group as the 
repository administrator. 

We recommend that you use Windows Active Directory 
services. If you choose this option, it applies to all TSS users. 
In other words, you cannot use a Windows Administrator 
group user as the repository administrator and then create 
TSS-specific users for the Control Center.

The TSS application administrator can also serve as the TSS 
repository administrator. Alternatively, you can establish a 
separate user to perform the role of repository administrator.

 During installation, you can create a Trillium-specific user as the 
administrator. 

 For a Trillium-specific user, you can optionally limit the administrator’s 
role to only managing application and repository files using the TSS 
Repository Manager. This prevents the repository administrator from 
interacting with the operating system.

You specify the type of user (Windows Active Directory or Trillium) that will 
serve as the repository administrator during the installation process. If you 
plan to designate a Trillium-specific user as the repository administrator and 
you want to restrict this user’s access, you must complete the following 
procedure before you install.
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 To limit the role of the TSS repository administrator on Windows

 1.   Create the following user accounts:

•   repadmin - TSS repository administrator account
•   tssuser - User account that is accessible by users of the repository 

server and that has access to the appropriate data source(s). You 
may create as many user accounts as you require.

 2.   Apply the “Log on as Batch Job” group policy privilege to every user 
account that is to be used to import data using the Create Entity 
Wizard.

 3.   When you install the TSS repository server, choose the option to install 
for repadmin only.

 4.   Change all Trillium services to run as a Local System account. 

a. Click Start > Control Panel > System and Security > Adminis-
trative Tools > Services.

b. Locate the TSS services. 

c. Right-click, and choose Properties. Click the Log on tab and select 
the Local System Account option.

d. Click OK.

 5.   Set the following directory permissions:

•   Import directories − Grant permission for tssuser to read the 
directories where the data will be stored. Ensure that Local Service 
does not have permission to do so.

•   Application and Repository directories − Grant full control 
permissions to Local Service and deny access for tssuser.

Backing up Existing Repositories
If you plan to reuse existing repositories from an existing TSS installation, you 
must backup the repositories to avoid data loss or corruption. During 
Repository Server installation, you can select to re-use existing repositories. 
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CHAPTER 2 Installing the Repository 
Server

This chapter contains instructions for installing the TSS Repository Server on 
UNIX and Windows platforms. When you install the repository server, the TS 
Quality component is installed with the server by default. TS Quality contains 
the executables and libraries for TS Quality processes and utilities.

This chapter includes: 
 Installing the Repository Server on UNIX on page 34
 Installing the Repository Server on Windows on page 50 

Before you begin the installation, review the important information in the 
section TSS Important Changes on page 11.
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Installing the Repository Server on 
UNIX
Installation steps include:

 Verifying the installation checklist.
 Backing up existing repositories for conversion or upgrade.
 Installing JRE or JDK 1.8 32-bit.
 Installing the repository server.
 (Optional) Installing web services (for standalone TS Web Server) on 

Sun SPARC or AIX. The TS Web Server is installed by default on Linux. 
See Installing Web Services on Sun SPARC or AIX on page 37.

 Specifying variables.
 Examining directory structure of files and folders.
 Activating Trillium Software System License.
 Starting the TSS services.
 Starting Apache Tomcat.

Verifying the Installation Checklist on UNIX
 1.   Verify that your system satisfies the hardware requirements listed on 

page 17. Trillium Software recommends that you install the repository 
server on a local drive.

 2.   Verify that your system has the latest platform patch. All required 
patches are available from your operating system support provider. 

 3.   Identify available ports. The repository server installation program asks 
for separate port numbers (accessible from the client to the server and 
not blocked) for: 
 Repository Server Login (client port)
 Repository Server Scheduler (and license server if hosted locally)
 License Server Host (if hosted remotely)
 Apache Tomcat
 TS Web services (UI Web Server)
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 Port numbers should not exceed 65535 and ports less than 
1024 are typically reserved. For easy reference, port numbers 
should be consecutive numbers.

The default port numbers are: 

•   15040 - Repository Server Login (client port)
•   15041 - Repository Server Scheduler (and license server if hosted 

locally)
•   3000 - web server
To find available port numbers:

a. Inspect the services file, located at: /etc/services.

b. Type the command netstat -an to identify ports that have 
applications listening on them. 

 4.   For Oracle loader connection, make a note of your Oracle version. You 
will need to provide the version number during the installation

 5.   For Windows Active Directory authentication, verify you know the name 
of the of the domain controller that will authenticate users. If you do 
not know the name of the controller, contact your Network 
Administrator responsible for the Active Directory. You can also use the 
nslookup command. For example:

On Windows:
nslookup
set type=all
_ldap._tcp.dc._msdcs.domain

where domain is the name of your domain. This will return a list of all 
the domain controllers for the specific domain.

Preparing to Re-use an Existing Repository
If you have a previous version of Trillium Software System installation, you 
can use data from that version. The installation procedure will go more 
smoothly if you have considered the conversion requirements and gathered 
the information you need beforehand.

We recommend that you create a backup of the repository server 
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you are going to convert/upgrade.

If you plan to use a repository server from a previous version, it must satisfy 
the following conditions:

 It must come from TSS Version 11.0.1, 11.5.2, 12.0.1, 13, 13.5.1, 
14.x. or 15.x. You can:
 convert a pre v14 repository (that is TSS Version 11.0.1, 11.5.2, 

12.0.1, 13, or 13.5.1)
 upgrade a v14 repository (that is TSS version 14.x)
 upgrade a previous version of v15 repository

 It must be complete and valid.
 It must be accessible from the server on which you are installing TSS 

15.x. 
 You must know the user ID and password of the repository 

administrator who created the existing repository server.

Note the following if you upgrade or convert repositories after you run the 
installation:

 If you have an existing repository from TSS v14.x or 15.x, an upgrade is 
performed. If for any reason you do not upgrade the repository during 
the installation process, after you install the software you must run the 
upgrade command to ensure the repository is properly upgraded. See 
Upgrading TSS v14 or v15 Repository on page 239.

 If you have an existing repository from TSS v13.5.1 or earlier, a 
conversion is performed. If for any reason you do not convert the 
repository during the installation process, after you install the software 
you must run the copy command to ensure the repository is properly 
converted. See Converting Pre TSS v14 Repositories on page 234.
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Installing Web Services on Sun SPARC or AIX
The repository server installation does not install the web server on Sun 
SPARC or AIX. The web server is required for communication between the 
repository server and web-based Trillium applications Discovery Center and 
Administration Center. To use the web server, you must install:

 Web services on the repository server (see step 22 on page 41 of 
Installing the Repository Server on UNIX) when installing on Linux.
If you cannot provide the web services information during repository 
server installation, you can add the information later using instructions 
in Updating Registry File with TS Web Server Information.

 TS Web Server (standalone) on a Windows client (see Installing 
Standalone TS Web Server for more information) when the TSS server 
is installed on Sun or AIX. 
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Installing the Repository Server on UNIX
Use the following procedure to install the repository server. During installation, 
you can optionally define an administrator to manage the repository server.

 To install repository server 

 1.   Log in to the system where you plan to install the repository server as 
the TSS administrator.

 2.   If you have not yet done so, install JRE or JDK 32-bit 1.8 to the default 
Java location on your server.

 3.   If you have not yet done so, download the server installation software 
setup from the TSS Download Center (File Portal) FTP site.

 4.   In the install software package, locate the directory  
/[platform]Server 

 5.   Unzip and copy the setup file to a convenient location on the UNIX 
server. 

 6.   Set execute permissions on the setup file (if necessary). For example: 
chmod +x tss_server_version.build_platform.sh

 7.   Run the setup file. For example:
 tss_server_version.build_sunos.sh

The program checks for existing installations. If it finds one or more 
existing installations, it offers you the option of upgrading or converting 
data from an existing repository server into TSS v15.

Review the section Preparing to Re-use an Existing Repository 
on page 35. 

 8.   Select the installation option: 
 Enter 1 for a new install. Go to step 10 on page 39.
 To upgrade or convert an existing repository, enter 2 and press 

Enter. 
You see the prompt Enter the Repository Environment boot 
user password.
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 9.   Enter the password of the boot user (repository administrator) who 
created the repository server you are converting. If you do not know 
the password, you cannot proceed with the conversion. Go to step 10 
on page 39.

 10.   Press Enter. You see the prompt: Please enter the name of your 
organization.

 11.   Enter the name of your organization and press Enter. You see the 
prompt Where would you like to install TSS 15 - Repository 
server? This is the repository server path. 

 12.   Enter the repository server path. For example, /opt/
TrilliumSoftware/server and press Enter. The application binaries 
are installed in this location. 

You see the prompt Where would you like to install your 
Repository Environment? 

 13.   Enter the directory location for your repositories, for example, /opt/
TrilliumSoftware/repository/ and press Enter. 

The repository server and repository environment paths must be 
distinct. 

You see the prompt To use Windows Authentication, enter the 
Active Directory server address or hostname.
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 14.   Enter the active directory name and press Enter for Windows 
Authentication (recommended). If you plan to use Trillium 
authentication, simply press Enter. 

You see the prompt Enter the Repository Environment boot login 
name:

 15.   Enter the login name for the repository administrator and press Enter.

You see the prompt Enter the Repository Environment boot login 
password: 

 16.   Create a password for Trillium authentication. Or, enter the password 
associated with your Windows user ID for Windows authentication.

 17.   Press Enter.

Note down the administrator username and password. You 
must provide this information to log in to Repository 
Administration Command Prompt tool and to the Repository 
Manager. 

You see the prompt Will your license manager be local or remote? 

 18.   Specify whether the License Server is local or remote. 

 Enter 1 if the License Server will be hosted locally (the default). 
 Enter 2 if the License Server will be hosted remotely. Use this option 

when you install on multiple servers. 

 19.   Press Enter. You see the prompt Enter license manager host name 
(host name):
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 20.   Enter the license manager host name and press Enter.

You see the warning:  
WARNING: Services for TSS 15 - Repository Server have not 
been installed yet. To install them later you will need the root 
password.
The warning is followed by the prompt: Enter port number for Client 
login: 

 21.   Enter the port number for the client (default is 15040) and press Enter.

You see the prompt: Enter port number for Scheduler: 

 22.   Enter the port number for the Scheduler (default is 15041) and press 
Enter.

 On Linux, you see the prompt: Enter the port number for the 
web server:  
 
Enter the port number for the web server (for example, 3000) and 
press Enter. 

 On Sun SPARC and AIX you see the prompt: Install web services 
(required for some new functionality)? (y/n): 

a. To install web services, enter y, otherwise enter n and go to step 23 
on page 42. If you selected y, you see the prompt: Enter mtbad-
min port number:

b. Enter the port number for TSS web services and press Enter.  
 
You see the prompt: Enter hostname for the of Web Server 
bridge (if known):

c. Enter the host name of the standalone web server, for example 
localhost and press Enter. If you do not know the information, 
you can add the information at a later time. 
 
You see the prompt: Enter port number for the Web Server 
bridge (if known):

d. Enter the port number of the standalone web server, for example, 
3000 and press Enter. If you do not know the information, you can 
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add the information at a later time.  
To add the port number and host name for the Web Server bridge, 
see Updating Registry File with TS Web Server Information on 
page 49.

 23.   At the prompt Please check your installation settings to make 
sure they are correct. Continue installation? (y/n):, review the 
settings that you specified.

 Enter y if the settings look correct and you want to continue the 
installation. 

 Enter n if the settings are not satisfactory. The program takes you back 
to the beginning of the process.

 24.   Press Enter.

The installation untars the binary and TSQ files and displays the prompt 
Choose your Oracle version. 

 25.   Enter the option number (1, 2 or 3) that applies to your site and press 
Enter. The default value is 1 (Oracle 10g). Depending on your 
operating system and configuration, you may see different choices for 
Oracle client versions. 

The process creates a Registry file, installs the Data Adapter and then 
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displays the following message:

Data Adapter provides read/write functionality to various 
database products supported by TSS. See Why Root Access? on 
page 20 for an explanation of why root access is required.

 26.   Enter y or n to proceed:

 Enter y if you have root access and wish to proceed. You are 
prompted for the root user’s password. Enter the root password and 
press Enter. The installation process begins. When all the repository 
services have been installed, a completion message is displayed.

 Enter n if you do not have root access or if you do not wish to install 
repository services at this time. 
When you are ready to install, log in as a user with root access and 
issue the command setup -root from the ../TrilliumSoftware/
server/metabase directory.

If you are having problems running the setup, verify that the setup 
file has the correct execute permission for the TSS Administrator. If 
not, use the chmod command to grant execute permission.
After you issue the setup -root command, respond to the series of 
prompts as follows:

a. Enter the repository server installation path (for example,  
/opt/TrilliumSoftware/server) and press Enter.

b. Enter the username of the TSS repository administrator and press 
Enter.
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c. Enter the home directory of the username specified in step b on 
page 43 (for example, /export/home/tssadmin) and press 
Enter.

d. Enter the port number for the client login and press Enter.

e. Enter the port number for the Scheduler and press Enter.

Once the repository environment building is complete, you see the 
prompt Do you want to set-up default connections? (y/n)

 27.   Enter y and press Enter to install the sample connections.

If you selected y, you see the following Set-up sample connections:

 28.   Enter 1 to install the sample delimited connection, 2 to install the TSQ 
(Trillium) connection, or 3 to install both; then press Enter. 

When repository installation is complete, you see the message:
TSS 15 - Repository Server Installation complete.

 29.   Ensure that the ports specified during installation are not blocked by 
your firewall. Add or remove firewall rules to allow open ports as 
needed. 

If you are converting an existing repository, the 
conversion process may take anywhere from a few 
minutes to several hours, depending on the size of the 
repositories you are converting. 
You can check the mtb_server.log to check the status of 
the conversion. If the conversion process stopped 
before completing, contact Technical Support before 
canceling the operation.
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Specifying Variables for UNIX
When working with Trillium Software System, inetd accesses tss_profile to 
gather environment information. For example, if you are using sudo, you need 
to define its path in the tss_profile file. 

 To modify the tss_profile file on a UNIX Server

 1.   Login to the repository server system as TSS administrator.

 2.   Stop the TSS Scheduler, if it is running.

a. Verify that there are no users logged on to TSS.

b. Change directories to /Server Path/metabase/bin

When you installed TSS, you were asked Where would you like to 
install the TSS 15 Repository Server? This is the directory 
represented by Server Path.

c. Type the command:
     ./scheduler -stop

 3.   Change to the /Server Path/etc directory.

 4.   Locate the file named tss_profile and open it for editing.

 5.   If you are using sudo, use the PATH command to specify the sudo 
location. For example, if sudo is located in your /usr/local/bin/ 
directory, the variable path should be:
  PATH=/usr/bin:/usr/local/bin/
   export PATH  

 6.   Set the TZ (time zone) variable to reflect the value you want.

The format of the TZ command varies, depending on the UNIX 
platform you are using. See your operating system 
documentation for details. 

 7.   Save and close the file.
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Examining Directory Structures and Files on 
UNIX
After you have installed the repository server and definitions, two new 
directory structures containing files and folders related to the TSS repository 
server and TSS repository definitions are created on the server.

Repository Server Path
The repository server is installed in the directory that you specified during 
installation when asked Where would you like to install the Repository 
Server? This manual refers to this path as the repository server path. The 
server path includes, but is not limited to, the following directories and files:

Repository Path
The repository is installed in the directory that you specified during installation 
when asked Where would you like to install your repository 
environment?. This manual refers to this path as the repository path. 

The repository path includes, but is not limited to, the following directories and 
files:

<Server Path>/
metabase Apache Tomcat

bin
etc
Jre
lib
library
resources
templates

<Repository Path>/
export
import
logs
metabase

_control/
tmp/
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Activating Trillium Software System License on 
UNIX
To activate the license, you must be logged on as the TSS application 
administrator.

The license is attached to the email that contains the instructions to download 
the TSS software from the TSS Download Center (File Portal) FTP website. 

 To activate a license key on the TSS Server

 1.   Make sure that you are logged on to the TSS server as the TSS 
application administrator.

 2.   Copy over the license.txt file into the metabase/etc directory of the 
repository server path.

 3.   Change directories to the metabase/bin directory of the repository 
server path. 

 4.   Type the following command:
    ./mtb_admin

 5.   When prompted, enter the repository administrator's username and 
password.

If you are using Windows authentication, you must log in with a 
fully qualified user name. For example, 
tssadmin@mycompany.com.

 6.   At the prompt _control: enter the following command and press 
Enter. 
    activate
Activation of your license key is complete. 

 7.   Type the following command and press Enter to exit the mtb_admin 
tool. 
    exit
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Starting the TSS Scheduler on UNIX
 To start the TSS Scheduler

 1.   Log in to the repository server as the TSS application administrator.

 2.   Go to the bin directory: server_install_path/metabase/bin

 3.   Type the command: ./scheduler -start 

 4.   Press Enter.

Starting Apache Tomcat on UNIX
If you plan to use 32-bit TS Web Services, part of the Enterprise Connectivity 
Solutions, you must start Apache Tomcat. You must first set the JRE_HOME 
environment variable (and JAVA_HOME for JDK if applicable). 

 To start Apache Tomcat on UNIX

 1.   Log in as a user with system administrator privileges.

 2.   To verify your Java version, enter java -version. Ensure Java 1.8 32-
bit version is installed.

 3.   Verify that the JRE_HOME variable in setenv.sh is set to your Java JRE 
location, for example, /usr/java/jre1.8.0_102

The setenv.sh file is located in server_install_path/metabase/
Apache_Tomcat/bin

 4.   Change directories to Trillium’s Apache directory, for example server_
install_path/metabase/Apache_Tomcat/bin

 5.   Run the start-up script, startup.sh

 6.   To shut down the server, run the shutdown.sh script, also in the 
Apache /bin directory.
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Starting TSS Rest APIs on UNIX
 To start TSS Rest APIs

 1.   Log in to the repository server as the TSS application administrator.

 2.   Go to the bin directory: server_install_path/metabase/bin

 3.   Type the command: svr_start 

 4.   Press Enter.

Updating Registry File with TS Web Server Information
This section is applicable only if during repository server installation:

 you installed on Sun SPARC or AIX.
 you installed web services.
 you did not provide the port number or the hostname for the TS Web 

Server. 

The repository server uses the port number and hostname information to tell 
the clients where to find the standalone TS web server. For more information 
on installing the standalone TS Web Server, see Installing Standalone TS Web 
Server.

 To update the registry file with the port number and hostname

 1.   Make a back up of the registry file located in the ../etc directory of the 
server installation.

 2.   Open the .registry file for editing.

 3.   Locate the entry nodePort. Enter the port number for the web server 
bridge. This is the port number the web server is listening on, for 
example 3000.

 4.   Locate the entry nodeHost. Enter the hostname for the Web Server 
bridge. This is the host name for the web server, for example 
localhost.   

 5.   Save your changes.
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Installing the Repository Server on 
Windows 
This section guides you through the installation of the TSS repository server on 
the Windows platform and includes:

 Preparing the repository server on Windows
 Installing JRE or JDK 1.8 32-bit
 Installing the repository server on Windows
 Examining directory structures and files on Windows
 Activating Trillium Software System license on Windows
 Starting the TSS services on Windows
 Starting Apache Tomcat as a service

Preparing to Install the Repository Server on 
Windows

 Go over the checklist on page 17 and verify your system meets the 
hardware and software requirements. 

 Verify that the default ports are available. During installation, you are 
prompted for port numbers that are accessible from the client to the 
server and are not blocked. These port numbers are used for: 
 Repository Server Login (client port)
 Repository Server Scheduler (and license server if locally hosted)
 License Host (if remotely hosted)
 Apache Tomcat
 Web services (UI Web Server)

 To find available port numbers

 1.   From the Windows Start menu, select Start > Run....

 2.   Type cmd and click OK.

 3.   At the prompt, type: 

  netstat -an
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 4.   Press Enter. This returns a list of active ports.

 5.   Review the list and verify that the following ports are not listed (and are 
therefore not currently in use):

•   15040 (Repository Server)
•   15041 (Repository Server Scheduler) 
•   15060 (Apache Tomcat Start Server)
•   15061 (Apache Tomcat Stop Server) 
•   3000 (UI Web Server Port) 

 6.   If a default port is already in use, you will need to specify a different 
port when you install the repository server application. The port you 
select should be greater than 1000 and not exceed 65535.

 7.   Type exit to close the window.

Preparing to Convert an Existing Repository 
Server on Windows
If you have installed a previous version of Trillium Software System, the 
installation procedure gives you the option of re-using data from an existing 
repository server. It is recommended that you consider the conversion 
requirements and gather the information you need beforehand.

A repository server is a collection of repositories. You cannot convert 
an individual repository.

To re-use a repository server from a previous version, you do not have to have 
the previous version of TSS installed. However, the existing repository server 
must meet the following conditions:

 It must come from TSS Version 11.0.1, 11.5.2, 12.0.1, 13, 13.5.1, 
14.x, or 15.x. You can:
 convert a pre V14 repository (that is TSS Version 11.0.1, 11.5.2, 

12.0.1, 13.0, or 13.5.1)
 upgrade a v14 repository 
 upgrade a v15 repository

 It must be complete and valid.
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 It must accessible from the server on which you are installing TSS 15. 
 You must know the user ID and password of the repository 

administrator who created the existing repository server.

Note the following if you upgrade or convert repositories after you run the 
installation:

 If you have an existing repository from TSS v14.x or 15.x, an upgrade is 
performed. If for any reason you do not upgrade the repository during 
the installation process, after you install the software you must run the 
upgrade command to ensure the repository is properly upgraded. See 
Upgrading TSS v14 or v15 Repository on page 239.

 If you have an existing repository from TSS v13.5.1 or earlier, a 
conversion is performed. If for any reason you do not convert the 
repository during the installation process, after you install the software 
you must run the copy command to ensure the repository is properly 
upgraded. See Converting Pre TSS v14 Repositories on page 234.

Reusing an Alternative Repository
TS Quality projects create large data files, so your repository administrator 
may have created an alternative repository just for those files. If the 
alternative repository is part of an existing installation on the server on which 
you plan to install TSS 15, the conversion process will set up the alternative 
repository for you.

However, if the alternative repository is not currently part of an installation or 
is on a different server, then the repository administrator must copy the 
repository and redefine its path after the TSS 15 installation is complete. 

The repository administrator establishes the path to the alternative 
repository using the Repository Administration Command Prompt, as 
described in the TSS Repository Administrator’s Guide.
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Installation Steps on Windows
The repository server uses DLLs that are common to other applications. So 
that the latest versions of the common DLLs are installed, you may be asked 
to shut down some applications before installing repository server.

 To install the repository server

 1.   Log in as the TSS administrator.

 2.   If you have not already done so, install JRE or JDK x86 (32-bit) 1.8 to 
the default location on your server. For example, C:\Program Files 
(x86)\Java\.

 3.   If you have not yet done so, download the software installation package 
from TSS Download Center (File Portal) FTP site. 

 4.   Browse to the \Repository_Server directory. 

 5.   Double-click the setup file to begin the installation. The InstallShield 
Wizard gathers the required information and displays the welcome 
message. 
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 6.   Click Next. The License window opens.

 7.   Read the license agreement. Select the I accept the terms in the 
license agreement option.

 8.   Click Next. The Destination Folder window opens.
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 9.   Click Next to accept the default path. 

Alternately, click Change to specify a different path and then click 
Next. The path you specify here is the repository server path. You 
are asked to specify a path for the repository in the next step. These 
two paths must be distinct. For example, if you specify the server path 
as C:\Trillium_Software\server, you can define the repository path 
as C:\Trillium_Software\repository.
The Repository Type window opens. You can:

•   create a new repository
•   convert a pre-v14 repository (that is TSS Version 11.0.1, 11.5.2, 

12.0.1, 13 or 13.5.1)
•   upgrade a v14 or v15 repository 
•   browse for an existing repository that is not associated with any 

previous TSS installation
Trillium Software System Installation Guide 55



Installing the Repository Server
Trillium recommends backing up any existing repository and data 
that you plan to reuse. 

 10.   Select one of the following option and click Next.

 New Installation - Select this default option if you do not want to 
reuse existing data. Proceed to step 11 on page 60.    

 Upgrade/convert existing repositories - Select this option if you 
have existing repository servers that you want to reuse. See 
Upgrade/convert existing repositories to re-use on page 57.
•   If they are pre v14, you will have to convert the repositories to 

v15.0
•   If they are v14.x or v15.x, you will have to upgrade them to 

v15.0
 Browse for existing repository - Select this option if you have an 

existing repository server that is not associated with one in the 
standard location on the current server. For example, say you are 
installing TSS 15 on a different server than you installed previous 
versions. For configuration instructions, see Browse for existing 
repositories on page 59.
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Upgrade/convert existing repositories to re-use

Use the following procedure to upgrade/convert existing repository.

To upgrade/convert existing repositories to reuse

When you select the Upgrade/convert existing installation option, and 
click Next, all available repositories are listed. 

a. Verify you made a backup of the data you plan to reuse.

b. Select the repository you want to upgrade/convert. 

In this image, you are selecting to upgrade a TSS 14 repository. If 
you selected a TSS v12 repository, it would be converted.
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c. Verify that the Copy the existing repositories before 
conversion box is checked. 

d. Click Next. You are prompted for username and password.

e. In Username enter the username associated with the repository 
you are upgrading or converting.

f. In Password, enter the password for the user. 

g. Click Next. The login credentials are verified. (Once validation is 
successful, the repositories are stored in the \15\Data folder after 
repository installation is complete. Click Change to specify a 
different folder location). 

If you do not copy the existing repositories, the 
conversion overwrites the existing ones so they will no 
longer work with your previous version of TSS. Trillium 
recommends that you back up any existing 
repositories.
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h. Click Next. The Repository Folder window opens.

i. Proceed to step 11 on page 60.

Browse for existing repositories
Use the following procedure to search for existing repositories that are 
not associated with any previous TSS installation. 

To browse for existing repositories

When you select Browse for existing repositories option, and click Next, 
the Browse for existing repositories window opens.

a. Click Change.

b. Browse and select a repository server to re-use. 

c. Click Next. The Repository Folder window opens.
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d. Verify that the Copy the existing repositories before 
conversion box is checked. 

e. Proceed to step 11. 

 11.   To keep the default location to store repositories in the \15\Data 
folder, click Next. To specify a custom location, click Change and 
select the location.

You were asked to specify a repository server path in step 9 on 
page 55. These two paths must be distinct. For example, if you 
specified the server path as C:\Trillium_Software\server, you can 
define the repository path as C:\Trillium_Software\ repository.
The Create Sample Data window opens. 

If you do not copy the existing repositories, the 
conversion overwrites the existing ones so they will no 
longer work with your previous version of TSS. Trillium 
recommends that you back up any existing 
repositories.
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If you are reusing data from a previous version, you will not 
see the Create Sample Data window.

 12.   Select one or both options if you want to install the sample data, then 
click Next. The sample data allows you to create simple entities and 
projects and get familiar with TSS.

If you do not select any option, the server does not install the sample 
data files.
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The Server Ports window opens.

 13.   Specify the server port numbers. 

a. In Repository Server, enter a port number or keep the default 
15040.

b. In Repository Server Scheduler, enter a port number or keep the 
default 15041. 

c. In Apache Tomcat Start Server, enter a port number or keep the 
default 15060.

d. In Apache Tomcat Stop Server, enter a port number or keep the 
default 15061. 

e. In UI Web Server Port, enter a port number or keep the default of 
3000.

 14.   Click Next. The License Server window opens.

The license server is a service that authorizes your site to perform 
certain functions within TSS. The license server can be hosted by the 
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Repository Server Scheduler service or by a different service or 
daemon.

 15.   Select one of the following options: 

 The license server runs on a different host - Select this option to 
install the repository server on more than one machine and to host 
the license server on a remote machine.  
For this option, you do not need to activate the license file on the 
remote server since the remotely hosted server is already actively 
licensed.

 The license server only supports local applications - Select this 
option to install the repository server and client applications (such as 
the Control Center) on the same machine.  
For this option, you will need to activate the license file. The server, 
once installed locally, is accessible to remote clients.

If you do not select any option, the server is installed locally and is 
accessible to remote clients.
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a. For The license server runs on a different host option, go to the 
License server address details section and click Change. The 
License Server Address Details window opens.

b. In DNS Name/IP Address, enter the fully qualified domain name 
or the IP address of the machine where the license server is 
installed. 

c. In Port, enter the port number associated with the license server.

d. Click OK.

 16.   Click Next.
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The Repository Security window opens.

 17.   Configure Windows authentication (default) or Trillium authentication. 
Windows authentication establishes the Windows Active Directory for 
TSS users. This option is more robust when defining repository security 
levels. See the TSS Repository Administrator’s Guide for information on 
TSS user security. Save the repository administrator login credentials in 
a safe place. This information is needed to log into Repository 
Administration Command Prompt and the Repository Manager.

 To configure Windows authentication

a. In Username, enter the name of the Windows administrator who 
will manage the Trillium repositories. 

b. In Password, enter the password of the user.   

 To configure Trillium authentication 

a. Clear the Use Windows Authentication selection. 

b. In Username, type a name for the repository administrator. 
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c. In Password and Confirm Password, enter the password for the 
user.    

 18.   Click Next. The Ready to Install window opens.

 19.   Click Install to begin the installation. A progress window shows the 
progress of the installation. When the installation is complete, the 
InstallShield Wizard Completed window opens (see next page). 

If you are upgrading or converting existing repositories, the 
process may take anywhere from a few minutes to several hours, 
depending on the size of the repositories you are re-using. Refer 
to the mtb_server.log to check the status of the upgrade/
conversion. If the conversion stopped before completion, contact 
Trillium Technical Support to resolve the issue.
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 20.   Click Finish to close the wizard. 

 21.   Restart your system if prompted to perform a restart. 

 22.   Ensure that the ports are not blocked by your firewall. If they are, use 
Windows Firewall with Advanced Security, Inbound and Outbound rules, 
and set the Allow the Connection option.
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Examining Directory Structures and Files
After you have completed repository server installation, navigate to the 
following directories and verify that you have the files and folders listed in the 
image below.

Repository Server 
If you selected the default directory 
during the repository server 
installation, your server directory 
structure will look like this:

This book refers to the path that you 
specified during installation as the 
repository server path.

Repository 
If you selected the default repository 
directory during the repository 
server installation, the repository 
structure will look like this:

This book refers to the path that you 
specified during installation as the 
repository path.
68 Trillium Software System Installation Guide



Installing the Repository Server 
Activating Trillium Software System License on 
Windows
Before you can begin to use TSS 15, activate the license key that was shipped 
with the product. 

The license is attached to the email that contains the instructions to download 
the TSS software from the TSS Download Center (File Portal) FTP website. 

 To activate the license key

 1.   Log in to the repository server as the TSS application administrator.

 2.   Copy the license.txt file to Server_Install_Path\etc

For example, if the server path is: 
C:\Program Files(x86)\Trillium Software\MBSW\15\

copy the license.txt file to:
C:\Program Files(x86)\Trillium Software\MBSW\15\etc

If you did not receive a license key, contact Trillium Software 
Customer Support at techsupport@trilliumsoftware.com.

 3.   Click Start > All Programs > Trillium Software > TSS 15 > 
Repository Administration Command Prompt to open the 
Repository Administration Command Prompt. 

 4.   Log in using the TSS repository administrator credentials. For Windows 
authentication, provide the fully qualified Windows user name (for 
example, tssadmin@domain.com). 

 5.   Press Enter.

 6.   If you converted an existing repository, you are prompted for a 
repository name. Provide the repository name and press Enter.
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 7.   At the prompt _control:, enter activate then press Enter.

 You see the message: Successfully activated license.

 8.   Type exit to close the command prompt.

The _control repository is a special repository that allows you to 
set up your system. Never log in to the _control repository and 
import data to it. 

Starting TSS Scheduler on Windows
Before you can begin working with TSS, you must start TSS 15 Scheduler. 

 To start TSS Scheduler

 1.   Log in as the TSS application administrator.

 2.   From the Windows Control Panel, open System and Security > 
Administrative Tools > Services.

 3.   Select the service named TSS 15 - Scheduler.

 4.   Set the Windows Service TSS 15 - Scheduler to a domain service 
account user with access to the server hosting the database to which 
you connect to load data (create real, fully-loaded entities). 

 5.   Right-click and select Start. The Status changes to Started. 

 6.   As with TSS 15 - Scheduler, set the TSS - inetd service to also run as 
a Windows domain account instead of a system account.
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Starting Apache Tomcat on Windows
If you plan to use 32-bit TS Web Services, part of the Enterprise Connectivity 
Solutions (ECS), you must start Apache Tomcat. Use the batch file 
(startup.bat) or install Tomcat as a service. 

You must first set the JRE_HOME (and JAVA_HOME for JDK) environment 
variable. To verify your Java version, open a command prompt and enter java 
-version. Ensure Java 1.8 32-bit version is installed.

 To start Apache Tomcat on Windows using the start-up batch file

 1.   Log in as a user with system administrator privileges and open a 
command window (cmd.exe).

 2.   Verify that the JRE_HOME variable (and JAVA_HOME for JDK) in the 
setenv.bat file is set to your Java JRE location. For example:

JRE: Set JRE_HOME=C:\Program Files (x86)\Java\jre1.8.0_102 
       Set PATH=%JRE_HOME%\bin;%PATH%

JDK: Set JAVA_HOME=C:\Program Files (x86)\Java\jdk1.8_102 
    Set JRE_HOME=%JAVA_HOME%\jre 
       Set PATH=%JRE_HOME%\bin;%PATH%

The setenv.bat file is located in C:\Program Files (x86)\Trillium 
Software\MBSW\15\Apache_Tomcat\bin

 3.   Run the start-up script startup.bat, located in C:\Program Files 
(x86)\Trillium Software\MBSW\15\Apache_Tomcat\bin. A Tomcat 
window opens. Allow the startup process to complete before attempting 
to use Tomcat.

 4.   Verify that Tomcat started correctly by checking the Tomcat server at 
http://localhost:port/.

 5.   To shut down the server, run the shutdown.bat file, also in the Apache 
\bin directory.
Trillium Software System Installation Guide 71



Installing the Repository Server
 To install Apache Tomcat on Windows as a service (with 
setenv.bat)

 1.   Log in as a user with system administrator privileges and open a 
command window (cmd.exe).

 2.   To set JRE_HOME, navigate to the Tomcat bin directory (C:\Program 
Files (x86)\Trillium Software\MBSW\15\Apache_Tomcat\bin) and 
enter setenv.bat

 3.   Enter service install 

 4.   To verify the Tomcat service was installed, enter Tomcat8w to return 
the path of the installation. 

 5.   Open the Administrative Tools > Services window and confirm the 
Apache Tomcat 8.0 Tomcat8 displays in the services list. 

 To install Apache Tomcat on Windows as a service (without 
setenv.bat)

 1.   Log in as a user with system administrator privileges. 

 2.   Open the System Properties window and click the Advanced tab. 

 3.   Click Environment Variables to open the Environment Variables 
window. 

 4.   Verify that your JRE_HOME system variable is set to your Java JRE 
location, for example, C:\Program Files\Java\jre1.8.0_102. Add the 
variable if necessary.

 5.   From an Administrative command prompt, navigate to the Tomcat bin 
directory; for example, C:\Program Files (x86)\Trillium 
Software\MBSW\15\Apache_Tomcat\bin

 6.   Enter service install. If you have not set JRE_HOME, you are 
prompted to do so now. If prompted to start the Commons Daemon 
Service Runner, click Yes. 

The message The service ‘Tomcat8’ has been installed displays. 

 7.   To verify the Tomcat service was installed, enter Tomcat8w to return 
the path of the installation. 
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 8.   Open the Administrative Tools > Services window and start the 
Apache Tomcat 8.0 Tomcat8 service. 

Starting TSS RestAPIs on Windows
The TSS 15-RestAPIs service starts automatically and does not require a 
manual start. 

If you need to restart the service, use the instructions below.

 To restart TSS RestAPIs

 1.   Log in as the TSS administrator.

 2.   From the Windows Control Panel, open System and Security > 
Administrative Tools > Services.

 3.   Select the service named TSS 15 - RestAPIs.

 4.   Set the Windows Service TSS 15 - Rest API to a domain service 
account user with access to the server hosting the database to which 
you connect to load data (create real, fully-loaded entities). 

 5.   Right-click and select Start. 
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CHAPTER 3 Installing TSS Country 
Templates

This chapter contains instructions on how to install the country templates. 
When you create a name and address project in TS Quality, you will typically 
use a template for each country whose data is present in the entity you used 
to create the project. Each country template supplies a pre-built set of TSS 
best practices and business rules optimized for that country.

Trillium Software subscribes to many country-specific postal services 
that enable us to expand our worldwide coverage and provide a 
central location to acquire data for low- to mid-tier economic regions.

This chapter includes:
 Installing the Country Templates on UNIX on page 74
 Installing the Country Templates on Windows on page 83

Installing the Country Templates on 
UNIX
You can install the country templates on a UNIX machine:

 Using the InstallShield Wizard
 Using the Console Mode
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Using the InstallShield Wizard
To install country templates using the InstallShield wizard, a Graphical User 
Interface (GUI) must be present. When installing on UNIX, InstallShield uses 
the X Window System. If a PC is serving as the user interface for a UNIX  
installation, an X Server — such as Hummingbird eXceed — must be running 
on the PC. 

 To install country templates using the InstallShield wizard

 1.   Log on as the TSS application administrator. 

 2.   If you have not yet done so, download the setup file from TSS 
Download Center (File Portal) FTP site. 

 3.   Locate the following directory: /[platform]Server

 4.   Unzip and copy the setup file to the tmp directory on your UNIX server.

For Linux, the /tmp directory you copy the setup file to must 
have executable permissions set.

 5.   Set execute permissions on the setup file:  
chmod +x tss_ct_version.build_platform.bin

 6.   Run the setup file. For example,: 
tss_ct_version.build_sunos.bin

The installation program starts and shows the Welcome message.
Trillium Software System Installation Guide 75



Installing TSS Country Templates
 7.   Click Next. The License Agreement window opens.
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 8.   Read the License Agreement, click the I accept the terms of the 
agreement option.

 9.   Click Next. The Product Key window opens. The Product Key 
determines which country templates and city tables are installed. 

 10.   Enter the 18-Character Product Key. The product key contains 
information on which countries are supported as part of your license 
agreement with Trillium Software.

the product key is attached to the email that contains the instructions to 
download the TSS software from the TSS Download Center (File Portal) 
FTP website. 

 11.   Click Next. The Destination Directory window opens. 

 12.   Click Next to install to the default location. Keep in mind that the 
country templates must be installed at the same location where you 
installed the repository server.

If you installed the repository server at a custom location, click Browse 
to select the custom repository location and then click Next. 
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 13.   Click Next. The Summary window opens listing the country templates 
that are installed. 
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 14.   Click Install to begin installation. The InstallShield Wizard displays the 
progress of the installation. When installation is complete, the 
installation completed window opens.

 15.   Click Finish to close the wizard. 
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Using the Console Mode
Use the following procedure to install the country templates in console mode. 

To install country templates in console mode 
 1.   Log on as the TSS administrator. 

 2.   If you have not yet done so, download the setup file from TSS 
Download Center (File Portal) FTP site. 

 3.   Locate the following directory: /CountryTemplates

 4.   Copy the setup file to a convenient location on your UNIX server. If you 
downloaded a zip file, unzip and copy the file.

 5.   Set execute permissions on the setup file:  
chmod +x tsq15.platform.bin

 6.   Run the setup file. For example,: 
./tss_ct_version_sunos/.sh -console

 The setup prepares for the installation and opens the console.

 7.   Press Enter. The license agreement opens.
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 8.   Read the license agreement, and if you agree, type 1, then press Enter.

 9.   Press Enter again to accept the license agreement and proceed. The 
product Key prompt opens.

The product key is attached to the email that contains the instructions 
to download the TSS software from the TSS Download Center (File 
Portal) FTP website. 

 10.   Enter your product key and press Enter.

The Destination Directory prompts opens. Keep in mind that the 
country templates must be installed at the same location where you 
installed the repository server.
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 11.   Type the location where the country templates should get installed.

 12.   Press Enter. The Country Templates summary opens.

 13.   Review the summary screens, pressing Enter to display the next 
screen. Alternately, type q to bypass the summary screens. 

 14.   Press Enter to install. A progress bar opens showing the progress of the 
installation. 

 15.   Press Enter to finish.
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Installing the Country Templates on 
Windows
Use the following procedure to install the country templates on a Windows 
server.

 To install the country templates

 1.   Log in as the Windows administrator. 

 2.   If you have not yet done so, download the setup file from TSS 
Download Center (File Portal) FTP site. 

 3.   Locate the \CountryTemplates folder.

 4.   Double-click the setup file to begin the installation. The InstallShield 
Wizard gathers the required information and shows the welcome 
message.
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 5.   Click Next. The License Agreement window opens. 

 6.   Read the License Agreement and select I accept the terms in the 
license agreement option. 

 7.   Click Next. The Product Key window opens. The product key contains 
information on which countries are supported as part of your license 
agreement with Trillium Software.
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 8.   Enter a valid 18-character product key and click Next. 

The product key is attached to the email that contains the instructions 
to download the TSS software from the TSS Download Center (File 
Portal) FTP website. 

The Language window opens, with ENGLISH as the default language to 
use for reports and log files.
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 9.   To choose another language, click the drop-down list and select from 
the available languages. 

This language setting only affects TS Quality processes 
running outside the Control Center.

 10.   Click Next. The Destination Folder window opens.

Alternately, click Change to specify a different location, then click 
Next.
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The Destination Folders window opens.

 11.   Click Next to install to the default location (country templates must be 
installed at the same location where you installed the repository 
server).

If you installed the repository server at a custom location, click Change 
and browse to that location. Then click Next.
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The Ready to Install window opens listing all the countries for which 
templates are installed. (Only the countries for which you are licensed 
for appear in the list.)  

 12.   Click Install to begin the installation. A status window shows the 
progress. When the installation is complete, the InstallShield Wizard 
Completed window opens.
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 13.   Click Finish to close the wizard. 
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CHAPTER 4 Installing the Control 
Center

This chapter contains instructions on how to install the Control Center on a 
client (Windows) system and includes the following sections:

 Installation Checklist on page 91
 Installing the Control Center on page 92
 Examining Directory Structure on page 100 
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Installation Checklist 
Before you install the Control Center: 

 Familiarize yourself with the install setup and any associated release 
notes. 

 Consult the checklist on page 22 to verify that your system meets the 
hardware and software requirements. 

 Verify network connectivity and access to the repository server by 
issuing a telnet command from the TSS client machine to the server.

 If you cannot telnet to the repository server, you will not be able to 
install the Control Center.

 If you have installed TS Quality, verify connectivity and access to TS 
Quality.

 If you are installing the Control Center on Windows 7, Windows 8/8.x, 
Windows 2008 or Windows 2012 turn off the Windows User Account 
Control function. For more information, see About User Permissions 
(UAC) on page 26.
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Installing the Control Center
The Control Center uses DLLs that are common to other TSS client 
applications. To ensure that the latest common DLLs are installed along with 
the Control Center, you may be asked to shut down some applications before 
installing the Control Center.

 To install the Control Center

 1.   Log in the Windows system as the Windows Administrator.

 2.   If you have not yet done so, download the setup from TSS Download 
Center (File Portal) FTP site. 

 3.   Go to the Control Center Client directory. 

 4.   Double-click the setup file to begin the installation. The InstallShield 
Wizard gathers the required information and shows the welcome 
message.
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 5.   Click Next. The License Agreement window opens. 

 6.   Read the agreement and if you agree, select I accept the terms in 
the license agreement option. 
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 7.   Click Next. The Customer Information window opens.

 8.   In User Name, enter your name. This is an optional configuration.

 9.   In Organization, enter your organization information. This is an 
optional configuration.

 10.   In the Install this application for: section, select from:

Anyone who uses this computer (all users) - this is the 
default option

Only for me (Employee Of) - choose this option to access the 
Control Center using the login credentials you are currently using. 
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 11.   Click Next. The Setup Type window opens.

 12.   Select one of the following options.

 Complete  - to install all the Control Center components under the 
default directory:  
C:\Program Files (x86)\Trillium Software\TssUI\15\

 Custom - to install the Control Center components in a custom location 
or to opt out of installing the Repository Manager or ECS Tools. 

a.  Click Next to open the Custom Setup window. 
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b. Select the components and features you want to install.

c. Click Change to select an alternate installation directory.

 13.   Click Next. The Repository Server window opens.
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 14.   Specify the repository server that this client will access.

a. In Repository Server Name, specify the local name of the reposi-
tory server or keep the default primary. This name is displayed in 
the login screens of this client. Choose any name that is meaningful 
to the person accessing the repository. 

b. In Repository Server Host Name, specify the server host name. 
The default is localhost - use this if you are installing the Control 
Center in the same system running the repository server. 

c. In Repository Server Port, enter the repository server login port 
that was defined during the repository server installation. The 
default is 15040.

 15.   To access an alternate repository server, click More and define the 
alternate repository server parameters using information above. 
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 16.   Click Next. The Ready to Install window opens. 

 17.   Click Install to begin the installation. A status bar shows the progress. 
When installation is complete, the InstallShield Wizard Completed 
window opens.
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 18.   Select Test Repository Server connections option to test server 
connectivity. 

You can also test the connections at any time by selecting Trillium 
Software > TSS 15 > Test Repository Connections from the Start 
menu.

 19.   Click Finish to complete the installation. 

 20.   Restart the machine if prompted. 

If your repository server is running on a UNIX system and you 
receive any error message, try to log in to the Control Center. 
If you can open the Control Center without any issues, ignore 
the error message. If you are unable to log in to the Control 
Center, contact Trillium Software Customer Support.
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Examining Directory Structure
Once you have installed the Control Center, a new directory structure is 
created on the client machine. If you selected the default directory during 
installation, the directory structure will look like this:
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CHAPTER 5 Installing the Batch 
Deployment Tool

This chapter contains instructions on how to install the Batch Deployment Tool 
(BDT). BDT is used to export a batch script. It can also be used to generate a 
batch script from a previously exported project definition. 

Install the Batch Deployment Tool on every client and server machine that you 
will use to generate a batch script.

This chapter includes:
 Installing the Batch Deployment Tool on UNIX on page 102
 Installing the Batch Deployment Tool on Windows on page 104
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Installing the Batch Deployment Tool 
on UNIX
You can install the BDT on the repository server to export a project definition 
to a server and create the batch script on the server. Installing the BDT on the 
server has the following advantages: 

 It allows you to make changes to the exported definition files, generate 
a batch script from the modified project definition, and, if needed, 
import the modified project definition back into the Control Center to 
make additional changes without losing any modifications.

 It allows you to easily move the project to a different system before 
generating the script files, which ensures that the paths used in the 
project files are correct for the target system.

On a server, you run the Batch Deployment Tool from the command line. See 
the Repository Administrator’s Guide for details

 To install the Batch Deployment Tool

 1.   Log in to the server system where you will install BDT as the TSS 
Administrator. 

 2.   If you have not yet done so, download the setup from TSS Download 
Center (File Portal) FTP site.

 3.   Locate the following directory: /[platform]Server

 4.   Unzip and copy the setup file to a convenient location on your UNIX 
server.

This location should be different from where you copied the 
repository server installation setup in order to prevent 
overwriting of files.

 5.   Run the setup file. For example:
tss_bdt_version.build_sunos.sh
If you are having problems running the setup, verify that the setup file 
has the correct execute permission for the TSS Administrator. If not, 
use the chmod command to grant execute permission.
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 6.   At the prompt Where would you like to install the Batch 
Deployment Tool? enter the name of the install directory (for 
example, /opt/TrilliumSoftware/bdt).

 7.   At the prompt Please check your installation settings to make 
sure they are correct. Continue installation? (y/n):, verify that 
the settings that you have specified are correct.

 Enter y if the settings look correct and you want to continue the 
installation.

 Enter n if the settings are not satisfactory. The program takes you 
back to the beginning of the process.

If you enter y, the BDT installation begins. When installation is 
complete, you see the Batch Deployment Tool installation 
complete message.
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Installing the Batch Deployment Tool 
on Windows
Complete the following procedure for each client system where you plan to 
export projects.

The BDT uses DLLs that are common to other TSS client applications. 
Therefore, you may be asked to shut down some applications before installing 
the BDT so that the latest common DLLs are installed along with the BDT.

 To install the Batch Deployment Tool

 1.   If you have not yet done so, download the setup file from TSS 
Download Center (File Portal) FTP site. 

 2.   Login as the Windows Administrator. 

 3.   Go to the \BDT directory.

 4.   Double-click the setup file to begin the installation.
104 Trillium Software System Installation Guide



Installing the Batch Deployment Tool 
The InstallShield Wizard gathers the required information and opens the 
Welcome window.

 5.   Click Next. The License Agreement window opens. 
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 6.   Read the License Agreement and select I accept the terms in the 
license agreement option. 
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 7.   Click Next.The Customer Information window opens.

 8.   In User Name, enter your name (optional). 

 9.   In Organization, enter your organization information (optional).

 10.   Click Next.
Trillium Software System Installation Guide 107



Installing the Batch Deployment Tool
The Destination window opens.

 11.   Click Next to accept the default destination. 
Alternately, click Change to specify a different location, then click 
Next.
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The Ready to Install window opens.

 12.   Click Install to install BDT. When installation is complete, the 
InstallShield Wizard Completed window opens.
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 13.   Click Finish to close the wizard. 

To see the installer log file, click the Show the Windows Installer log 
option. The log file opens in your default text editor. You can save the 
log file for troubleshooting purposes.

If you export a batch script from the Control Center, the Batch 
Deployment Tool is automatically run.
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CHAPTER 6 Installing TS Reporting 
Adapter

The TS Reporting Adapter is a callable reporting adapter designed to run table 
queries which extract the contents of a TSS repository and import the data 
into a third-party data consumer such as Excel, QlikView, and Tableau.

There are two supported types of data connection providers: Object Linking 
and Embedding, Database (OLE DB) and Open Database Connectivity (ODBC). 
32- and 64-bit versions of each are available, depending on your needs. 

This chapter includes the following sections:
 Installing ODBC 32-Bit Reporting Adapter on page 113
 Installing ODBC 64-Bit Reporting Adapter on page 122
 Installing OLE DB 64-Bit Provider on page 125

For information about how to configure and use the reporting 
adapters and providers, see TS Reporting Adapter for Excel User’s 
Guide. 
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What Do You Need To Install?
Both OLE DB and ODBC providers support loading data into 32-bit and 64-bit 
third-party applications. Note the following to understand what you need to 
install:

 To use the OLE DB Provider with a 64-bit version of Excel, you must 
install the 64-bit version of the OLE DB Provider. The OLE DB Provider 
(64-bit) installer is supplied with TSS client/Control Center software. 

 To use the ODBC Provider with a 64-bit version of Excel, you must 
install the 64-bit version of the ODBC Provider. The ODBC Provider (64-
bit) is available as a separate installation package. 

 The 32-bit version of the OLE DB TS Reporting Adapter is installed 
automatically when you install the client/Control Center software. No 
additional installation is required. 

 ODBC Provider for 32-bit applications is available with TSS client/
Control Center software as a separate install. 
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Installing ODBC 32-Bit Reporting 
Adapter
Install the ODBC Data Adapter on the same Windows system where you plan 
to create ODBC DSNs. For information on using ODBC Reporting Adapter, see 
the TS Reporting Adapter for Excel User’s Guide. 

It is not a requirement that the repository server or the Control Center be 
installed in the same system where you will install ODBC Reporting Data 
Adapter and create the DSN. The instance of Excel you use must reside on the 
same system on which you create the DSN.

After you install the 32-bit ODBC adapter, you must also configure the ODBC 
DSN. See Configuring ODBC DSN on page 119.

 To install ODBC 32-bit Reporting Data Adapter

 1.   Login as the Windows Administrator. 

 2.   If you have not yet done so, download the setup file from TSS 
Download Center (File Portal) FTP site. 

 3.   Go to the \ODBC_Reporting_Adapter directory. 
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 4.   Double-click the setup.bat file to begin the installation. The 
InstallShield Wizard gathers the required information and shows the 
welcome message.

 5.   Click Next. The License Agreement window opens. 
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 6.   Read the License Agreement and select I accept the terms in the 
license agreement option. 

 7.   Click Next.
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The Destination window opens.

 8.   Click Next to accept the default destination. 
Alternately, click Browse to specify a different location. Then click 
Next.
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The Select Program Folder window opens.

 9.   Do one of the following:

 Accept the default location of Trillium Software to add program icons 
by clicking Next.

 Select another folder in the Existing Folders window, and click Next. 

The Start Copying Files window opens. 
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 10.   Review the information in the Current Settings section.

 To make changes to the installation settings, click Back. 
 To continue the installation, click Next. 
The Setup Status window opens, showing the progress of the 
installation. When the installation finishes, the InstallShield Wizard 
Complete window opens.

 11.   (Optional) Select View the Readme file. 

 12.   Click Finish to close the window and finish the install.

 13.   Go to Configuring ODBC DSN on page 119. 
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Configuring ODBC DSN
You must configure an ODBC DSN for each repository from which you want to 
access data on the system where you installed the TSS ODBC Provider.

Before you start this procedure, you must first perform the following:

 1.   Install TSS Repository Server in your environment (they do not need to 
be installed on the same system as the DSN). Create a repository.

 2.   Install either 32-bit or 64-bit ODBC Reporting Adapter on the same 
Windows system where you plan to create ODBC DSNs. 

 To configure ODBC DSN data source

 1.   On the TSS repository server system, click Start > Programs/All 
Programs > Trillium Software > ODBC Administrator. The ODBC 
Data Source Administrator window opens. 

 2.   Click the System DSN tab. 

 3.   Click Add. The Create New Data Source window opens. 
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 4.   Scroll through the list of available drivers and select TSS ODBC 
Reporting Adapter. 

 5.   Click Finish. The Trillium ODBC DSN Setup window opens.

 6.   In the DSN Properties section, enter information in the following fields:

 Data Source Name. Enter a name for the DSN you are creating. 
This will be the name displayed by the application when it requests a 
connection to the data source. 

This name cannot be changed after you click OK to save these 
properties. 

 Description. Enter a brief description of the data source. 
120 Trillium Software System Installation Guide



Installing TS Reporting Adapter 
 7.   In the Connection Properties section, enter information in the following 
fields:

Service Name and Service Data Source fields are populated 
automatically and cannot be modified. 

 User name. Name of the TSS administrator who created the 
repository. 

 Password. Password of the TSS administrator who created the 
repository. 

 Host. TSS repository server host name for the system where the 
repository is located. Enter localhost if you are creating the DSN on 
the TSS server system. Otherwise, enter the name or IP address; for 
example, tsserver or 123.456.789.10.

 Port. Repository Server port defined during installation of the 
repository server. For example, 15040.

 Repository. Name of the repository. 

 8.   Click Test. After a few seconds a message opens stating that the data 
source connection was successful. If the test is not successful, a Failed 
to attach to Repository [repository_name] opens. Verify the information 
entered in the Trillium ODBC DSN Setup window and click Test again.

To use the reporting adapter, follow the guidelines and procedures in the TS 
Reporting Adapter for Excel User’s Guide. 
Trillium Software System Installation Guide 121



Installing TS Reporting Adapter
 9.   Click OK. The Setup window closes and the name of the new DSN 
displays in the System Data Sources section of the System DSN tab.

 10.   (Optional) To change the properties for the DSN, select the DSN name 
and click Configure. You cannot change the data source name or the 
Service Name and Service Data Source connection properties. 

 11.   (Optional) To delete a DSN, select it and click Remove.

 12.   Click OK to close the ODBC Data Source Administrator window.

Installing ODBC 64-Bit Reporting 
Adapter
The ODBC reporting adapter supports 32- and 64-bit versions of Excel. Before 
you use the ODBC Provider with a 64-bit version of Excel, you must install the 
64-bit version of the ODBC Provider.

The ODBC reporting adapter (64-bit) is available with the TSS client/Control 
Center installation package, although it must be installed separately. 
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 To install the TSS ODBC reporting adapter (64-bit)

 1.   Navigate to the Client\ODBC_Reporting_Adapter installation file 
directory in the TSS installation files. For example, ...\TSS_Windows_
Client_and_Server\Client\ODBC_Reporting_Adapter.

 2.   Double-click the setup.bat file. The Welcome window opens. The setup 
wizard Welcome window opens. 

 3.   Click Next. The License Agreement window opens. 

 4.   Click I accept the terms of the License Agreement.

 5.   (Optional) Click Print to print a copy of the text displayed in the License 
Agreement window.

 6.   Click Next. The Choose Destination Window opens.
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 7.   Do one of the following:

•   To install the software to the default directory, click Next.
•   To choose another directory, click Browse, navigate to the 

directory, click OK, then click Next. 

The Select Program Folder window opens. 

 8.   Select a Program Folder (the default is Trillium Software) and click 
Next. The Start Copying Files window opens. 

 9.   Review the install settings. Click Back to change a selection. Click Next 
to start the install. The Setup Status window opens and displays the 
progress of the installation. When the install finishes, the InstallShield 
Wizard Complete window opens. 

 10.   Click Finish to close the wizard. 

To use the reporting adapter, follow the guidelines and procedures in the TS 
Reporting Adapter for Excel User’s Guide. 
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Installing OLE DB 64-Bit Provider
The OLE DB Data Provider supports 32- and 64-bit versions of Excel. Before 
you use the OLE DB Provider with a 64-bit version of Excel, you must install 
the 64-bit version of the OLE DB Provider.

The OLE DB Provider (64-bit) is available with the TSS installation package, 
although it must be installed separately. 

 To install the TSS OLE DB Provider (64-bit)

 1.   Navigate to the Client\OLEDB64 installation file directory in the TSS 
installation files. For example, ...\TSS_Windows_Client_and_
Server\Client\OLEDB64.

 2.   Double-click the setup.bat file. The Welcome window opens. 

 3.   Click Next. The License Agreement window opens.

 4.   Click I accept the terms of the License Agreement if you accept the 
terms.
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 5.   (Optional) Click Print to print a copy of the text displayed in the License 
Agreement window.

 6.   Click Next. The Destination Folder window opens. 

 7.   Do one of the following:

 Click Next to accept the default install location. 
 Click Change to navigate to and select a different install destination 

location. Then click Next. 

The Ready to Install the Program window opens. 

 8.   Click Install to start the installation. 

 9.   When the Completed window opens, click Finish.

To use the reporting adapter, follow the guidelines and procedures in the TS 
Reporting Adapter for Excel User’s Guide. 
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CHAPTER 7 Installing EDQ 

This chapter describes how to install Enterprise Data Quality (EDQ) on Linux 
and Windows systems.

This chapter includes:
 About EDQ on page 127
 Installing EDQ on Linux on page 128
 Installing EDQ on Windows on page 143
 Starting the Apache Tomcat Web Server on page 167
 Setting Table Locations on page 168
 Running 64-Bit and 32-bit Concurrently on page 170

About EDQ
Enterprise Data Quality (EDQ) is the 64-bit enabled implementation of TS 
Quality. Depending on your product key, your EDQ installation options may 
include:

 Enterprise Data Quality, which installs the 64-bit enabled core TS 
Quality modules and Trillium tables.

 TS Quality for Real Time, which installs the TS Director, and includes 
two optional components:
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•   TS Web Services, which enables TS Quality processing through REST 
and SOAP requests to the Apache Tomcat web server.

•   Director SDK, which enables TS Quality processing through a 
connector client.

 64-bit EDQ client interface components (Windows only): 
•   Director System Manager (64-bit) - A graphical user interface that 

allows you to control Director, cleansing and matching. 
•   Project Rule Analyzer (64-bit) - A tool that allows you to test 

cleansing and matching rules and logic. 
•   Web Service Manager (64-bit) - A web service test tool that allows 

you to send REST and SOAP requests for cleansing and matching 
services.

The 64-bit client interface components are automatically installed 
with the Enterprise Data Quality option. No installation option is 
displayed for these; you cannot select a subset of these 
components for installation.

 TS Quality for SAP, which installs the SAP connector, enabling TS 
Quality integration with the SAP NetWeaver RFC client.

Installing EDQ on Linux
The EDQ installation on Linux requires:

 The basic calculator (bc). If not installed, the following error will display:
'bc' command was not found. Please make sure bc is in the 
path and run the installer again.

Install the basic calculator and restart the installation.

 Libraries that allow for 32-bit applications to run on 64-bit architecture. 
If these are not found, the following error will display:
Bundled JRE is not binary compatible with host OS/Arch or it 
is corrupt. Testing bundled JRE failed.

Running the following commands from an account with sudo privileges 
will resolve this issue.
sudo yum install glibc-common glibc 
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sudo yum install glibc.i686 

If you are installing EDQ on Red Hat, EDQ supports Red Hat 
Enterprise Linux versions 6 and above only.

 To install EDQ on Linux

 1.   Download the Enterprise Data Quality installation zip file from the TSS 
Download Center (File Portal) FTP website and decompress the zip file.

 2.   Copy the executable (tss_edq_version.build_linux.bin) from the 
EDQ64 folder into a directory to be used as the base directory.

If you are copying the executable file from another machine, 
such as a PC, be sure to copy the file in binary mode, so that 
it can be executed on the UNIX system.

 3.   Run the executable file that you copied in Step 2, using the -console 
option.

 4.   Read the Welcome message and enter 1 to continue. 

 5.   At the License Agreement prompt enter 1 to select I accept the terms 
of the license agreement, then enter 0 then 1 to continue.

 6.   Enter your product key, then enter 1 to continue.

 7.   Enter a Destination Directory or accept the default /opt/trillium, then 
enter 1 to continue. If the directory you specify does not exist, the 
installation program creates it.

 8.   Select the features to install on this computer. The features listed vary 
depending on your product key. By default, all features activated by 
your product key will be installed. To omit a feature, enter the number 
of the feature to be excluded. 

Some features include optional components. These are described in 
their relevant sections.
Because EDQ uses a distributed architecture, you can install these 
components on different computers in your network.

The next prompt displayed depends on the features you have selected for 
installation.
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Installing TS Quality for Real Time
The TS Quality for Real Time option installs the TS Director, a service that 
provides transaction load balancing and server connection management for 
client applications. There are two optional components available with the TS 
Quality for Real Time installation:

 TS Web Services - TS Web Services enables Trillium processing through 
industry-standard REST and SOAP requests. Selecting this option 
installs the Apache Tomcat Web Server. Java 64-bit version 1.8 is 
required and the JRE_HOME variable must be set to the JRE location.

 Director SDK - The Software Development Kit includes the Java API, 
code samples, and a sample project, director_proj. You can optionally 
install cleansing and matching services to test your client application.

To view the optional components, enter 3, and enter 2. 

Figure 7-1  TS Quality for Real Time Optional Components

To use TS Quality for Real Time, install both the Enterprise Data Quality option 
and one or both of the TS Quality for Real Time options. If you will be installing 
TS Quality for SAP, installation of TS Quality for Real Time is required; the 
optional components (TS Web Services and Director SDK) are not required for 
SAP.

Follow the prompts to select components to be installed.

Depending on components installed, the following prompt may 
display after the Apache prompts.

Set the following parameter:

Director Port: Enter the TCP/IP port number on which the Director will 
listen for incoming connection requests. The default is 15400. You can 
assign any port number available on your system. The Director requires 
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two consecutive ports for communication; ensure that the next 
consecutive port number is also available.

Enter 2 to make changes, or enter 1 to continue. The next prompt displayed 
depends on the components you have selected for installation.

Installing TS Web Services
TS Web Services installs the Apache Tomcat Web Server. Before using TS Web 
Services, you must start the Apache Tomcat Web Server. See page 167 for 
startup information.

Set the following parameters:

Apache Tomcat Start Port: Enter the port number on which the 
Apache Tomcat server listens for requests. The default is 8484.

Apache Tomcat Stop Port: Enter the port number on which the 
Apache Tomcat server listens for stop requests. The default is 8405.

Enter 2 to make changes or enter 1 to continue. The next prompt displayed 
depends on the components you have selected for installation.

Installing Director SDK
The TS Quality Director SDK contains the application programming interface 
(API) tools required to develop client applications that call the TS Quality data 
cleansing and matching servers. The SDK installs the Java API and a sample 
Director project, director_proj. You can optionally install:

Cleansing Server: A server that handles data cleansing requests.

Matching Server: A server that handles data matching requests.

Figure 7-2  SDK Optional Components
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Installing the SDK Cleansing Server

When you install the SDK cleansing server, you are prompted for the 
following:

Director Host: Enter the host name or IP address of the node on 
which the Director is running. 

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening.

Cleansing Server Port: Enter the port number on which the cleansing 
server will listen for requests. Ensure that the same port is not used by 
multiple services. The default is 15410.

Cleansing Configuration File: Accept the default path and file name 
for the sample Trillium configuration file, designed for use with the 
sample project, or enter a new path and name. 

Processing Level: The Processing Level determines how requests will 
be queued for handling by the server. The optimum processing level is 
dependent on your hardware configuration. In general, using one 
thread for each processor yields optimum performance.

At all levels, the maximum number of concurrent attaches is 128. The 
processing level options are:

Minimum - No threads will be spawned for cleansing. Requests will 
be placed in a queue. The client that has been waiting the longest 
for a request to be serviced (based on when the server last 
processed a request for that client) is processed next. Note that the 
network queue limits the number of attach requests that can be 
waiting.

Default - One thread will be actively cleansing; another thread will 
be listening for requests on the network. Other requests will wait 
until the request is completed. This level is most appropriate for a 
system with one or two execution cores. 

High - Eight threads will be actively cleansing. Other requests will 
wait until a request is completed. This level is most appropriate for 
a system with more than four cores. 

Maximum - A thread will be created for each incoming request, 
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within the limit of 128 concurrent attaches. This level can increase 
performance depending on the overall load on the system, for 
example, if some records require more processing resources.

A summary of your selections displays. Enter 2 to make changes or enter 1 to 
continue. The next prompt displayed depends on the components you have 
selected for installation.

Installing the SDK Matching Server

When installing the SDK matching server, you are prompted for the following:

Director Host: Enter the host name or IP address of the node on 
which the Director is running. 

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening.

Matching Server Port: Enter the port number on which the matching 
server will listen for requests. Ensure that the same port is not used by 
multiple services. The default is 15412.

Matcher Configuration File: Accept the default path and file name 
for the sample Trillium configuration file, designed for use with the 
sample project, or enter a new path and name. 

Processing Level: The Processing Level determines how requests will 
be queued for handling by the server. The optimum processing level is 
dependent on your hardware configuration. In general, using one 
thread for each processor yields optimum performance.

At all levels, the maximum number of concurrent attaches is 128. The 
processing level options are:

Minimum - No threads will be spawned for matching. Requests will 
be placed in a queue. The client that has been waiting the longest 
for a request to be serviced (based on when the server last 
processed a request for that client) is processed next. Note that the 
network queue limits the number of attach requests that can be 
waiting.

Default - One thread will be actively matching; another thread will 
be listening for requests on the network. Other requests will wait 
until the request is completed. This level is most appropriate for a 
Trillium Software System Installation Guide 133



Installing EDQ
system with one or two execution cores. 

High - Eight threads will be actively matching. Other requests will 
wait until a request is completed. This level is most appropriate for 
a system with more than four cores. 

Maximum - A thread will be created for each incoming request, 
within the limit of 128 concurrent attaches. This level can increase 
performance depending on the overall load on the system, for 
example, if some records require more processing resources.

A summary of your selections displays. Enter 2 to make changes or enter 1 to 
continue. The next prompt displayed depends on the components you have 
selected for installation.
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Installing TS Quality for SAP
TS Quality for SAP is a client application that passes cleansing and matching 
requests from your SAP environment to TS Quality cleansing and matching 
services, and returns the cleansed and matched data to your SAP 
environment. It includes the TrilliumSAPNW client, a cleansing service, 
matching service, and a sample project.

TS Quality for SAP requires installation of both the Enterprise Data Quality 
option and TS Quality for Real Time. Installation of the two optional 
components of TS Quality for Real Time (TS Web Services and Director SDK) is 
not required.

Installing TS Quality for SAP is a two-part process. After you have 
finished the installation steps described in this section, refer to 
Installing the SAP Add-On and Support Packages on page 256 of this 
manual and to the TS Connector for SAP Products Reference Guide 
for additional installation and configuration information.

Pre-Installation Checklist
The following information should be available prior to installation.

 What version of SAP is implemented?
 What version of SAP Basis is implemented?
 Is the SAP operating system installed on a Windows system or a Linux 

system?
 Are you creating a stand-alone gateway for the two systems to 

communicate? (This is highly recommended for failover.)
 Typically, the following team members should be available during 

installation:
•   SAP Basis Administrator – to install the Add-On
•   SAP function team member – to perform the configuration
•   Other (system administrator)
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To view the subfeatures available, enter 4, then enter 2. 

Figure 7-3  SAP Optional Components

Optional components include:

SAP Client: The SAP NW client and a sample project for the SAP 
Connector, which you can use to test your SAP Connector installation.

Cleansing Service: A service that handles data cleansing requests. 
The default service name is TSQSAPCleanser15.

Matching Service: A service that handles data matching requests. 
The default service name is TSQSAPMatcher15.

When you install the SAP Client, the following prompts display: 

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening. The default is 15400.

Director Host: The host name or IP address of the node on which the 
Director is running.

SAP Client Maximum threads: The maximum concurrent requests 
that the client can handle. The default is ten (10).

SAP Client Configuration File: The path and filename of the TS 
Quality SAP configuration file, by default /conf/TrilSAP.cfg.

A summary of your selections displays. Enter 2 to make changes or enter 1 to 
continue.

Set the following TS Client for SAP RFC parameters: 

Destination: Unique destination name entry. Defaults to TRILLIUM_R. 
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Gateway Host: The SAP Gateway server host name.

Gateway Service: SAP Gateway server name, generally the value 
“sapgw” followed by the two-digit system number.

Program ID: The registered SAP RFC server program name. Defaults 
to TRILLIUM.CONNECTOR. 

SAP Version: Defaults to 610.

SAP Client: The SAP customizing client where the TS Quality 
Connector is activated.

System ID: Unique SAP application system name, for example C5W.

Language: Defaults to EN (English).

Username: The SAP RFC service user name, for example TRILLRFC.

Password: The SAP RFC user’s password that was set by the Security 
Administrator.

User Logon Group: Application server’s group name (optional); 
default is PUBLIC.

Message Server Host: Host name of the message server, for example 
localhost.

A summary of your selections displays. Enter 2 to make changes or 1 to 
continue. The next prompt displayed depends on the components you have 
selected for installation.

Installing the Cleansing Service for SAP
When you install the Cleansing Service for SAP, set the following parameters:

Director Host: The host name or IP address of the node on which the 
Director for this client is running.

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening. The default is 15400.

Cleansing Server Port: The port number on which the cleansing 
service will listen for requests. Ensure that the same port is not used by 
multiple services. The default is 15420.
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Cleansing Configuration File: Accept the default path and file name 
for the sample TS Quality configuration file, /samples/projects/sap_
proj/settings/TrilSAP.cfg, or type a new path and name.

Processing Level: The Processing Level determines how requests will 
be queued for handling by the server. The optimum processing level is 
dependent on your hardware configuration. In general, using one 
thread for each processor yields optimum performance.

At all levels, the maximum number of concurrent attaches is 128. The 
processing level options are:

Minimum - No threads will be spawned for cleansing. Requests will 
be placed in a queue. The client that has been waiting the longest 
for a request to be serviced (based on when the server last 
processed a request for that client) is processed next. Note that the 
network queue limits the number of attach requests that can be 
waiting.

Default - One thread will be actively cleansing; another thread will 
be listening for requests on the network. Other requests will wait 
until the request is completed. This level is most appropriate for a 
system with one or two execution cores. 

High - Eight threads will be actively cleansing. Other requests will 
wait until a request is completed. This level is most appropriate for 
a system with more than four cores. 

Maximum - A thread will be created for each incoming request, 
within the limit of 128 concurrent attaches. This level can increase 
performance depending on the overall load on the system, for 
example, if some records require more processing resources.

A summary of your selections displays. Enter 2 to make changes or enter 1 to 
continue. The next prompt displayed depends on the components you have 
selected for installation.

Installing the Matching Service for SAP
When you install the matching service for SAP, set the following parameters:

Director Host: The host name or IP address of the node on which the 
Director for this client is running. 
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Director Port: Verify that the port number is the same as the port 
number on which the Director is listening. The default is 15400.

Matching Server Port: The port number on which the matching 
service will listen for requests. Ensure that the same port is not used by 
multiple services. The default is 15422.

Search Matching Server Port: The port number on which the Fuzzy 
Search matching service will listen for requests. Ensure that the same 
port is not used by multiple services. The default is 15424.

Matching Configuration File: Accept the default path and file name 
for the sample TS Quality configuration file, /samples/projects/sap_
proj/settings/TrilSAP.cfg, or type a new path and name.

Search Matching Configuration File: Accept the default path and file 
name for the sample TS Quality configuration file for Fuzzy Search,  
/samples/projects/sap_proj/settings/TrilSAP001.cfg, or type a 
new path and name.

Processing Level: The Processing Level determines how requests will 
be queued for handling by the server. The optimum processing level is 
dependent on your hardware configuration. In general, using one 
thread for each processor yields optimum performance.

At all levels, the maximum number of concurrent attaches is 128. The 
processing level options are:

Minimum - No threads will be spawned for matching. Requests will 
be placed in a queue. The client that has been waiting the longest 
for a request to be serviced (based on when the server last 
processed a request for that client) is processed next. Note that the 
network queue limits the number of attach requests that can be 
waiting.

Default - One thread will be actively matching; another thread will 
be listening for requests on the network. Other requests will wait 
until the request is completed. This level is most appropriate for a 
system with one or two execution cores. 

High - Eight threads will be actively matching. Other requests will 
wait until a request is completed. This level is most appropriate for 
a system with more than four cores. 
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Maximum - A thread will be created for each incoming request, 
within the limit of 128 concurrent attaches. This level can increase 
performance depending on the overall load on the system, for 
example, if some records require more processing resources.

A selections summary displays. Enter 2 to make changes; enter 1 to continue.

After TS Quality for SAP installation, you must set the following environment 
variables:

 TRILLDIRADDR: Name of the host or IP address (in dotted decimal 
format) of the node on which the Director listens. Set on client and 
cleansing/matching service machines.

 TRILLDIRPORT: Port on which the Director listens for incoming 
requests. Set on client and cleansing/matching service machines.

Installing the TS Connector for SAP is a two-part process. After you 
have finished the installation steps described in this section, refer to 
Installing the SAP Add-On and Support Packages on page 256 of this 
manual and to the TS Connector for SAP Products Reference Guide 
for additional installation and configuration information.

Completing Installation
After entering all selections for components, a summary of the features to be 
installed displays. Enter 2 to make changes or enter 1 to begin the installation. 
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A progress bar displays during the installation.

Figure 7-4  Completing Installation on Linux

When installation completes, enter 3 to finish. Following the installation:
 Set environment variables, as described in the following section.
 If you are using TS Web Services, start Apache Tomcat, as described in 

Starting the Apache Tomcat Web Server on page 167.
 Set your table locations, as described in Setting Table Locations on 

page 168.
 Install your postal directories/tables and city tables as needed. See 

Installing Postal Directories on page 172 and Copying City Tables on 
page 189.
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Environment Variables - Linux
Depending on the components installed, after installation you must manually 
set the following environment variables.

Trillium Software recommends that you set the environment 
variables in the .cshrc file, or other startup configuration file, to 
avoid setting them up manually each time you start the system.

Table 7-1  Environment Variables 

Variable Use

LD_LIBRARY_PATH Library path environment variable, which must include the path to 
the client library files (libtrilTGenClientLibrary.so or the 
xerces library). If you have installed TS Web Services, include 
%JRE_HOME%/bin and %CATALINA_HOME%/bin in the path.

JRE_HOME If you use TS Web Services or you are using a Java SDK client, set 
JRE_HOME to your JRE location. 

TS_DUMP_FILES (Optional; used for debugging when tracing is enabled in the 
cleanser or matcher.) Path to the location where binary dump files 
will be created. If the I/O buffers dump trace level is set, as 
described in the TS Director User’s Guide, individual I/O buffer 
dump files will be created in this location.

TRILLDIRADDR (Set for clients using TS Director) Name of the host or IP address 
(in dotted decimal format) of the node on which the Director listens. 
Set on client and cleansing/matching service machines.

TRILLDIRPORT (Set for clients using TS Director) Port on which the Director listens 
for incoming requests. Set on client and cleansing/matching service 
machines.
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Installing EDQ on Windows
EDQ is installed using the InstallShield wizard. During the installation process, 
you can click Cancel at any time to stop the install program and exit the 
InstallShield wizard.

 To install EDQ

 1.   If you have not yet done so, download the setup file from the TSS 
Download Center (File Portal) FTP website. Copy the installer file, tss_
edq_version.build_win.exe.

 2.   Run the installer. The Welcome window opens. Read the welcome 
message and click Next.

Figure 7-5  Welcome
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 3.   The License Agreement window opens. You must accept the terms of 
the license agreement in order to install solution components. Select I 
accept the terms in the license agreement and click Next. 

Figure 7-6  License Agreement
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 4.   The Product Key window opens. Enter your product key and click Next.

Figure 7-7  Product Key
Trillium Software System Installation Guide 145



Installing EDQ
 5.   The Destination Folder window opens. Accept the default installation 
directory or browse to select a different directory. If the directory you 
specify does not exist, the installation program creates it. Click Next.

Figure 7-8  Install Location
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 6.   The Custom Setup window opens. Select the features and components 
to install on this computer.

Figure 7-9  Select Components to Install

The features listed on this screen vary depending on your product key. 
By default, all components activated by your product key will be 
installed. To omit a feature, click the icon next to the feature name and 
select the This feature will not be available option, as shown in 
Figure 7-10. 

Installation of Enterprise Data Quality includes the following 64-bit 
client user interface components:

•   Director System Manager - A graphical user interface that allows you 
to control Director, cleansing and matching. 

•   Project Rule Analyzer - A tool that allows you to test cleansing and 
matching rules and logic. 

•   Web Service Manager - A web service test tool that allows you to 
send REST and SOAP requests for cleansing and matching services.

The 64-bit client interface components are automatically 
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installed with the Enterprise Data Quality option. No 
installation option is displayed for these; you cannot select a 
subset of these components for installation.

Figure 7-10  Component Selection Options

 7.   Click Next. The next window displayed depends on the components you 
have selected for installation.

Installing TS Quality for Real Time
The TS Quality for Real Time option installs the TS Director, a service that 
provides transaction load balancing and server connection management for 
client applications. There are two additional components available with the TS 
Quality for Real Time installation:

 TS Web Services - TS Web Services enables Trillium processing through 
industry-standard REST and SOAP requests. Selecting this option 
installs the Apache Tomcat Web Server. Java 64-bit version 1.8 is 
required and the JRE_HOME variable must be set to the JRE location.
148 Trillium Software System Installation Guide



Installing EDQ 
 Director SDK - The Software Development Kit includes the Java API, 
code samples, and a sample project, director_proj. You can optionally 
install cleansing and matching services to test your client application.

Figure 7-11  TS Quality for Real Time Options

To install the TS Director, install both Enterprise Data Quality and TS Quality 
for Real Time; optionally install one or both of the TS Quality for Real Time 
options (TS Web Services and Director SDK).

When you install the TS Director, the Director parameters window opens, as 
shown in Figure 7-12.

The Director is automatically installed as a service, and the 
configuration parameters discussed in this section are stored in the 
Windows registry. 

Figure 7-12  Director Port
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 To install the TS Director

 1.   Set the following parameter:

Director Port: Enter the TCP/IP port number on which the Director will 
listen for incoming connection requests, or accept the default 15400. 
You can assign any port number available on your system. The Director 
requires two consecutive ports for communication; ensure that the 
next consecutive port number is also available.

 2.   If you want the Director to start automatically when Windows starts, 
verify that Start services automatically? is selected. This check box 
is selected by default.

 3.   Click Next. The next window displayed depends on the components you 
have selected for installation.

Installing TS Web Services
Selecting the TS Web Services option installs the Apache Tomcat Web Server. 

Figure 7-13  Assign Ports for Tomcat
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 To install TS Web Services

 1.   Set the following parameters:

Apache Tomcat Start Port: Enter the port number on which the 
Apache Tomcat server listens for requests. The default is 8484.

Apache Tomcat Stop Port: Enter the port number on which the 
Apache Tomcat server listens for stop requests. The default is 8405.

 2.   Click Next. The next window displayed depends on the components you 
have selected for installation.

Director SDK
The Director SDK contains the application programming interface (API) tools 
used to develop client applications that call the TS Quality data cleansing and 
matching services. The Java API, samples illustrating API calls and a sample 
project, director_proj are installed. Optionally, you can install: 

Cleansing Service: A service that handles data cleansing requests. 
The default service name is TSQCleanser15.

Matching Service: A service that handles data matching requests. 
The default service name is TSQMatcher15.
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Installing the SDK Cleansing Service

When installing the cleansing service, the window shown in Figure 7-14 opens.

Figure 7-14  SDK Cleansing Service

 To install the SDK cleansing service

 1.   Set the following parameters:

Server Port: Enter the port number on which the cleansing service will 
listen for requests. Ensure that the same port is not used by multiple 
services. The default is 15410.

Director Host: Enter the host name or IP address of the node on 
which the Director is running. 

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening. This port was established 
when the Director was installed. The default is 15400.

Configuration File: Accept the default path and file name for the 
sample Trillium configuration file or enter a new path and name. 
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Processing Level: The Processing Level determines how requests will 
be queued for handling by the server. The optimum processing level is 
dependent on your hardware configuration. In general, using one 
thread for each processor yields optimum performance.

At all levels, the maximum number of concurrent attaches is 128. The 
processing level options are:

Minimum - No threads will be spawned for cleansing. Requests will 
be placed in a queue. The client that has been waiting the longest 
for a request to be serviced (based on when the server last 
processed a request for that client) is processed next. Note that the 
network queue limits the number of attach requests that can be 
waiting.

Default - One thread will be actively cleansing; another thread will 
be listening for requests on the network. Other requests will wait 
until the request is completed. This level is most appropriate for a 
system with one or two execution cores. 

High - Eight threads will be actively cleansing. Other requests will 
wait until a request is completed. This level is most appropriate for 
a system with more than four cores. 

Maximum - A thread will be created for each incoming request, 
within the limit of 128 concurrent attaches. This level can increase 
performance depending on the overall load on the system, for 
example, if some records require more processing resources.

 2.   If you want the cleansing service to start automatically when Windows 
starts, verify that Start services automatically? is selected. This 
check box is selected by default.

 3.   Click Next. The next window displayed depends on the components you 
have selected for installation.

Installing the SDK Matching Service

When you install the SDK matching service, the window shown in Figure 7-15 
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opens.

Figure 7-15  SDK Matching Service

 To install the SDK Matching Service

 1.   Set the following parameters:

Server Port: Enter the port number on which the matching service will 
listen for requests. Ensure that the same port is not used by multiple 
services. The default is 15412.

Director Host: Enter the host name or IP address of the node on 
which the Director for TS Quality is running. 

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening. This port was established 
when the Director was installed. The default is 15400.

Configuration File: Accept the default path and file name for the 
sample Trillium configuration file or enter a new path and name. 

Processing Level: The Processing Level determines how requests will 
be queued for handling by the server. The optimum processing level is 
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dependent on your hardware configuration. In general, using one 
thread for each processor yields optimum performance.

At all levels, the maximum number of concurrent attaches is 128. The 
processing level options are:

Minimum - No threads will be spawned for matching. Requests will 
be placed in a queue. The client that has been waiting the longest 
for a request to be serviced (based on when the server last 
processed a request for that client) is processed next. Note that the 
network queue limits the number of attach requests that can be 
waiting.

Default - One thread will be actively matching; another thread will 
be listening for requests on the network. Other requests will wait 
until the request is completed. This level is most appropriate for a 
system with one or two execution cores. 

High - Eight threads will be actively matching. Other requests will 
wait until a request is completed. This level is most appropriate for 
a system with more than four cores. 

Maximum - A thread will be created for each incoming request, 
within the limit of 128 concurrent attaches. This level can increase 
performance depending on the overall load on the system, for 
example, if some records require more processing resources.

 2.   If you want the matching service to start automatically when Windows 
starts, verify that Start services automatically? is selected. This 
check box is selected by default.

 3.   Click Next. The next window displayed depends on the components you 
have selected for installation.

Installing TS Quality for SAP
TS Quality for SAP is a client application that passes cleansing and matching 
requests from your SAP environment to TS Quality cleansing and matching 
services, and returns the cleansed and matched data to your SAP 
environment. It includes the TrilliumSAPNW client, a cleansing service, 
matching service, and a sample project.
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TS Quality for SAP requires installation of both the Enterprise Data Quality 
(EDQ) option and TS Quality for Real Time. Installation of the two optional 
components of TS Quality for Real Time (TS Web Services and Director SDK) is 
not required.

Installing TS Quality for SAP is a two-part process. After you have 
finished the installation steps described in this section, refer to 
Installing the SAP Add-On and Support Packages on page 256 of this 
manual and to the TS Connector for SAP Products Reference Guide 
for additional installation and configuration information.

Pre-Installation Checklist
The following information should be available prior to installation.

 What version of SAP is implemented?
 What version of SAP Basis is implemented?
 Is the SAP operating system installed on a Windows system or a Linux 

system?
 Are you creating a stand-alone gateway for the two systems to 

communicate? (This is highly recommended for failover.)
 Typically, the following team members should be available during 

installation:
•   SAP Basis Administrator – to install the Add-On
•   SAP function team member – to perform the configuration
•   Other (system administrator)
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Optional components include:

SAP Client: The SAP NW client and a sample project for the SAP 
Connector, which you can use to test your SAP Connector installation.

Cleansing Service: A service that handles data cleansing requests. 
The default service name is TSQSAPCleanser15.

Matching Service: A service that handles data matching requests. 
The default service name is TSQSAPMatcher15.

Figure 7-16  SAP Options

When you install the TS Quality for SAP, the window shown in Figure 7-17 
opens.

Figure 7-17  Installing the SAP Client
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 To install TS Quality for SAP

 1.   Set the following parameters:

Director Host: The host name or IP address of the node on which the 
Director is running.

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening. This port was established 
when the Director was configured. The default is 15400.

Configuration File: The path and filename of the TS Quality SAP 
configuration file.

Maximum threads: The maximum concurrent requests that the client 
can handle. The default is ten (10).

 2.   If you want the TS Client for SAP to start automatically when Windows 
starts, verify that the Start services automatically? check box is 
selected. This check box is selected by default.

 3.   Click Next. The TS Client for SAP RFC window opens.

Figure 7-18  SAP RFC
158 Trillium Software System Installation Guide



Installing EDQ 
 4.   Set the following RFC parameters:

Destination: Unique destination name entry. Defaults to TRILLIUM_R. 

Program ID: The registered SAP RFC server program name. Defaults 
to TRILLIUM.CONNECTOR. 

Gateway Host: The SAP Gateway server host name.

Gateway Service: SAP Gateway server name. It is usually the value 
“sapgw” followed by the two-digit system number.

SAP Client: The SAP customizing client where the TS Quality 
Connector is activated.

SAP System ID: Unique SAP application system name, for example 
C5W.

SAP Language: Defaults to EN (English).

SAP Username: The SAP RFC service user name, for example 
TRILLRFC.

SAP Password: The SAP RFC user’s password that was set by the 
Security Administrator.

SAP Logon Group: Application server’s group name (optional); 
default is Default.

Msg Server Host: Host name of the message server, for example 
localhost or wnarkka-lt.

In a Windows environment, these parameters are 
automatically copied to the SAPRFC.INI file that is used for 
communication between TS Quality and the SAP system. 
Refer to the TS Connector for SAP Products Reference Guide 
for additional information on the SAPRFC.INI.

 5.   Click Next. The next window displayed depends on the components you 
have selected for installation.
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Installing the Cleansing Service for SAP
When you install the Cleansing Service for SAP, the window shown in  
Figure 7-19 opens.

Figure 7-19  SAP Cleanser Service

 To install the cleansing service for SAP

 1.   Set the following parameters:

Server Port: The port number on which the cleansing service will 
listen for requests. Ensure that the same port is not used by multiple 
services. The default is 15420.

Director Host: The host name or IP address of the node on which the 
Director for this client is running.

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening. This port was established 
when the Director was configured. The default is 15400.

Configuration File: Accept the default path and file name for the 
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sample TS Quality configuration file or type a new path and name.

Processing Level: The Processing Level determines how requests will 
be queued for handling by the server. The optimum processing level is 
dependent on your hardware configuration. In general, using one 
thread for each processor yields optimum performance.

At all levels, the maximum number of concurrent attaches is 128. The 
processing level options are:

Minimum - No threads will be spawned for cleansing. Requests will 
be placed in a queue. The client that has been waiting the longest 
for a request to be serviced (based on when the server last 
processed a request for that client) is processed next. Note that the 
network queue limits the number of attach requests that can be 
waiting.

Default - One thread will be actively cleansing; another thread will 
be listening for requests on the network. Other requests will wait 
until the request is completed. This level is most appropriate for a 
system with one or two execution cores. 

High - Eight threads will be actively cleansing. Other requests will 
wait until a request is completed. This level is most appropriate for 
a system with more than four cores. 

Maximum - A thread will be created for each incoming request, 
within the limit of 128 concurrent attaches. This level can increase 
performance depending on the overall load on the system, for 
example, if some records require more processing resources.

 2.   If you want the cleansing service to start automatically when Windows 
starts, verify that the Start services automatically? check box is 
selected. This check box is selected by default.

 3.   Click Next. The next window displayed depends on the components you 
have selected for installation.
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Installing the Matching Service for SAP
When you install the matching service for SAP, the Matching Service for SAP 
window opens.

Figure 7-20  SAP Matching Service

 To install the matching service for SAP

 1.   Set the following parameters:

Director Host: The host name or IP address of the node on which the 
Director for this client is running. 

Director Port: Verify that the port number is the same as the port 
number on which the Director is listening. This port was established 
when the Director was configured. The default is 15400.

Processing Level: The Processing Level determines how requests will 
be queued for handling by the server. The optimum processing level is 
dependent on your hardware configuration. In general, using one 
thread for each processor yields optimum performance.
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At all levels, the maximum number of concurrent attaches is 128. The 
processing level options are:

Minimum - No threads will be spawned for matching. Requests will 
be placed in a queue. The client that has been waiting the longest 
for a request to be serviced (based on when the server last 
processed a request for that client) is processed next. Note that the 
network queue limits the number of attach requests that can be 
waiting.

Default - One thread will be actively matching; another thread will 
be listening for requests on the network. Other requests will wait 
until the request is completed. This level is most appropriate for a 
system with one or two execution cores. 

High - Eight threads will be actively matching. Other requests will 
wait until a request is completed. This level is most appropriate for 
a system with more than four cores. 

Maximum - A thread will be created for each incoming request, 
within the limit of 128 concurrent attaches. This level can increase 
performance depending on the overall load on the system, for 
example, if some records require more processing resources.

Server Port: The port number on which the matching service will 
listen for requests. Ensure that the same port is not used by multiple 
services. The default is 15422.

Configuration File: Accept the default path and file name for the 
sample TS Quality configuration file or type a new path and name.

Search Server Port: The port number on which the Fuzzy Search 
matching service will listen for requests. Ensure that the same port is 
not used by multiple services. The default is 15424.

Search Configuration File: Accept the default path and file name for 
the sample TS Quality configuration file for Fuzzy Search or type a new 
path and name.

 2.   If you want the matching service to start automatically when Windows 
starts, verify that the Start services automatically? check box is 
selected. This check box is selected by default.

 3.   Click Next. The Ready to Install window opens.
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After TS Quality for SAP installation, you must manually set the following 
environment variables:

 TRILLDIRADDR: Name of the host or IP address (in dotted decimal 
format) of the node on which the Director listens. Set on client and 
cleansing/matching service machines.

 TRILLDIRPORT: Port on which the Director listens for incoming 
requests. Set on client and cleansing/matching service machines.

Installing the TS Connector for SAP is a two-part process. After you 
have finished the installation steps described in this section, refer to 
Installing the SAP Add-On and Support Packages on page 256 of this 
manual and to the TS Connector for SAP Products Reference Guide 
for additional installation and configuration information.
164 Trillium Software System Installation Guide



Installing EDQ 
Completing Installation
Once components have been selected and configured, you are ready to 
complete the installation. 

 To complete installation

 1.   On the Ready to Install window, click Back to modify your selections, 
or click Install to begin the installation. The status bar displays the 
progress of the installation.

Figure 7-21  Ready to Install
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 2.   When installation is complete, the Completion window opens. 

Figure 7-22  Installation Complete

 3.   Click Finish to close the InstallShield wizard. Following the installation:

 Set environment variables, as described in the following section.
 If you are using TS Web Services, start Apache Tomcat, as described in 

Starting the Apache Tomcat Web Server on page 167.
 Set your table locations, as described in Setting Table Locations on 

page 168.
 Install your postal directories/tables and city tables as needed. See 

Installing Postal Directories on page 172 and Copying City Tables on 
page 189.
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Environment Variables - Windows
Depending on the components installed, the installation sets the PATH 
environment variable on your system, except for TRILLDIRADDR and 
TRILLDIRPORT which must be set manually.  

Starting the Apache Tomcat Web 
Server
Before you can begin working with TS Web Services, you must start the 
Apache Tomcat Web Server.

 To start Apache Tomcat on Linux

 1.   Log in as a user with system administrator privileges.

 2.   Set the JRE_HOME variable to your Java JRE location.

Table 7-2  Environment Variables - Windows 

Variable Use

PATH Library path environment variable, which must include the path to 
the TGenClient.dll, trilTGenClientLibrary.dll, and 
libtsi.dll.

TS_DUMP_FILES (Optional; used for debugging when tracing is enabled in the 
cleanser or matcher; not set automatically.) Path to the location 
where binary dump files will be created. If the I/O buffers dump 
trace level is set, as described in the TS Director User’s Guide, 
individual I/O buffer dump files will be created in this location.

JRE_HOME If you installed TS Web Services or you are using a Java SDK client, 
set JRE_HOME to your JRE location. 

TRILLDIRADDR (Set manually for clients using TS Director) Name of the host or IP 
address (in dotted decimal format) of the node on which the 
Director listens. Set on client and cleansing/matching service 
machines.

TRILLDIRPORT (Set manually for clients using TS Director) Port on which the 
Director listens for incoming requests. Set on client and cleansing/
matching service machines.
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 3.   Change directories to Trillium’s Apache directory, by default /opt/
trillium/apache-tomcat-8.0.47/bin.

 4.   Run the start-up script, startup.sh.

 5.   After Tomcat has started, navigate to /apache-tomcat-8.0.47/
webapps/TrilliumSOAP/WEB-INF/conf and edit the file axis2.xml. 
Search for port 8080 and change it to the port specified during 
installation, by default 8484.

 To start Apache Tomcat on Windows

 1.   Log in as a user with system administrator privileges and open a 
command window.

 2.   Set the jre_home variable to your Java JRE location, for example 
C:\Program Files\Java\jre1.8.0_102.

 3.   Change directories to Trillium’s Apache directory, by default 
C:\Program Files\Trillium Software\EDQ\15\apache-tomcat-
8.0.47\bin.

 4.   Run the start-up script, startup.bat. A Tomcat window opens. Allow the 
startup process to complete before attempting to use Tomcat.

 5.   After Tomcat has started, navigate to C:\Program Files\Trillium 
Software\EDQ\15\apache-tomcat-8.0.47\webapps\TrilliumSOAP 
\WEB-INF\conf and edit the file axis2.xml. Search for port 8080 and 
change it to the port specified during installation, by default 8484.

Tomcat must have been started at least once before you make 
this change.

Setting Table Locations
To process your data, Trillium projects use several tables, such as postal 
tables, parser rule tables, code page tables, and so on. (See Installing Postal 
Directories on page 172 for information on installation of postal tables.) The 
location of your tables is defined in an initialization file, EDQ.ini. By default, 
EDQ.ini identifies the path to your tables as /install_path/tables (Linux) 
or \install_path\Trillium Software\EDQ\15\tables (Windows). 
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Tables used with EDQ use UTF-8 character encoding. Tables using 
any other encoding mechanism are not compatible with EDQ.

The tables directory is created by the EDQ installation and contains the 
following subdirectories:

ACE_tables 
aptables
census_tables
code_pages
gatables
general_resources
parser_rules
postal_utf8

If your tables are stored in an alternate location, after you install EDQ you 
must modify EDQ.ini to change the table location. When a project is run for 
the first time, the path defined in EDQ.ini is used to create the file 
Config64.tbl in the project’s settings directory. To change table locations 
after the project is run, run the program trilconfig64.exe to reset the table 
locations.

For the 16 Postal Matcher countries (including those for the Custom Postal 
Matcher) there are two versions of the postal tables—one for 32-bit TS Quality 
processes, and the UTF-8 version to support EDQ 64-bit. However, all other 
countries (APAC, global postal matcher, and so on) need only one instance of 
the ACE_tables, aptables, census_tables, and gatables postal tables as they 
are already compliant with UTF-8 and/or Unicode data. Therefore, you can 
simplify project configuration and set EDQ.ini to point to a single set of tables 
used for EDQ 64-bit processing or 32-bit processing.

For Trillium Quality for Big Data installations, do not change the table 
locations.

 To change the default table location

 1.   Using a text editor open the file EDQ.ini, located in the conf folder in 
your Trillium directory path, by default /opt/trillium/conf on Linux 
and C:\Program Files\Trillium Software\EDQ\15\conf on 
Windows. 

 2.   Change the table location definitions. 
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 3.   Save and close the EDQ.ini file.

 4.   If your project has been run previously, run the program 
trilconfig64.exe, located in /install_path/bin (Linux) or 
\install_path\Trillium Software\EDQ\15\bin (Windows), 
specifying the - f (force) switch and the project path. For example: 

trilconfig64 -f /opt/trillium/projects/myproj

 5.   Check the configuration file (Config64.tbl) located in the project’s 
settings folder to verify the table locations.

You can change the top-level TABLES location or change the location 
of the subdirectories. For example, the following would set the table 
location to /tables, but would specifically set the location of the 
postal tables to /mypostaldirectory: 

TABLES = “/opt/trillium/tables” 
POSTAL_TABLES = “/mypostaldirectory”

Do NOT change the location of the ACE_tables. ACE tables must reside in 
the default location.

Running 64-Bit and 32-bit 
Concurrently
You can install TS Quality (32-bit) and EDQ (64-bit) on the same machine. 
Components are segregated in different directory paths and do not conflict. 
The version that will be used depends on your project selections.

 Batch scripts - When you export a project to a batch script, TS Quality 
creates different versions of the script. Run the 32-bit version to use 
the 32-bit core components; run the 64-bit version to use the 64-bit 
core components. See the help file in the TSS Control Center for 
information on running batch scripts.

 Real-time projects - When you create a cleanser or matcher, you select 
the processing type, which determines whether the project will run with 
32-bit or 64-bit components. 
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When switching between 32-bit and 64-bit projects, you must make two 
changes to your environment:

 If both 32-bit and 64-bit locations are included in your PATH 
environment variable, the first location in the path list will be used. You 
can find the currently defined location by using the ‘which’ command on 
Linux to search for libtrilTGenClientLibrary or the ‘where’ command on 
Windows to search for TGenClient.dll. Change the PATH environment 
variable to point to the correct library location. 

 Change the JRE_HOME location. 32-bit projects must use the JRE you 
installed for the 32-bit Trillium installation; 64-bit projects use the 64-
bit JRE.

Improving Performance
If you are planning to use TS Director with EDQ, for improved performance, 
add the DWORD values shown in Table 7-3 to HKEY_LOCAL_
MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters registry 
key on the TS Quality/ECS machine.

Table 7-3  TCP/IP Registry Entries

DWORD Value 
Name

Value Data
(Decimal Base)

Description

MaxUserPort 60000 Determines the highest port number TCP can
assign when an application requests an available
user port from the system. Typically, ephemeral
ports (those used briefly) are allocated to port
numbers 1024 through 5000, but decimal values
up to 65534 are valid.

TcpTimeWaitDelay 30 Determines the time that must elapse before TCP
can release a closed connection and reuse its
resources. This interval between closure and
release is known as the TIME_WAIT state or 2MSL
state. During this time, the connection can be
reopened at much less cost to the client and
server than establishing a new connection. The
default value is 240 seconds (4 minutes).
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CHAPTER 8 Installing Postal 
Directories

Postal directories (tables) are a critical part of the data quality process 
because they provide the address information used to validate and improve 
the name and address data in your records.

Periodically, the postal services of various countries issue updates to the postal 
tables. Trillium Software distributes the updates two ways: 

 TSS Download Center (File Portal) FTP website. TSS Download 
Center allows you to manually download postal directories through 
Trillium Software’s secure website. This guide describes how to 
download and install postal directories using this method.

 Trillium Postal Download Web Service. Trillium Postal Download 
Web Service is an automated download service introduced in v15.7. The 
download service allows you to check the status of your postal license 
and download the postal directories from a browser-based application. 
See the Trillium Postal Download Web Service User’s Guide for details.

This chapter has the following sections:
 File Naming Conventions on page 173
 EDQ Postal Tables on page 176
 Default Installation Locations on page 178
 Defining Alternative Postal Table Locations on page 179
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 Installing on Windows and UNIX on page 185

The installation procedure is the same, whether you are installing for the first 
time or installing an update. 

File Naming Conventions
The postal tables are delivered in a compressed format. The file extensions are 
.zip (for Windows operating systems) and .tar (for UNIX operating systems). 
The following file naming conventions are used:

UTF-8 Postal Tables

XXMMMq64.ext, where XX is the 2-letter country code, MMM is the 
abbreviation for the month the postal table was issued, and ext is 
either zip or tar. Valid for use on Windows and Linux 64-bit operating 
systems. Available for TSS v15.2 and later when you install EDQ (64-
bit). For more information, see EDQ Postal Tables on page 176.

Trillium Software ships two sets of Canadian Postal Directories. 
One set, which has the prefix CAC, is required for SERP 
certification and is limited to batch processing. The second set 
has the prefix CA; this set can be used in batch or real-time 
processing, but does not produce a SERP certificate. 

General and Asian Postal Tables 

XXMMMq.ext, where XX is the 2-letter country code, MMM is the 
abbreviation for the month the postal table was issued, and ext is zip or 
tar. For example, USJULq.zip is the United States postal table for July.

The General Postal Tables are for 32-bit processing only and do 
not support UTF-8. 

Trillium Software ships two sets of Canadian Postal Directories. 
One set, which has the prefix CAC, is required for SERP 
certification and is limited to batch processing. The second set 
has the prefix CA; this set can be used in batch or real-time 
processing, but does not produce a SERP certificate.
Trillium Software System Installation Guide 173



Installing Postal Directories
ACE Postal Tables

jpACEMMM.zip, where MMM is the month the postal table was issued. 

ACE Postal Tables are used by the Japanese Address Code Edition 
(ACE) Postal Matcher. These tables provide address dictionaries 
to validate and enrich address data. They can be used to return 
standard address fields as well as address codes and bar codes. 

Global Postal Tables

XXXMMMYY.ext, where XXX is the 3-letter country code, MMMYY 
represents the abbreviation for the month and year the postal table 
was issued, and ext is either zip or tar. For example, NORJAN15.zip is 
the Norwegian postal table for January 2015.

Global Postal Tables are a subset of international postal tables 
that are invoked from within Trillium Software System. The 
postal tables in this subset are: Austria, Brazil, Czech Republic, 
Denmark, Finland, Greece, Hungary, Ireland, Mexico, New 
Zealand, Norway, Poland, Sweden, and the Basic countries.

US Census Directories

USCMMMq.ext. This is the name of the United States census directory 
that includes the Interpolated Rooftop files. MMM is the abbreviation for 
the month the directory was issued and ext is either zip or tar.

USXMMMq.ext. This is the name of the United States census directory 
that includes the ZIP+4 Centroid files. MMM is the abbreviation for the 
month the directory was issued and ext is either zip or tar.

USPMMMq.ext. This is the name of the file that contains only the 
Interpolated Plus directory, where MMM is the abbreviation for the 
month the directory was issued and ext is either zip or tar.

Census tables, which are available for the U.S. only, assign 
census geographic codes, such as county, tract, latitude and 
longitude, to address data. If you are interested in assigning 
latitude and longitude values to address data for other countries, 
contact your account manager for more information.
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DPV Directory

USDMMMq.ext. This is the name of the United States Delivery Point 
Validation directory. MMM is the abbreviation for the month the 
directory was issued and ext is either zip or tar.

Delivery Point Validation (DPV) is a U.S. Postal Service product 
that helps validate the accuracy of existing address information 
and identify inaccurate, incomplete, or erroneous addresses.

LACSLink Directory

USLMMMq.ext. This is the name of the United States LACSLink directory, 
where MMM is the abbreviation for the month the directory was issued 
and ext is either zip or tar. 

LACSLink is a product of the U.S. Postal Service that provides 
users with an automated method of obtaining a new address for 
locations that have been converted by local municipalities, 
usually when the community has implemented a 911 emergency 
system. 

SuiteLink Directory

USSMMMq.ext. This is the name of the United States SuiteLink directory, 
where MMM is the abbreviation for the month the directory was issued 
and ext is either zip or tar. 

SuiteLink is a product of the U.S. Postal Service that improves 
business address information by adding suite numbers to 
qualified records. Only business records that have been identified 
through CASS processing as having a high-rise default are 
candidates for SuiteLink processing. 

RDI Tables

USRMMMq.ext. This is the name of the Residential Delivery Indicator 
(RDI) table, where MMM represents the abbreviation for the month the 
RDI table was issued and ext is either zip or tar. For example, 
USRAPRq.tar.
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Residential Delivery Indicator (RDI) is a product available from 
the U.S. Postal Service (USPS) that identifies a USPS delivery 
point as being a residential or commercial.

Trillium Software’s license agreements with the U.S. Postal Service 
limit the shipment and transfer of DPV, LACSLink, SuiteLink, and RDI 
directories to the United States and its territories. Customers who 
purchase these directories from Trillium Software must adhere to the 
same restriction.

EDQ Postal Tables
As of TSS v15.2, Trillium Software expanded support of 64-bit processing on 
Windows and Linux operating systems with Enterprise Data Quality (EDQ). 
EDQ is the 64-bit enabled implementation of TS Quality. 

EDQ 64-bit supports postal tables in UTF-8/Unicode format only. 

To enhance postal table support for 64-bit environments, a set of UTF-8 
encoded postal tables are available. The UTF-8 tables are valid for ASCII data 
on Windows and Linux platforms. For the TSS Postal Matchers, the new UTF-8 
postal tables are required for EDQ processing for the following 16 countries: 
Australia, Belgium, Canada, France, Germany, Great Britain, Hong Kong, Italy, 
Luxembourg, Malaysia, Netherlands, Portugal, Singapore, Spain, Switzerland, 
and United States. 

For these Postal Matcher countries there are two versions of the postal tables 
available—one for 32-bit TS Quality processes, and a UTF-8 version to support 
EDQ 64-bit. However, all other countries (APAC, global postal matcher, and so 
on) need only one instance of the ACE_tables, aptables, census_tables, and 
gatables postal tables as they are already compliant with UTF-8 and/or 
Unicode data. 

Previously only 32-bit versions of these postal tables were available 
for use with TS Quality. Continue to use the 32-bit supported tables 
for TS Quality project testing in the Control Center and to export 
batch scripts to 32-bit systems.
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EDQ Tables Directory 
When you install EDQ, a default \tables directory is created containing sub-
directories for postal tables, code pages, parser rules, and general process 
files.

Install the appropriate postal tables in the following sub-directories:
 ACE_tables. Tables for the JP Postal Matcher Address Code Edition 

(ACE) Postal Matcher.
 aptables. Tables for the Postal Matcher for China, Japan, Korea, and 

Taiwan. 
 census_tables. Tables for US Census Geocoder used with the US Postal 

Matcher.
 gatables. Tables for countries used by the Global Postal Matcher. 
 postal_utf8. 64-bit UTF-8 postal tables for the 16 countries listed above.

The following sub-directories are populated during the EDQ install:
 code_pages. Code page tables. 
 general_resources. General process files, including rule, table, ddx, ddl, 

and map files. 
 parser_rules. Parser rule file. 

To use a different location for the postal tables, follow the instructions in the 
section Defining Alternative Postal Table Locations on page 179, to specify the 
location.
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Default Installation Locations
By default, postal-related files and directories are installed to the locations 
shown in this section. (Windows paths are shown. For Linux, the top-level path 
is /install_path/tables.)

UTF-8

TSS 15 EDQ (64-Bit):

C:\Program Files\Trillium Software\EDQ\15\tables\postal_utf8

General Postal Tables 

TSS 15:

C:\Program Files (x86)\Trillium Software\MBSW\15\tsq\tables\ 
postal_tables

Asian Postal Tables (China, Japan, Korea, Taiwan)

TSS 15:

C:\Program Files (x86)\Trillium Software\MBSW\15\tsq\tables\ 
aptables

TSS 15 EDQ (64-Bit):

C:\Program Files\Trillium Software\EDQ\15\tables\aptables

ACE Postal Tables (Japanese Address Code Edition dictionaries)

TSS 15:

C:\Program Files (x86)\Trillium Software\MBSW\15\tsq\tables\ 
ACE_tables

TSS 15 EDQ (64-Bit): 

C:\Program Files\Trillium Software\EDQ\15\tables\ACE_tables

Census Tables

TSS 15:

C:\Program Files (x86)\Trillium Software\MBSW\15\tsq\tables\ 
census_tables
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TSS 15 EDQ (64-Bit):

C:\Program Files\Trillium Software\EDQ\15\tables\census_tables

Global Postal Tables

TSS 15:

C:\Program Files (x86)\Trillium Software\MBSW\15\tsq\tables\ 
gatables\datastore

C:\Program Files (x86)\Trillium Software\MBSW\15\tsq\tables\ 
gatables\license

TSS 15 EDQ (64-Bit):

C:\Program Files\Trillium Software\EDQ\15\tables\gatables\ 
datastore

C:\Program Files\Trillium Software\EDQ\15\tables\gatables\ 
license

If you want to use a different location for the postal tables, follow the 
instructions in the section Defining Alternative Postal Table Locations, to 
specify the location.

Defining Alternative Postal Table 
Locations
Depending on your needs, you may want to install the tables to a location 
other than the specified default directories. If you plan to install some or all of 
the tables in a non-default location, you must first define those alternative 
locations before you install the postal tables. (See Default Installation 
Locations on page 178 for more information.)

The procedure varies, depending on whether you are defining locations for 
tables used for EDQ 64-bit processing or 32-bit processing.

For the 16 countries that have both the 32-bit postal tables and 64-
bit UTF-8 postal tables, these tables cannot reside in the same 
directory. Tables for other countries (APAC, global postal matcher, 
and so on) can reside in the same directory.

If you are installing the postal tables in their default locations, skip this section 
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and go to Installing on Windows and UNIX on page 185.

Defining EDQ 64-Bit Table Locations
Use this procedure to define an alternative location for tables used for EDQ 64-
bit processing. For example, you might want to configure EDQ to point to a 
single instance of the ACE_tables, aptables, census_tables, and gatables 
tables on your network (that is, one set of tables used for both 32-bit and 64-
bit processing) instead of copying those country tables to the default EDQ 
tables directory. 

About EDQ.ini and Config64.tbl
The location of your EDQ tables is defined in an initialization file, EDQ.ini. By 
default, EDQ.ini identifies the path to your tables as /install_path/tables 
(Linux) or \install_path\Trillium Software\EDQ\15\tables (Windows).

The following subdirectories are found in the tables directory:

aptables   
census_tables 
code_pages 
gatables 
general_resources 
parser_rules 
postal_utf8

When you run a 64-bit batch script for an exported TS Quality project for the 
first time, a configuration file named Config64.tbl is created in the project’s /
Settings folder. The tables location used in Config64.tbl is determined by 
the TABLES setting in the EDQ.ini file. Depending on the requirements of your 
data processing environment, you can change the default table location by 
changing the path in EDQ.ini. 

Do not change the location of the ACE_tables. ACE tables must reside 
in the default location.

If you change the TABLES location in EDQ.ini after you start your project, you 
must stop your project, stop Tomcat, delete Config64.tbl, restart Tomcat, 
and restart your project. A new Config64.tbl will be created using the new 
Tables path defined in EDQ.ini.
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On Linux, you must create a symbolic link to the alternative 
directory, which can be on any mounted drive.

Alternatively, you can regenerate Config64.tbl manually by running 
trilconfig64.exe, located in /install_path/bin (Linux) or \install_
path\Trillium Software\EDQ\15\bin (Windows), specifying the - f (force) 
switch and the project path. For example:

trilconfig64 -f trillium/projects/myproj 

The next time you run the project the new table locations will be recognized. 
Check the configuration file (Config64.tbl) located in the project’s settings 
folder to verify the table locations. 

Changing the Global Postal Tables Location
When changing the tables location for Global Postal Tables, you must also 
change the gaserver.ini file.

 To change Global Postal Table locations

 1.   With a text editor, open the global postal table gaserver.ini file, 
which is located in the \conf directory: C:\Program Files\Trillium 
Software\EDQ\15\conf. 

 2.   Set the CountryDataDirectory entry to point to the alternative 
location of the Global Postal Table datastore\rdata directory.

 3.   Set the KnowledgeBaseDirectory entry to point to the location of the 
global postal table datastore\kbase directory.

 4.   Locate the LicenseDirectory entry and point it to the global postal 
table license directory.
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Figure 8-1 shows an example of a modified gaserver.ini.

Figure 8-1  Sample of Modified EDQ gaserver.ini

 5.   Save and close the file.

Defining 32-Bit Table Locations
Use this procedure to define an alternative location for postal tables used for 
32-bit (non-EDQ) processing so that TSS repositories are able to access the 
tables. 

You cannot define an alternative directory for ACE Postal Tables.

 To define an alternative location for the 32-bit (non-EDQ) postal 
tables

 1.   Shut down TSS, including all TSS clients.

 2.   Stop the TSS Scheduler service.

 3.   Create the alternative postal table installation directory. 

On UNIX, you must create a symbolic link to the alternative 
directory, which can be on any mounted drive.

 4.   Start the TSS command line utility.

 On Windows, select Programs > Trillium Software > version > 
Repository Administration Command Prompt.

 On UNIX, type ./mtb_admin.
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 5.   When prompted, supply your username, password, and repository 
name.

Use the _control repository name to apply the alternative 
location to all repositories.

 6.   Ensure that changes have not already been made to the postal directory 
installation locations by typing the following commands, individually.

  define postal_directory
  define apac_postal_directory
  define census_directory
  define ga_directory 
The commands should each return a failure message of the form “No 
setting with name ‘nnn_directory’ found in table ‘default_settings’.” For 
example, “No setting with name ‘census_directory’ found in 
table ‘default settings’.”

If a value is returned, you need to remove the current setting before 
defining a new one. See “Removing a postal directory definition” on 
page 185 for more information.

 7.   At the mtb_admin prompt, type: 

   expert 

 8.   Issue one or more of the following commands, pressing Enter after 
each one:

 For non-Asian postal tables:

define postal_directory [file join {d:\newpostal}]

 For Asian postal tables:

define apac_postal_directory [file join {d:\newpostal}]

 For census tables:

define census_directory [file join {d:\newpostal}]

 For global postal tables:

define ga_directory [file join {d:\newpostal\datastore}]

    where d:\newpostal is the path of the alternative postal directory 
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and datastore is the required name of the subdirectory. 

On Windows systems, the path must be specified as a UNC 
path, not a mapped drive.

 9.   Type exit to close the command prompt window.

 10.   Move any installed xxCITY.ext files (where ext is either len or ben) from 
the default installation directory to the new, alternative directory.

These files were copied to the default postal directories when 
TS Quality project templates were installed. They must be in 
the same location as the postal tables.

 11.   Remove the default directories (or leave them empty).

 12.   For Global Postal Tables, there is an additional step.  

a. With a text editor, open the global postal table gaserver.ini file, 
which is located in the /Software/bin directory. 

b. Set the CountryDataDirectory entry to point to the alternative 
location of the global postal table datastore\rdata directory.

c. Set the KnowledgeBaseDirectory entry to point to the location of 
the global postal table datastore\kbase directory.

d. Locate the LicenseDirectory entry and point it to the global postal 
table license directory.

Figure 8-2 shows an example of a modified gaserver.ini.

Figure 8-2  Sample of Modified gaserver.ini
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e. Save and close the file.

 13.   Restart Trillium Software System and the Scheduler.

On Windows operating systems, if you installed the postal 
tables on a network drive, you must change the Scheduler 
and inetd service to run as a Windows domain account instead 
of a system account.

 14.   Install the postal tables. See Installing on Windows and UNIX. 

 To remove a postal directory definition

 1.   Shut down Trillium Software System, including all TSS clients.

 2.   Stop the TSS Scheduler service.

 3.   Start the TSS command line utility, as described on page 182.

 4.   When prompted, log on to the _control repository.

 5.   Issue the appropriate command:

       undefine postal_directory

    undefine apac_postal_directory

    undefine census_directory

    undefine ga_directory

Installing on Windows and UNIX
The installation procedures for Windows and UNIX are generally the same and 
apply to all versions. Where there are differences, they are noted.

EDQ 64-bit tables are supported on Windows and Linux systems 
only.

The installation procedure has multiple parts:
 Install the files in a temporary directory. This procedure is 

recommended so that the file integrity can be validated before being 
implemented by your TS Quality production system.
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 Validate the integrity of the files.
 Install the files into the production directory.

Installing the Files into a Temporary Directory
There are two procedures you can run, one for non-ACE postal tables and one 
for ACE postal tables. 

 To install/update non-ACE postal directory files 

 1.   Stop the TSS Scheduler and the cleansing services (32-bit, non-EDQ 
tables only).

 2.   Create a temporary directory. The temporary location is recommended 
so that the file integrity can be validated prior to being implemented by 
TS Quality production processes.

 3.   Copy the compressed file to the temporary location. Download this file 
from the TSS Download Center (File Portal) FTP website. See File 
Naming Conventions on page 173 for a description of the file name 
formats. 

 4.   Unzip or explode the postal file using the appropriate command (for 
example, WinZip or tar). The expanded files are placed into the 
temporary location.

 5.   (UNIX users only) Review the list of files for any that have a .Z 
extension, indicating that they have been compressed. If necessary, 
uncompress files by entering the following command:

   uncompress *.Z

Due to the size of some files, the uncompress command may 
produce the error message “MAX FILE LIMIT EXCEEDED.” If 
this occurs, talk to your System Administrator about resetting 
the ULIMIT environment variable to UNLIMITED in the UNIX 
Bourne shell.

 To install ACE postal directory files

 1.   Stop the TSS Scheduler and the cleansing services, if not already 
stopped (32-bit, non-EDQ tables only).
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 2.   Copy the jpACEMMM.zip file to a temporary directory. This file is 
provided by Trillium Software from the TSS Download Center (File 
Portal) FTP website.

 3.   Uncompress the .zip file.

 4.    Copy the appropriate file(s) from the temporary directory to the 
install path\tables\ACE_tables directory:

 For Windows operating systems, copy all the files under the len 
directory.

 For Linux operating systems, copy the len.tar file to the ACE_
tables directory and uncompress it.

 For UNIX operating systems, copy the ben.tar file to the ACE_
tables directory and uncompress it.

The ACE tables must be installed in the default location to be 
recognized by Trillium Software System.

Validating File Integrity
It is strongly recommended that you check the file integrity of postal tables 
before using them in your projects. The process uses a Trillium Software-
provided utility to determine the hash value of the newly installed files. To 
complete the validation, you compare that value to the one provided in a text 
file that was delivered with the tables.

There are no hash files for ACE tables.

If you have purchased Global Postal Tables, hash files are available 
for rdata (country data) but not for kdata (knowledge base data). 

About the Hash File
Every postal table you install includes a text file named xxHASH.txt, where xx 
is the 2- or 3-character directory identifier. For example, the file CAHASH.txt 
contains the hash values for each of the files in the Canadian postal directory; 
the file USCHASH.txt contains the hash values for each of the files in the US 
census directory.
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About the Hash Utility 
The tuhash utility performs a byte-by-byte evaluation of the input file and 
returns a resulting numerical value (called the hash value) to the screen. You 
use this utility to generate values for monthly postal updates that are 
delivered with updates. You then compare the values to the ones provided. If 
the values match, the postal directories are installed properly. This process 
can be applied to any file.

The syntax of the tuhash command is:
tuhash -i <input_file> -l <lrecl>  

 To run the hash utility

 1.   Go to a command prompt.

 2.   Change to the directory that contains the files you want to validate.

 3.   Enter the tuhash command for the first file you want to validate. For 
example:

tuhash -i CAINDEX2.tbl -l 2

 4.   Press Enter. The utility returns the final hash value as shown in 
Figure 8-3.

 5.   Open the appropriate hash text file with a text editor.

 6.   Locate the line that corresponds to the file to which you applied the 
hash utility.

 7.   Compare the value in the file with the value in the command window.

 8.   If the values match, the file integrity is valid. If the values do not 
match, contact Trillium Software Customer Support.

-i <input_file> Specifies the input file name.

-l <lrecl> Specifies the record length of the file. The default record length is 
1. For larger files, using a record length of 1 makes the hash 
program run very slowly. We recommend that you specify the 
logical record length of the file if it is known. Otherwise, specify a 
number that can be divided evenly into the file size.
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 9.   Repeat the process for each postal directory file you installed.

Figure 8-3  Sample TUHASH Results

Error Codes for TUHASH
The following table describes the tuhash error codes.

Installing the Files into the Production Directory
Once you have validated the integrity of the postal files, you can move them 
into the production directory. 

The delivery of GA Postal Tables includes a series of dump files, 
named xxxL1DUMP.txt (where xxx is the 3-character country code).

Copying City Tables
TSS uses city tables in conjunction with the postal tables to validate and 
enhance address data. City tables are installed with country templates. 
Updated city tables are also delivered with postal directory (table) updates. 

Code Description

0 Program completed successfully.

1 The error code ‘1’ can reflect any of the following errors:
 Input file name not specified
 Unable to open input file
 Missing or invalid (less than zero) record length
 Unable to allocate enough memory – try smaller record length

91 Invalid command line option – check spelling.
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Naming Conventions
There are two city tables per country. The naming conventions are 
xxxCITY.ext where xxx is the 2- or 3-character country code and .ext is 
either len or ben. For example, the city tables for Austria are ATCITY.len and 
ATCITY.ben.

City Table Install Location
City tables are stored in the same location as the postal tables. For example, 
when you receive new postal files for the U.S., you copy both the postal tables 
and city tables into the default tables directory, install 
path\tables\postal_tables or \postal_utf8 (or the alternative directory 
you have set up). 

An exception are city tables associated with Global Postal Tables (see Global 
Postal Tables on page 174); these tables are generally stored in the same 
directory as the standard postal tables (also referred to as non-Asian postal 
tables). For example, when you receive new postal files for Finland (or one of 
the other Global Postal countries), you copy the postal tables to the install 
path\tables\gatables\datastore directory (or the alternative directory you 
have set up); then you copy the city tables to the install 
path\tables\postal_tables or \postal_utf8 directory (or its alternative). 

Whenever you receive updated city tables, you must copy the 
updated tables to the appropriate directories. 
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CHAPTER 9 Troubleshooting 

This section discusses potential problems you may encounter during TSS 
installation and the steps to resolve them. It includes: 

 Error: Could not create file on page 191
 Error: Writing to File TrilliumSoftware.DirectorManagerLib.dll on 

page 192
 Error: Permission Issues when Building Repository Environment on 

Linux on page 193
 Error: PANIC: Not enough space BDB Unable to join the environment on 

page 193

Error: Could not create file 
Problem:

When installing TSS, you get the error:
Error: Could not create file 

Solution:

You see the error because you do not have write permissions to the working 
directory when running the setup program. 

During TSS install, the installer needs to unpack some temporary files, and 
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does so to the current directory. If you cannot write to that directory, you 
receive the error. 

To workaround the problem, assign yourself read/write permissions. You can, 
for example make yourself a member of the TSS admin group so you have all 
the admin privilege before installing TSS. 

Error: Writing to File 
TrilliumSoftware.DirectorManagerLib.
dll 
Problem:

When installing the Control Center, you get the error:
Error 1304: Error writing to file 
TrilliumSoftware.DirectorManagerLib.dll 

Solution:

You are getting this error because the client machine has a .NET version that is 
lower than the recommended version.

Check the version of .NET 4 installed on the client machine. If the version 
listed is below the recommended version of v4.5.1, install Microsoft .NET 
Framework v4.5.1. Then install the Control Center. 

 To check .NET version

 1.   In the Control Panel, go to Add/Remove Programs.

 2.   Scroll through the list of installed programs and locate Microsoft .NET 
Framework.

 3.   Check the version. We recommend the .NET version is v4.5.1 or higher.
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Error: Permission Issues when 
Building Repository Environment on 
Linux
Problem:

When installing the Repository Server on Linux, you are getting permission 
issues/errors even though you have write access to the installation directory.

Solution:

Check the SELINUX value in the configuration file and set value as disabled. 

 To change config file setting

 1.   Go to /etc/selinux/ and open the config.txt file.

 2.   Locate SELINUX.

 3.   If the current value is enforcing, change value to: 
SELINUX=disabled

 4.   Reboot your server system. 

Error: PANIC: Not enough space BDB 
Unable to join the environment 
Problem:

When upgrading or converting a repository, you see the error: 

PANIC: Not enough space BDB Unable to join the environment

Solution: You see this message and may see other messages related to BDB 
out of resources because the upgrade process opens all repositories without 
closing them as a result the system may out of space.

To resolve the issue: 
 remove the repository's tmp directory
 rerun upgrade
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CHAPTER 10 Uninstalling TSS on 
UNIX 

Use the instructions in this chapter to uninstall the Repository Server, Country 
Templates and Batch Deployment Tool. The chapter includes the following 
topics:

 Uninstalling the Country Templates on page 195
 Uninstalling the Repository Server on page 196
 Uninstalling the Batch Deployment Tool on page 200
 Uninstalling Enterprise Data Quality (EDQ) 64-bit on page 201

When uninstalling TSS components, always initiate the process from 
outside of the _uninst directory. This directory was created during 
the TSS installation and will be removed during uninstall. 
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Uninstalling the Country Templates
Uninstall the country templates before you uninstall the repository server. 

 To uninstall the Country Templates

 1.   Log in as the TSS administrator. Locate the directory where you 
installed country templates. 

 2.   Run the uninstaller program: 
./_uninst/CountryProjects15/uninstaller.bin -console

(Always run the uninstall outside of the _uninst directory. This directory 
was created during the TSS installation and is removed during 
uninstall.) The setup prepares for the uninstall and prompts you to 
confirm the uninstall. 

 3.   Click Next.

You will see a list of the country templates that will get uninstalled.

 4.   Press Enter to begin to uninstall. After uninstall is complete, you will 
see the message.
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Uninstalling the Repository Server
To successfully uninstall the repository server, you need to remove data 
import directories, binaries, and repository servers. You also need to edit the 
services and inetd.conf files. These procedures are described in the following 
sections.

Before You Begin
Before you begin:

 Uninstall country templates. 
 Back up repositories you want to retain.
 Verify all users are logged off the TSS repository server.
 Check with your UNIX administrator and ensure that stopping and 

restarting inetd.conf (which listens for client connections) will not 
cause problems in your environment.

Stopping TSS Scheduler on UNIX
The TSS Scheduler schedules the background tasks for the repository. You 
must stop the Scheduler prior to uninstalling the Repository Server. 

 To stop TSS Scheduler

 1.   Verify that there are no users logged on to TSS.

 2.   Log in to the server as the TSS administrator.

 3.   Change directories to /<Server Path>/metabase/bin

 4.   Enter the command: ./scheduler -stop
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Stopping TSS Rest APIs on UNIX
You must stop the Rest APIs prior to uninstalling the Repository Server. 

 To stop TSS Rest APIs

 1.   Verify that there are no users logged on to TSS.

 2.   Log in to the server as the TSS administrator.

 3.   Change directories to /<Server Path>/metabase/bin

 4.   Enter the command: ./svr_stop

Removing Data Import Locations
When configuring the TSS repository servers, you defined import locations. 
These locations store the source files used for data imports into Trillium 
Software System. If you are planning to reuse the source files or directory 
structure, ignore this section. Otherwise, follow the instructions below to 
delete the data import locations.

 To manually remove data import locations

 1.   Click Start > All Programs > Trillium Software > TSS 15 > 
Repository Manager.

 2.   Log in as the TSS repository administrator.

 3.   Expand the folder Control Admin.

 4.   Double-click on the folder Loader Connections.

 5.   From the List View, right click on a Data Connection and select Edit.

 6.   Take note of the directory location and click Cancel.

 7.   Delete the directory if it is no longer required.

 8.   Repeat steps for each defined Data Connection and delete as necessary.

For more information about the Repository Manager, refer to the TSS 
Repository Administrator’s Guide. You can access the document from the 
Windows Start menu. (Click Start > All Programs > Trillium Software > 
TSS 15 > Documentation.)
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Removing TSS Binary Files
When you installed TSS, you had defined the repository server path. This 
directory has all the repository binary files etc, and this is the location you will 
remove in the following procedure.

 To remove TSS binaries

 1.   Log in to the repository server as the TSS repository administrator.

 2.   Locate and verify the directory that contains the TSS binaries.

 3.   After you are satisfied that this is the correct directory location, type the 
command:

  rm -R <Server Path> 
This removes the directory and all its subdirectories and files under 
<Server Path>. For example, if you installed the TSS server application 
in /rel15, enter rm -R /rel15.

Removing the TSS Repository
During repository server install, you defined the repository path location by 
answering the question: Where would you like to install your Repository 
Environment? This is the directory from where you will remove a TSS 
repository. 

 To remove a TSS repository

 1.   Log in to the server machine as the TSS repository administrator.

 2.   Locate the directory that contains the TSS repositories.

 3.   Verify the repository names used with this version by checking the 
directory /<Repository Path>/metabase. If the names of those 
repositories are there, then you know that you have the correct path.

 4.   Once you have verified that you have the correct repository location, 
type the command:
    rm -R <Repository Path> 
This removes the directory and all its sub-directories and files under 
<Repository Path>. For example, if you installed TSS repositories in /
mb15, then you would type:
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rm -R /mb15

If you try to delete the primary directory of a file system, you 
will see an error message stating that the directory is empty 
and you will not be able to delete the directory. This however 
does not mean that the directory is actually empty. 

Removing Entries in Services File
When you installed TSS, two entries were added to the bottom of the 
services file located in the /etc directory.

 To remove entries in the Services file

 1.   Log in to the server system as a root user.

You must be logged on as root user to modify the services file.

 2.   Navigate to the /etc directory.

 3.   Locate the services file, then make a backup of the file.

 4.   Open the services file for editing and go to the end of the file. Locate 
the following lines: 

 5.   Delete these three lines from the services file.

 6.   Save your changes and close the file.

Removing Entries from inetd.conf File
When you installed TSS, an entry was added to the bottom of the inetd.conf 
file found in the /etc directory.

 To remove entries from inetd.conf

 1.   In the /etc directory, locate the inetd.conf file.

You should still be logged on as root to modify theinetd.conf 
file. 
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 2.   Make a backup of the file.

 3.   Open inetd.conf for editing and go to the end of the file.

You will see two lines inserted into the file. See the graphic below for an 
example.

 4.   Delete the lines from the inetd.conf file.

 5.   Save your changes and close the file.

 6.   Restart the inetd by entering the command:

kill -HUP $(ps -e|grep inetd|head -1|awk ‘{print$1}’)

This releases the ports.
This command will stop and restart inetd. Check with your UNIX 
administrator to ensure that this command will not cause problems in 
your environment.

Uninstalling the Batch Deployment 
Tool
 To uninstall Batch Deployment Tool

 1.   Log in as the user who installed BDT. 

 2.   From the location where the BDT setup file was copied, run the 
uninstaller program: 
./setup -remove 
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Uninstalling Enterprise Data Quality 
(EDQ) 64-bit
 To uninstall EDQ 64-bit

To uninstall EDQ components on Linux machines, run the following 
uninstall script:

_uninst/EDQ/uninstaller.bin -silent

You can also execute this command in -console mode.
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CHAPTER 11 Uninstalling TSS on 
Windows

Use the instructions in this chapter to uninstall the Repository Server or other 
TSS components. The chapter includes the following topics:

 Uninstalling Country Templates on page 203
 Uninstalling the Repository Server on page 203
 Uninstalling the Control Center on page 210
 Uninstalling the ODBC 32-Bit Reporting Adapter on page 210
 Uninstalling the OLE DB 64-Bit Provider on page 211
 Uninstalling the ODBC 64-Bit Reporting Adapter on page 212
 Uninstalling the Batch Deployment Tool on page 212
 Uninstalling Enterprise Data Quality (EDQ) 64-bit on page 213
 Removing Post-Installation Files on page 213

When uninstalling TSS, follow the product uninstall sequence 
documented here. 

When uninstalling TSS components, the uninstall process attempts to delete 
all directory structures associated with the product. However, if files were 
added to your directory structure after the installation, these directories will 
not be removed during the uninstall process. You will need to delete them 
manually. See Removing Post-Installation Files on page 213 for more 
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information.

Uninstalling Country Templates 
Uninstalling Country Templates will remove all the directories containing the 
country project templates and the postal tables. 

 To uninstall Country Templates

 1.   Log in to the repository server system as the TSS application 
administrator.

 2.   Verify that all users are logged off the Control Center and Repository 
Manager.

 3.   From the Control panel, open the Uninstall or change a program 
window and select TSS 15 – Country Templates.

 4.   Click Uninstall. You are prompted to confirm the uninstall.

 5.   Click Yes to begin the uninstall.

 6.   Verify that TSS15 - Country Template is no longer listed

Uninstalling the Repository Server 
Before you begin:

 Back up any repository servers or repositories you want to retain.
 Make sure all users are logged off the TSS repository server.
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Removing Data Source Import Locations
During repository server installation, you defined the import locations. These 
locations store the source files used for data imports into Trillium Software 
System.

If you are planning to reuse the source files or directory structure, 
skip this procedure so that you can reuse them in future. 

 To manually remove data import locations

 1.   Click Start > All Programs > Trillium Software > TSS 15 > 
Repository Manager.

 2.   Log in as the TSS repository administrator.

 3.   Expand the folder Control Admin.

 4.   Double-click the folder Data Connections.

 5.   From the List View, right-click a Data Connection and select Edit.

 6.   Take note of the directory location and click Cancel.

 7.   Delete the directory if it is no longer required.

 8.   Repeat the steps to delete other data import locations as needed. 

For information about the Repository Manager, refer to the TSS Repository 
Administrator’s Guide. 

Stopping TSS Scheduler Service
 1.   Log in as the TSS administrator.

 2.   Open Control Panel > System and Security > Administrative 
Tools.

 3.   Double-click Services and scroll through the list of services. 

 4.   Select TSS 15 - Scheduler.

 5.   Right-click and select Stop.
204 Trillium Software System Installation Guide



Uninstalling TSS on Windows 
Stopping TSS Apache Tomcat 
 1.   Log in as the TSS administrator.

 2.   Open Control Panel > System and Security > Administrative Tools.

 3.   Double-click Services. 

 4.   Scroll the list and select Apache Tomcat 8.0 Tomcat8.

 5.   Right-click and select Stop.

Stopping TSS Rest APIs service 
 1.   Log in as the TSS administrator.

 2.   Open Control Panel > System and Security > Administrative Tools.

 3.   Double-click Services. 

 4.   Scroll the list and select TSS 15 - Rest APIs.

 5.   Right-click and select Stop.

Stopping TSS inetd Service
 1.   Log in as the TSS Administrator

 2.   Open Control Panel > System and Security > Administrative Tools.

 3.   Double-click Services. 

 4.   Locate and select TSS - inetd.

 5.   Right-click and select Stop. 

During repository uninstall, you can: 
 Delete all data and repositories. (See Deleting all Data and Repositories 

on page 206)
 Retain all data and repositories. (See Retain all Data and Repositories 

on page 209)
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Deleting all Data and Repositories
 To uninstall TSS repository server and delete all data and 

repositories

 1.   Log in to the TSS server as the TSS Administrator.

 2.   From the Control panel, open the Uninstall or change a program 
window and select TSS 15 - Repository Server.

 3.   Click Change. The Welcome window opens.
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 4.   Click Next. The Program Maintenance window opens. 

 5.   Select Remove to remove the TSS 15 - Repository Server.

 6.   Click Next.
Trillium Software System Installation Guide 207



Uninstalling TSS on Windows
 7.   To remove all data, select the Repository and all associated data 
will be removed option.

 8.   Click Next.
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The Remove the Program window opens. 

 9.   Click Remove. When uninstall is complete, the InstallShield Wizard 
Completed window opens.

 10.   Click Finish to close the wizard. 

 11.   Verify that TSS 15 - Repository Server is no longer listed. 

Retain all Data and Repositories
 To uninstall TSS Server and retain all data and repositories 

 1.   Follow the instructions in steps 1 to 6 in the procedure above. 

 2.   In the Remove Repository Data window, verify that the Repository 
and all associated data will be removed is not selected. 

 3.   Click Next to open the Remove the Program window. 

 4.   Click Remove. When uninstall is complete, the InstallShield Wizard 
Completed window opens. 
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 5.   Click Finish to close the wizard. 

 6.   Verify that TSS 15 - Repository Server is no longer listed.

Uninstalling the Control Center
Follow the directions to uninstall the Control Center from each system where it 
is installed.

 To uninstall the Control Center

 1.   Log in to the TSS client machine as the Windows Administrator.

 2.   From the Control panel, open the Uninstall or change a program 
window and select TSS 15 - Control Center.

 3.   Click Uninstall. You are prompted to confirm the uninstall.

 4.   Click Yes.

 5.   Verify that TSS 15 - Control Center entry is no longer listed.

Uninstalling the ODBC 32-Bit Reporting 
Adapter
Follow these directions to uninstall the ODBC 32-bit Reporting Adapter. 

 To uninstall the ODBC Reporting Adapter

 1.   Log in to the TSS client machine as the Windows Administrator.

 2.   From the Control panel, open the Uninstall or change a program 
window and select TSS 15 - ODBC Reporting Adapter.
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 3.   Click Remove. You are prompted to confirm the uninstall.

 4.   Click OK. 

 5.   Click Finish to close the wizard. 

 6.   Verify that TSS 15 - ODBC Reporting Adapter entry is no longer listed. 

Uninstalling the OLE DB 64-Bit 
Provider
Follow this procedure if you need to uninstall the OLE DB Provider (64-bit) for 
any reason.
 To uninstall the 64-bit OLE DB Provider

 1.   Log on to the TS Quality server as the TSS application administrator.

 2.   Open the Windows Control Panel and double-click Add or Remove 
Programs.

 3.   In the Add or Remove Programs window, double-click Tssversion – 
OLE DB Provider (64-bit). A message opens asking if you are sure 
you want to uninstall the software. 

 4.   Click Yes. When the uninstall finishes, the entry for Tss15 - OLE DB 
Provider (64-bit) is no longer available. 
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Uninstalling the ODBC 64-Bit 
Reporting Adapter
Follow this procedure if you need to uninstall the ODBC Reporting Adapter (64-
bit) for any reason.

During the uninstall you may be prompted to uninstall DSNs you created. 

 To uninstall the 64-bit ODBC Reporting Adapter

 1.   Log on to the TS Quality server as the TSS application administrator.

 2.   Open the Windows Control Panel and double-click Add or Remove 
Programs.

 3.   In the Add or Remove Programs window, double-click Tss version – 
ODBC Reporting Adapter (64-bit). A message opens asking if you 
are sure you want to remove the software. 

 4.   Click OK. 

Uninstalling the Batch Deployment 
Tool
Follow the directions to uninstall the Batch Deployment Tool from each system 
where it is installed.

 To uninstall the Batch Deployment Tool

 1.   Log in to the TSS client machine as the Windows Administrator.

 2.   From the Control panel, open the Uninstall or change a program 
window and select TSS 15 - Batch Deployment Tool.

 3.   Click Uninstall. You are prompted to confirm the uninstall.

 4.   Click Yes. 

 5.   When the uninstall finishes, verify that TSS15 - Batch Deployment Tool 
is no longer listed. 
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Uninstalling Enterprise Data Quality 
(EDQ) 64-bit
Follow the directions to uninstall EDQ 64-bit from each system where it is 
installed. 

 To uninstall EDQ

 1.   Log on to the machine where EDQ is installed as an administrator user. 

 2.   Stop all TSQ services, such as TSQ Director (x64) and TSQ Client for 
SAP (x64).

 3.   From the Control panel, open the Uninstall or change a program 
window and right-click TSS 15 - EDQ (x64).

 4.   Select Uninstall. You are prompted to confirm the uninstall.

 5.   Click Yes. 

 6.   When the uninstall finishes, verify that TSS 15 - EDQ (x64) is no longer 
listed. 

Removing Post-Installation Files
After uninstall is complete, manually delete any files or folders that were 
custom added after installation. 

Files may be added to the installation directories as a result of user activities. 
For example, when you deploy a project to real time, the Control Center 
populates the cache directories in the repository path with projects to be 
picked up by the Project Deployment Manager. The files in these directories 
are not removed by the uninstall process. 

Before you remove any file, check if you need to archive them. For archiving 
instructions, see Archiving Post-Installation Files on page 214.
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Uninstalling TSS on Windows
 To manually remove post-installation files and directories 
(optional)

 1.   Log in to the TSS server as the TSS Administrator.

 2.   Locate the installation directory, also referred to as the repository 
server path. Assuming you selected the default during installation, the 
path is Install_path\Trillium Software\MBSW\15.

 3.   Delete any files you do not want to save.

 4.   Next, navigate to: C:\ProgramData\Trillium Software\MBSW\15

 5.   Delete files. 

 6.   Delete the directory 15 and any sub-directories.

Archiving Post-Installation Files
If you are planning to reinstall Trillium Software System, it is recommended 
that you archive any post-installation files you may want to use. 

During re-install, the Control Center may overwrite old files with new files of 
the same name, or write new data into existing files, thereby corrupting them.

 To manually archive post-installation files and directories 
(optional)

 1.   Log in to the TSS server as the TSS administrator.

 2.   Locate the installation directory, also referred to as the repository 
server path. Assuming you selected the default during installation, the 
path is Install_path\Trillium Software\MBSW\15.

 3.   Archive any files you want to save.

 4.   Navigate to: C:\ProgramData\Trillium Software\MBSW\15

 5.   Archive any files you want to save.
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APPENDIX A Installing TS Quality Core 
Only

The information in this appendix applies to 32-bit environments only. 
If you need to install TS Quality Core in a 64-bit environment, see 
Installing EDQ on page 127.

TS Quality, an optional component of the Trillium Software System installs 
executables and libraries for TS Quality processes and utilities. Out of the box, 
if you are licensed for TS Quality, it is installed with the repository server. You 
can also install just this component on a as needed basis. For example, you 
may need to install TS Quality if you will create TS Quality projects to deploy 
to real time. 

This chapter contains instructions on how to install and uninstall TS Quality 
Core only on UNIX and Windows operating systems. 

This chapter includes:
 Installing TS Quality Core Only on UNIX on page 216
 Uninstalling TS Quality Core Only on UNIX on page 217
 Installing TS Quality Core Only on Windows on page 218
 Uninstalling TS Quality Core only on Windows  on page 222
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Installing TS Quality Core Only on 
UNIX
By default, TS  Quality is installed with the repository server. You can also 
install just the TS Quality core component on an as needed basis. 

Before you begin, verify you have set up user permissions as described in 
Defining User Accounts on UNIX on page 23.

 To install TS Quality core only on UNIX 

 1.   Log in to the system where you plan to install the TS Quality Core Only 
as the TSS administrator.

 2.   If you have not yet done so, download the setup from the TSS 
Download Center (File Portal) FTP website.

 3.   Locate the directory /Repository_Server 

 4.   Set execute permissions on the launcher (if necessary): 
chmod +x tss_server_version.build_platform.sh

 5.   Run the setup file with the following command:
tss_server_version.build_platform.sh -coreonly directory
where directory is the TS Quality install location.
The setup prepares the environment and displays the prompt Choose 
your Oracle version. 

 6.   Type the option number (1, 2 or 3) that applies to your site and press 
Enter. The default value is 1 (Oracle 10g). 

Depending on your operating system and configuration, you 
may see different choices for Oracle client versions. 

The process installs the Data Adapter. Data Adapter provides read/write 
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functionality to various database products supported by TSS.

 7.   After installation is complete, you see the installation complete 
message. 

Uninstalling TS Quality Core Only on UNIX
When uninstalling TSS, always initiate the process from outside of the _uninst 
directory.

 To uninstall TS Quality on UNIX

 1.   Locate the directory that contains the TSS Quality installation.

 2.   Type the command:

  rm -R <tsqlocation> 
where <tsqlocation> is the directory where you installed TS Quality. 
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Installing TS Quality Core Only on 
Windows
 To install TS Quality on Windows

 1.   Log in as the TSS administrator.

 2.   Browse to the setup files you downloaded prior to installation from the 
TSS Download Center (File Portal) FTP website.

 3.   Go to the folder level: \\tsq15.0.0\TSS\buildnumber\TSS_Windows_
Quality_Core_Only and run the tsq15.0.0.build#.Win32 executable.

The InstallShield Wizard gathers the required information and shows 
the welcome message. 

 4.   Click Next.
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The License Agreement window opens.

 5.   Read the License Agreement and select I accept the terms in the 
license agreement option.

 6.   Click Next. The Language window opens, with ENGLISH as the default 
language to use for reports and log files.
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 7.   To choose another language, click the drop-down list and select from 
the available languages. 

This language setting only affects TS Quality processes 
running outside the Control Center.

 8.   Click Next. The Destination Folder window opens.
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 9.   Click Next to accept the default path.  
Alternately, click Change to specify a custom destination folder and 
then click Next. 

The Ready to Install window opens:
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 10.   Click Install to begin. A status window shows the progress. When 
complete, the InstallShield Wizard Completed window opens.

 11.   Click Finish to close the wizard.

Uninstalling TS Quality Core only on Windows 
Uninstalling TS Quality removes all TS Quality components. Before you begin, 
verify that all users are logged off the Control Center and Repository Manager.

 To uninstall TS Quality

 1.   Log in to the TS Quality server as the TSS administrator.

 2.   In the Control Panel, open Add or Remove Programs.

 3.   Scroll through the list and select TSS 15 – Quality.

 4.   Click Remove. You are prompted to confirm the uninstall.

 5.   Click Yes. 
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APPENDIX B Installing Standalone TS 
Web Server

This appendix guides you through the steps required to install standalone TS 
Web Server. The TS Web Server allows communication between the repository 
server and web-based Trillium applications the Discovery Center and 
Administration Center. 

This chapter includes the following topics:
 Understanding Configuration on page 224
 Installation Checklist on page 225
 Installing Standalone TS Web Server on page 226
 Starting and Stopping TSS Rest APIs Service on page 231
 Uninstalling Standalone TS Web Server  on page 231

You need to install the TS Web Server only if you installed the 
repository server on Sun SPARC or AIX and you intend to use the 
Discovery Center and/or the Administration Center. 
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Understanding Configuration
In Linux and Windows environments, when you install the repository server, it 
automatically installs the TS Web Server. 

Figure 2-1  Standard TS Web Server Configuration

The repository server installation does not install TS Web Server on Sun 
SPARC or AIX.

Therefore, you must install the TS Web Server as a standalone application on a 
Windows system so that the web server can communicate with the repository 
server.

Figure 2-2  Standalone TS Web Server Configuration
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Installation Checklist 
Before you install the TS Web Server: 

 Familiarize yourself with the install setup and any associated release 
notes. 

 Verify network connectivity and access to the repository server by 
issuing a telnet command from the Windows system to the server. If 
you cannot telnet to the repository server, you will not be able to install 
the Web Server.

 Identify repository server port and hostname. 
 Identify available port for UI Web Server. 

During installation, you are prompted to provide port numbers for UI 
Web Server. 

To find available port number for UI Web Server

 1.   From the Windows Start menu, select Start > Run....

 2.   Type cmd and click OK.

 3.   At the prompt, type: 

      netstat -an

 4.   Press Enter. This returns a list of active ports.

 5.   Review the list and identify available ports. Available ports do not 
appear in the list.

 6.   Type exit to close the window.
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Installing Standalone TS Web Server 
Install the TS Web Server application only if your repository server is running 
on Sun SPARC or AIX.

Do not install the TS Web Server on a Windows system where you installed the 
repository server. The TS Web Server should be installed on a separate 
Windows system.

 To install TS Web Server on Windows

 1.   Log in as the TSS administrator.

 2.   Browse to the setup files you downloaded prior to installation from the 
TSS Download Center (File Portal) FTP website.

 3.   Click TSS 15- Web Server. The InstallShield Wizard gathers the 
required information and shows the Welcome window. 

 4.   Click Next.
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The License Agreement window opens.

 5.   Read the License Agreement and select I accept the terms in the 
license agreement option.

 6.   Click Next. The Web Server/Repository Web Services window opens. 
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 7.   In Web Server Port, enter a port number or keep the default of 3000. 
This is the port number the TS Web Server will listen on.

 8.   In TSS Server Web Services port, enter the same port number you 
used for web services, when you installed the repository server.

 9.   In TSS Server host, enter the fully qualified domain name or the IP 
address of the repository server system. 

 10.   Click Next. The Destination Folder window opens.
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 11.   Click Next to accept the default path.  
Alternately, click Change to specify a custom destination folder and 
then click Next. 
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The Ready to Install window opens.

 12.   Click Install to begin the install. A status window shows the progress. 
When the installation is complete, the InstallShield Wizard Completed 
window opens.

 13.   Click Finish to close the wizard.

After you have installed the TS Web Server, verify that the TSS Rest APIs 
service is running (see Starting and Stopping TSS Rest APIs Service).
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Starting and Stopping TSS Rest APIs 
Service
The TSS 15-Rest APIs service should start automatically. You can start the 
service manually if needed.

 To restart TSS Rest APIs

 1.   Log in as the TSS administrator.

 2.   From the Windows Control Panel, open System and Security > 
Administrative Tools > Services.

 3.   Select the service named TSS 15 - RestAPIs.

 4.   Right-click and select Start.The Status changes to Started.

To stop TSS Rest APIs

 1.   Log in as the TSS administrator.

 2.   Open Control Panel > System and Security > Administrative 
Tools.

 3.   Double-click Services. 

 4.   Scroll the list and select TSS 15 - Rest APIs.

 5.   Right-click and select Stop.

Uninstalling Standalone TS Web 
Server 
Uninstalling TS Web Server will remove all web server components. Before you 
begin, verify that all users are logged off the Repository Manager.

 To uninstall TS Web Server

 1.   Log in as the TSS administrator.

 2.   In the Control Panel, open Add or Remove Programs.
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 3.   Scroll through the list and select TSS 15 – Web Server.

 4.   Click Change. The Program Maintenance window opens. 

 5.   Select Remove and click Next.
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The Remove the Program window opens. 

 6.   Click Remove. When uninstall is complete, the InstallShield Wizard 
Completed window opens.

 7.   Click Finish to close the wizard. 

 8.   Verify that TSS 15 - Web Server is no longer listed. 
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APPENDIX C Converting/Upgrading an 
Older Repository Server to 
v15.x

This appendix describes the process for converting an older repository server 
to TSS v15.x on both on UNIX and Windows operating systems. After you have 
successfully converted or upgraded an older repository, verify the country 
project templates and postal tables are pointing to the correct location.

You can only convert repositories that are pre TSS v14.x. If your 
repository is of a TSS v14.x or v15.x version, you will need to 
upgrade the repository.

This appendix includes:
 Converting Pre TSS v14 Repositories on page 234
 Upgrading TSS v14 or v15 Repository on page 239

Converting Pre TSS v14 Repositories
We recommend that you convert existing repositories during the installation of 
TSS 15.x. However, if for some reason, you did not perform the conversion, 
manually copying the source repository to the destination directory ready for 
conversion is not applicable. You will instead need to use the mtb_admin copy 
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command for repository conversion.
Conversion is a process by which an earlier version of a TSS repository server 
is made compatible with a later version; for example, converting a v13.0 
repository server to be used with v15.x. A repository server is a collection of 
repositories. You cannot convert an individual repository. 

You can only convert a single repository server! For example, if you 
convert a repository server during the installation process, you 
cannot convert another repository server using the mtb_admin copy 
command.

If you opt to use the mtb_admin copy command to convert an older repository 
server, you must use it before you create new repositories, loader 
connections, users, entities, and so on in TSS v15.x.

Requirements
If you plan to convert an older repository server, it must satisfy the following 
conditions:

 It must be from TSS Version 11.0.1, 11.5.2, 12.0.1, 13.0 or 13.5.1
 It must be complete and valid.
 It must be clean. You must delete unneeded repositories, users, and so 

on.
In addition, before you convert the older repository server:

 Delete the v15.x repository installed during v15.x installation. 
 Stop the TSS Scheduler for both TSS v15 and the older TSS version 

from which you are converting.
 Remove the metabase, logging, and tmp directories from the 

C:\ProgramData\Trillium Software\MBSW\15\Data directory.
 All users must be logged off TSS.

You must also know the user ID and password of the repository administrator 
who created the older repository server.
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Converting an Older Repository to TSS v15.x
This section includes instructions on how to convert an older repository server 
to TSS v15.x and has the following topics.

 Converting a Repository on UNIX on page 236
 Converting a Repository on Windows on page 237

Do not use this procedure for an older v15.x repository. You must run an 
upgrade in that case. See Upgrading TSS v14 or v15 Repository on page 239.

Converting a Repository on UNIX
Follow the instructions to convert an older repository to TSS v15 on UNIX. 

 To convert an older repository server to TSS 15.x

 1.   In the system where you installed TSS v15.x, use the copy command to 
point to the source repository. For example:

/home/username/TSS15/metabase/bin/mtb_admin -user madmin -
password madmin -copy /home/username/data13.0/

where data13.0 is the path to the source repository.

 2.   Start the repository conversion:

/home/username/TSS15/metabase/bin/mtb_admin -user madmin -
password madmin -convert ddl convert.ddl

where user is the TSS v15.x repository administrator ID and password 
is the password associated with that ID.

If you are using Windows-authentication with TSS, you must 
log in with your fully-qualified user name.

A series of messages display on the console, as shown below.
Converting metabase "_control"
Converted  metabase "_control"
Converting metabase "meta1152"
Converted  metabase "meta1152"
Upgrading metabases
Upgraded metabases
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 3.   When the conversion is complete, restart the TSS Scheduler service.

/home/username/TSS15/metabase/bin/scheduler -start

Sample 
A sample Unix conversion script looks like this:

#!/bin/sh

/home/username/TSS15/metabase/bin/scheduler -stop

echo "Deleting 15 metabase"

rm -rf /data/discovery/engg/username/DATA/metabase

rm -rf /data/discovery/engg/username/DATA/logging

rm -rf /data/discovery/engg/username/DATA/logs

rm -rf /data/discovery/engg/username/DATA/tmp

rm -rf /data/discovery/engg/username/DATA/license.db

echo "Copy & upgrade source metabase to v15..."

/home/username/TSS15/metabase/bin/mtb_admin -user madmin -
password madmin -copy /home/username/data13.5.1/

echo "Running conversion..."

/home/username/TSS15/metabase/bin/mtb_admin -user madmin -
password madmin -convert ddl convert.ddl

/home/username/TSS15/metabase/bin/scheduler -start

Converting a Repository on Windows
Follow the instructions to convert an older repository to TSS v15.x on 
Windows. 

 To convert an older repository server to TSS v15.x

 1.   In the system where you installed TSS v15.x, use the copy command to 
point to the source repository. For example:
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C:\Program Files (x86)\Trillium Software\MBSW\15\bin>mtb_
admin -user "madmin" -password "madmin" -copy "c:/
ProgramData/Trillium Software/MBSW/13/data13"

where data13 is the path to the source repository.

 2.   Start the repository conversion:

C:\Program Files (x86)\Trillium Software\MBSW\15\bin>mtb_
admin -user "madmin" -password "madmin" -convert ddl 
convert.ddl

where user is the TSS 15.x repository administrator ID and password is 
the password associated with that ID.

If you are using Windows-authentication with TSS, you must log 
in with your fully qualified user name.

 3.   When the conversion is complete, restart the TSS Scheduler service.

Sample 
A sample Windows conversion script looks like this:

@echo off

echo "Deleting 15 metabase..."

rmdir /S /Q "C:\ProgramData\Trillium 
Software\MBSW\15\Data\metabase"

rmdir /S /Q "C:\ProgramData\Trillium 
Software\MBSW\15\Data\logging"

rmdir /S /Q "C:\ProgramData\Trillium 
Software\MBSW\15\Data\tmp"

attrib -h "C:\ProgramData\Trillium 
Software\MBSW\15\Data\license.db"

del /F /Q "C:\ProgramData\Trillium 
Software\MBSW\15\Data\license.db"

echo "Copy & upgrade source metabase to v15..."

call "C:\Program Files (x86)\Trillium 
Software\MBSW\15\bin\mtb_admin" -user "" -password "" -copy 
" C:\ProgramData\Trillium Software\MBSW\12"
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echo "running convert"

call "C:\Program Files (x86)\Trillium 
Software\MBSW\15\bin\mtb_admin" -user "" -password "" -
convert ddl convert.ddl

pause

Upgrading TSS v14 or v15 Repository
Upgrade is a process by which an version of a TSS 14.x or 15.x repository 
server is made compatible with a later version of TSS 15.x; for example, 
upgrading a v14.3 repository server to be used with v15.3.

Trillium Software recommends that you upgrade existing repositories during 
the installation of TSS 15.x. However, if for some reason, you did not perform 
the upgrade, manually copying the source repository to the destination 
repository is not applicable. You will instead need to use the mtb_admin 
upgrade command for repository upgrade.

Repository upgrade is used to patch from version to version. It only adds new 
tables and does not remove or significantly alter existing tables. 

Requirements
If you plan to upgrade a TSS 14.x repository server, it must satisfy the 
following conditions:

 It must be from TSS Version 14.x or 15.x
 It must be complete and valid.
 It must be clean. You must delete unneeded repositories, users, and so 

on.
In addition, you must also know the user ID and password of the repository 
administrator who created the older repository server.
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Upgrading an Older Repository
 To upgrade to TSS 15.x

 1.   In the system where you installed TSS v15.x, log into mtb_admin _
control repository.

 2.   Enter upgrade

 3.   Press Enter to begin the upgrade process.

Sample 
A sample Windows upgrade looks like this:

$ ./mtb_admin
TSS Repository Administration Tool (spf-15-0-0_14164)
login: mtbadmin
password: *
Select repository from "_control test1 test2".
repository:
_control: upgrade
_control:
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APPENDIX D Retaining Customizations 
During Upgrade

This appendix guides you through the steps required to retain changes made 
to the config.txt and settings.xml files when you upgrade to TSS v15.7.

This chapter includes:
 Retaining Changes in config.txt Files on page 242
 Retaining Changes in server.xml Files on page 243

You do not need to follow these procedures if:
 You are installing Trillium Software on your system for the first time (no 

previous versions installed). 
 For the server.xml file, if you are upgrading from a pre-15 version of 

TSS. 
 The config.txt or server.xml file on your system has not been 

modified.
 You do not need to retain modifications and instead want to use the 

default settings in the new config.txt or server.xml files that are 
installed with the TSS software. 
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Retaining Changes in config.txt Files
This section describes how to retain changes made to the config.txt file 
during an upgrade to TSS version v15.x from any previous version (on either 
Windows or UNIX systems). All changes made post v15.0 are retained during 
an upgrade.
During an upgrade, the system can automatically detect changes made to the 
config.txt server configuration file on your system. Once identified, the 
upgrade process automatically renames the custom config file to 
config.txt.backup and installs a new, clean config.txt file in the etc 
directory. 
To retain your custom configurations, you must complete the following 
procedure after the upgrade. 

Modifications can, among other items, include changing of the license 
server location and modifying time-out settings. 

 To retain modifications made to config.txt

 1.   Complete the upgrade to TSS 15.x. 

 2.   On the TSS server system, open the new config.txt file located in the 
etc directory of your TSS repository server installation path. 

 Windows - Install_path\Trillium Software\MBSW\15\etc
 UNIX - /TrilliumSoftware/server/metabase/etc

 3.   Open the config.txt.backup file for reference and make the 
modifications you want to retain in the new config.txt file.

Do not rename the backup file to config.txt. For the TSS 
repository server to be properly configured, you must make 
the changes in the new, version 15-compliant config.txt file.

 4.   Save and close the config.txt file.

 5.   (Optional) Delete the config.txt backup file. 

 6.   Restart the TSS Scheduler service. 
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Retaining Changes in server.xml Files
The server.xml file, installed with the 32-bit Apache Tomcat when you run 
the TSS v15 server install, is used to specify information such as the Tomcat 
start and stop ports. 

When you install the TSS server, the software automatically installs a new 
version of the server.xml file, overwriting the existing server.xml file.

Follow this procedure to retain changes made in the server.xml file when 
upgrading TSS.

If you are upgrading from a pre-15.0 version of TSS (for example, 
v13.5.1 or 14.0), you do not need to follow this procedure.

 To retain modifications made to server.xml

 1.   Before you install TSS v15.7, rename the existing server.xml file as a 
backup file (for example, server.xml.bak). This backup file will be 
used for reference. 

server.xml is located in the following location: 
 
Windows: C:\Program Files (x86)\Trillium Software\MBSW\ 
   15\Apache_Tomcat\conf  
 
UNIX: server_install_path/metabase/Apache_Tomcat/conf

 2.   Install TSS v15.7. The TSS server will install a new server.xml file.

 3.   Using the server.xml backup file for reference, open the new 
server.xml file and add the modifications you want to retain. 

 4.   Save and close the server.xml file.

 5.   (Optional) Delete the backup server.xml file. 
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APPENDIX E Configuring Vendor-
Supplied ODBC

This appendix guides you through the steps required to set up the vendor- 
supplied ODBC that connects to a relational database, and includes the 
following topics:

 Configuring ODBC Source Connections on page 244
 Installing TSS Vendor ODBC Adapter  on page 246
 Setting Up Oracle/IBM DB2 Data Source Connections on page 252
 Troubleshooting Sybase on page 255

Configuring ODBC Source Connections
Before you can import data from an ODBC source, complete the following 
tasks:

 Determining Configuration
 Installing TSS Vendor ODBC Adapter 
 Setting Up Oracle/IBM DB2 Data Source Connections

You must also create a TSS data connection to access the ODBC source. For 
more information about ODBC connections, see the TSS Repository 
Administrator’s Guide.
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Determining Configuration
To import data from ODBC sources, you must install TSS ODBC support on a 
Windows Server. TSS ODBC support does not have to reside on the same 
machine as the TSS server or client. The following figures show two 
configuration options.
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Installing TSS Vendor ODBC Adapter 
 To install TSS Vendor ODBC Adapter on a Windows Server

 1.   Log in to the system where you want to install TSS ODBC Support as 
the Windows Administrator.

 2.   Browse to the setup files (TSS_15_build_Windows_Vendor_ODBC_
Adapter.zip) you downloaded from the TSS Download Center (File 
Portal) FTP website prior to installation and double-click the setup.exe 
file. 

The InstallShield Wizard gathers the required information and opens the 
Welcome window. 
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 3.    Click Next. The License Agreement window opens.

 4.   Read the agreement and if you agree to the terms, select I accept the 
terms in the license agreement.

 5.   Click Next. The Customer Information window opens.

 6.   Enter User Name and Organization information.

 7.   Click Next. The Destination Folder window opens.
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 8.   Click Next to accept the default destination for the TSS ODBC binaries. 
Alternately, click Change to specify a different location, then click 
Next. The Log Folder window opens.
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 9.   Click Next to accept the default location for log files. Alternately, click 
Change to specify a different location, then click Next. The Server Port 
window opens.

This port is for the TSS ODBC Service. Note down this number since you 
will need to supply it when defining the ODBC data connections. This 
port must not be used by any other service on the machine.
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 10.   In ODBC Adapter Port, specify the port number or keep the default 
value 15070. Then click Next. The Ready to Install window opens.

 11.   Click Install to begin the installation. When the installation is complete 
the InstallShield Wizard Completed window opens.

 12.   Click Finish to close the wizard.

 13.   Restart the computer for the installation changes to take effect. 

If you intend to import data from Oracle or IBM DB2, continue to 
Setting Up Oracle/IBM DB2 Data Source Connections on page 252.
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Create or Validate ODBC System DSN
Verify with the system administrator that the ODBC system DSN for the ODBC 
source that you will access to import data exists. Depending on your site, you 
may already have an ODBC system DSN established for the ODBC source. If 
you do not have a valid ODBC system DSN, create one.

Running the TSS ODBC Component on 64-Bit 
System
The TSS ODBC component is a 32-bit process. On a 64-bit operating system 
(for example, Windows Server 2012 x64), DSNs created using the Control 
Panel ODBC applet apply to 64-bit processes only. 

For 32-bit applications to use ODBC on a 64-bit machine, a DSN must be 
configured using a 32-bit ODBC applet. This can be invoked by running: 
%WINDOWS%\SysWOW64\odbcad32.exe.

Validate Login Access to the ODBC Source
To import data directly into Trillium Software System from an ODBC source, a 
TSS user with valid credentials must have login access to the ODBC source. 

Working with Excel Spreadsheets
If you want to use an Excel spreadsheet as your ODBC data source, you must:

 Create a Defined Name area for the required data. It is the defined 
name that appears in the table list when you create an entity.

 Use a system DSN with the Microsoft Excel driver.

 To create a Defined Name area

 1.   In Excel, open the spreadsheet that contains the data you want to use.

 2.   Select the required data.

 3.   From the Insert menu, select Name > Define.

 4.   Enter a name for this data source and click OK.
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Setting Up Oracle/IBM DB2 Data 
Source Connections
Make sure that you completed all of these steps:

 Ensure the TSS Repository Server is installed.
 Ensure that the appropriate Oracle/IBM DB2 client is installed on the 

repository server machine.
 Ensure that you can connect to Oracle/IBM DB2 from an Oracle/IBM 

DB2 client that is installed on the repository server machine.
 For Oracle, try to connect using the Oracle Network Configuration 

Assistant, or similar application.  
 For IBM DB2, try to connect through Command Center or Control 

Center, or a similar application.
 For Oracle, find the database name (that TSS accesses for data imports) 

by checking the name specified in the tnsnames.ora file. 
 For repository servers installed on UNIX, modify the TSS file tss_

profile to reflect your site configuration. See the procedure on To 
modify the tss_profile file on a UNIX Server on page 253.

 If you plan to modify date formats from an Oracle database, modify the 
oracleremote.sdf file. 

 Ensure that IBM DB2 and Oracle asynchronous I/O processes have not 
been removed to increase available memory. This action could result in 
connectivity failure to these RDBMS applications.

 Ensure that you have login access to your IBM DB2 or Oracle data 
sources.

 Define an IBM DB2 or Oracle data connection using the Repository 
Server Manager. (For this procedure, see the TSS Repository 
Administrator’s Guide.)

 If you installed Oracle or DB2 clients after the TS repository server 
installation, reboot the server to set environment variables.

The following steps are only necessary for repository servers on UNIX. If an 
Oracle/DB2 client is installed on the repository server for Windows, the 
environment information is automatically located through the system 
environment variables.
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When working with Trillium Software System, Inetd accesses tss_profile to 
gather environment information. By making the following changes to the tss_
profile file, you are ensuring that the Trillium Software System knows how 
to access Oracle and IBM DB2 databases.

 To modify the tss_profile file on a UNIX Server

 1.   Stop the Scheduler.

a. Verify that there are no users logged on to TSS.

b. Log in to the TSS server as the TSS administrator.

c. Change directories to /<Server Path>/metabase/bin. When you 
installed TSS, you were asked Where would you like to install the 
TSS 15 Repository Server? This is the directory represented by 
<Server Path>.

d. Type the command:

     ./scheduler -stop

 2.   Change to the /<Server Path>/etc directory.

 3.   Locate the file named tss_profile and open it for editing.

 4.   Add an entry to the file based on the following table:

 5.   You may be able to copy the required Oracle and IBM DB2 information 
from the file named .profile which is in the home directory of the user 
who installed Trillium Software System. 

Relational 
Database

Add

Oracle the entry:
export ORACLE_HOME=<path to Oracle client>

IBM DB2 an entry to run the db2profile script that is supplied with IBM 
DB2. Start the line in the script with a “. ” to ensure the 
environment gets updated.
For example:
. /home/db2inst/sqllib/db2profile
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 6.   If you are connecting to an Oracle database, set the library path 
variable to the location of the Oracle 32-bit libraries. The path name 
varies, depending on UNIX platform:

 7.   Verify that the path is exported.

 8.   Save and close the file.

 9.   Restart the Scheduler.

a. Make sure that you are logged on to the repository server as the 
TSS application administrator.

b. Make sure that you are in the directory:

    <Server Path>/metabase/bin

For example, if the repository server path is  
/TrilliumSoftware/server, then you would change 
directories to /TrilliumSoftware/server/metabase/bin.

 To enable modified date formats from Oracle databases

 1.   Open the file oracleremote.sdf for editing. This file is located in the 
repository server’s /etc directory (for example, <install path>/MBSW/
15/etc).

 2.   Add the following environment variables to the file: 
NLS_LANG 
NLS_DATE_FORMAT

For example:
set env(NLS_DATE_FORMAT) YYYYMMDD

Valid values for these variables are defined by Oracle. For more 
information, check with your Oracle system administrator. 

Platform Library Path Setting

AIX LIBPATH

Solaris LD_LIBRARY _PATH

Linux LD_LIBRARY_PATH
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Both variables are required for UNIX. Only the NLS_DATE_
FORMAT variable is required for Windows installations; the NLS_
LANG variable is set in the registry automatically.

 3.   Save and close the file.

Validate Access to the Relational Source
To import data into Trillium Software System directly from IBM DB2 or Oracle, 
a TSS user must have login access to IBM DB2 or Oracle. Ensure that you have 
a valid RDBMS user name and password.       

Troubleshooting Sybase
If you receive the following error when trying to load data from a Sybase 
source: Remote command failed, [DataDirect][ODBC Sybase Wire Proto-
col driver][SQL Server]Incorrect syntax near x, make sure that the 
Sybase ASE ODBC Driver configuration settings (Advanced tab) has the option 
Enable Quoted Identifiers selected.
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APPENDIX F Installing the SAP  
Add-On and Support 
Packages

This appendix describes installation of the SAP Add-On and installation of the 
SAP Add-On support packages, and includes pre-installation and post-
installation checklists. 

For SAP component installation instructions, see “Installing EDQ” on page 127.
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Pre-Installation Checklist
Before installing the SAP Add-On, review the following checklist. After 
installation, review the post-installation checklist provided on page 323. 

 Are there Business Add-Ins (BADIs) already installed that utilize the 
ADDRESS_CHECK and ADDRESS_SEARCH functions, for example, IS-
Media?

To verify whether there are existing BADIs

 1.   Using Transaction SE19, bring up the Search option and enter 
ADDRESS_CHECK or ADDRESS_SEARCH in the Definition name box, 
then run the search.

Figure F-1  Transaction SE19 Implementation Search Option
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A list of objects implemented against the definition name  
ADDRESS_CHECK or ADDRESS_SEARCH will display.

Figure F-2   Transaction SE19 List of Implementations

 2.   If there are BADIs already installed, contact Trillium Software Customer 
Support. If the list is empty, continue with the pre-installation checklist.

 Are you planning to install the Trillium SAP Add-On on both R/3 and 
CRM (to be able to configure so that both systems can process from one 
instance of TS Quality)?

 In which instance will the Add-On be initially installed?
•   Development
•   QA
•   Sandbox
•   Production (not a typical option)

 Do you have access to the SAP administrative level (Client 000) so you 
can install the Add-On?
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 Do you have access to the SAP customizing client level (Client 0xx) to 
activate BC-SET and configuration?

Supported SAP Versions
The SAP Add-On packages require one of the SAP versions identified in Table 
F-1. If the Support Package is not up to the required number, the 
prerequisite OSS Notes must be applied prior to the TS Quality 
Connector SAP Add-On installation. 

Table F-1  Supported SAP Versions   

Component  
Version

 
Basis  

Enhancement 
Packages 

ERP 6.0 7.xx Ehp1 - Ehp8
CRM 5.0 7.xx
CRM 2007 (6.0) 7.xx
CRM 7.0 7.xx Ehp1 - Ehp4
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Installing the SAP Add-On
The SAP Add-On is delivered as a set of standard SAP archive files according to 
the Basis or CRM versions, as described in Table F-2. If you have not yet done 
so, download the archives files from the TSS Download Center (File Portal) FTP 
website. 

Table F-2  SAP Add-On Delivered SAR Files by Basis

Directory File names File description

SAP700
(ERP 6.0 and CRM 
5.0)

EX854700.SAR
IN854700.SAR
UP854700.SAR
SP01854700.SAR

Upgrade from previous SAP application version
Initial Add-On installation
Upgrade to existing Add-On version 8.4 or lower 
Support package 01 for Add-On version 8.5.

CRM600 EX856700.SAR
IN856700.SAR
UP856700.SAR
SP01856700.SAR

Upgrade from previous SAP application version
Initial Add-On installation
Upgrade to existing Add-On version 8.4 or lower 
Support package 01 for Add-On version 8.5.

CRM700 EX857701.SAR
IN857701.SAR
UP857701.SAR
SP01857701.SAR

Upgrade from previous SAP application version
Initial Add-On installation
Upgrade to existing Add-On version 8.4 or lower 
Support package 01 for Add-On version 8.5.

CRM701 (Ehp1) EX858702.SAR
IN858702.SAR
UP858702.SAR
SP01858702.SAR

Upgrade from previous SAP application version
Initial Add-On installation
Upgrade to existing Add-On version 8.4 or lower
Support package 01 for Add-On version 8.5.

CRM702 (Ehp 2) EX859731.SAR
IN859731.SAR
UP859731.SAR
SP01859731.SAR

Upgrade from previous SAP application version
Initial Add-On installation
Upgrade to existing Add-On version 8.4 or lower
Support package 01 for Add-On version 8.5.

CRM703 (Ehp3) EX85A740.SAR
IN85A740.SAR
UP85A740.SAR
SP0185A740.SAR

Upgrade from previous SAP application version
Initial Add-On installation
Upgrade to existing Add-On version 8.4 or lower
Support package 01 for Add-On version 8.5.

CRM704 (Ehp4) EX85B750.SAR
IN85B750.SAR
UP85B750.SAR

Upgrade from previous SAP application version
Initial Add-On installation
Upgrade to existing Add-On version 8.4 or lower
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The Upgrade to version 8.5 should only be installed if you are 
upgrading from version 8.4 or lower. 
 
The Support Package for the Initial Add-On and the Upgrade Add-On 
should be installed after the Initial Add-On or the Upgrade has been 
installed. The support package names are SP01YYYZZZ.SAR, where  
 
01 = Support Package number, YYY = TS Quality version, and ZZZ is 
the SAP Basis version, for example SP01854700.SAR.

The SAP Add-On is installed into the existing SAP repository using the SAP 
Add-On installation tool. Generally, TS Connector for SAP Add-On loading and 
activation is the same for SAP ERP 6.0 and CRM, however the instructions are 
presented in two separate sections:

 “Installing the SAP Add-On for SAP ERP 6.0” on page 261
 “Installing the SAP Add-On for SAP CRM” on page 284

Each section contains instructions for the initial installation, upgrade 
installation, and support packages installation.

Installing the SAP Add-On for SAP ERP 
6.0
This section describes the installation process for the Initial, Upgrade and 
Support Packages for the SAP Add-On for SAP ERP 6.0.

Initial and Upgrade SAP Add-On Installation
The Initial and the Upgrade Add-On use the same installation procedure. They 
are loaded via the transaction /nSAINT (SAP Add-On Installation Tool).

 To install the Connector for SAP Add-On

 1.   Log into the SAP system, client 000 (zero-zero-zero), as a user that 
has the SAP_ALL profile.
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 2.   Invoke the SAP Add-On Installation tool by running transaction  
/nSAINT and click Start to begin the loading process.

Figure F-3  Add-On Installation Tool
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 3.   The Add-On Installation Tool dialog box opens.

Figure F-4  Add-On Installation Tool Dialog

On the Add-On Installation Tool menu, select  
Installation Package > Load Package > From frontend. The 
Select window opens.
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 4.   In the Look in text box, browse to [CDDRIVE:]\Trillium 
Software\TSQuality\15\SAPxxx\IN85nXXX.SAR (or 
UP85nXXX.SAR when installing the upgrade) where:

•   [CDDRIVE:] is the drive letter of the drive that contains the SAP 
Addendum installation software

•   xxx is the version of the SAP system, for example 700
•   n is the number assigned against the SAP version, for example 4 is 

assigned against 700
•   XXX is the SAP Basis version

 5.   Click Open.

Figure F-5  The Select CAR/SAR Archive Browser Window
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 6.   The Decompress Tool screen opens. Click Decompress.

Figure F-6  Decompress Tool
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 7.   On the Add-On selection screen, select the TRILLIUM add-on and 
click Continue.

Figure F-7  Add-On Installation Tool Selection Screen
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 8.   On the Support Package Selection screen, click Continue.

Figure F-8  Support Package Selection
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 9.   On the Installation Queue screen, click Continue.

Figure F-9  Installation Queue
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 10.   When prompted to add Modification Adjustment Transports to the 
queue, click No.

Figure F-10  Do Not Add to the Queue

 11.   A confirmation of import is requested. Click the check mark  
button to begin importing the Add-On.

Figure F-11  Confirmation Request Screen for the 
Add-On Installation
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 12.   During the import of the TS Connector for SAP Add-On, the Import 
status should display the following message: 
 "The add-on will now be imported with the displayed queue." 

Figure F-12  Add-On Import Queue Status
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 13.   When the import of the Add-On is complete, a success message is 
displayed. Click Logs to check the logs for possible errors.

Figure F-13  Success Message, Click Logs
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 14.   The log overview window opens. If any unexplainable errors are found 
in the log, contact the Trillium Software Customer Support Help Desk.

Figure F-14  Log Report
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 15.   Click Back to return to the Installation of Add-On screen and click 
Finish to complete the installation.

Figure F-15  Completing Installation
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 16.   The Installed Add-Ons window opens. Click Cancel to return to the 
SAP main menu.

Figure F-16  Installed Add-Ons Window
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SAP Add-On Support Package 
Installation (ERP)
Trillium Software periodically delivers support packages. To install a TS 
Connector for SAP Add-On support package, use the following procedure.

 To install a TS Connector for SAP Add-On Support Package

 1.   Log in to your SAP system in Client 000 (zero-zero-zero) as a user who 
has the SAP_ALL profile.

 2.   Invoke the SAP Support Package Installation Tool by running 
transaction /nSPAM. The Support Package Manager initial screen 
opens.

Figure F-17  Support Package Manager Initial Screen
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 3.   From the menu bar of the Support Package Installation Tool screen, 
select Support Packages > Load Package > From frontend.

Figure F-18  Load Package From Frontend
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 4.   Browse to the support package location and click Open.

Figure F-19  Browse and Open
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 5.   The Decompress Tool screen opens. Click the Decompress button.

Figure F-20  Select Support Package
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 6.   Click Display/Define.

Figure F-21  Display/Define
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 7.   Select the TRILLIUM component to import the support package and 
click the check mark button.

Figure F-22  Select Trillium Component

 8.   Select the support package and click the check mark button.

Figure F-23  Select Support Package
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 9.   When prompted to add Modification Adjustment Transports, click No.

Figure F-24  Do Not Add Modification Adjustment Transports

 10.   Select Support Package > Import Queue to import the selected 
package.

Figure F-25  Support Package Import Queue Initiating Screen
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 11.   A SPAM Import Queue confirmation pop-up opens. Click the check 
mark button to continue.

Allow some time for the import and activation to take place.

Figure F-26  SPAM Import Queue Confirmation

 12.   After the import and activation is completed, a confirmation of 
successful installation will display. Click the check mark button to 
finish the process.

Figure F-27  Successful Support Package Import 
Information 
282 Trillium Software System Installation Guide



Installing the SAP Add-On and Support Packages 
 13.   Select Support Package > Confirm to complete the process.

Figure F-28  Confirm to Complete Process

 14.   The message Support Package queue was confirmed will display 
near the bottom of the screen.
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Installing the SAP Add-On for SAP CRM 
This section describes the installation process for the Initial, Upgrade and 
Support Packages for the SAP Add-On for SAP CRM.

Initial and Upgrade SAP Add-On Installation
The Initial and the Upgrade Add-On use the same installation procedure. They 
are loaded via the transaction /nSAINT (SAP Add-On Installation Tool).

If you are performing an upgrade, ensure that you have a previous 
version of the Trillium v14 Add-on installed.

 To install the Connector for SAP Add-On

 1.   Log into the SAP system, client 000 (zero-zero-zero), as a user that 
has the SAP_ALL profile.
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 2.   Invoke the SAP Add-On Installation tool by running  
transaction /nSAINT.

Figure F-29  Add-On Installation Tool
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 3.   On the Add-On Installation Tool menu, select  
Installation Package > Load Package > From frontend. The 
Select CAR/SAR Archive dialog box opens. 

Figure F-30  Add-on Installation Tool

 4.   Browse to [CDDRIVE:]\Trillium Software\TSQuality\15\ 
CRMxxx\IN85nXXX.SAR (or UP85nXXX.SAR if upgrading) where:

•   [CDDRIVE:] is the drive letter of the drive that contains the SAP 
Addendum installation software

•   xxx is the version of the CRM system
•   n is the number assigned against the CRM version, for example 6 is 

assigned against CRM600
•   XXX is the SAP Basis version

 5.   Click Open.
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 6.   The Decompress Tool screen opens. Click Decompress.

Figure F-31  Decompress Tool
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 7.   On the Add-On selection screen, select the TRILLIUM add-on from 
the selection box.

Figure F-32  Add-On Installation Tool

 8.   From the Environment menu select Add-on Manager for EBP/CRM. 
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 9.   On the CRM Add-On Manager screen, click Continue.

Figure F-33  CRM Add-On Manager Steps Information
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 10.   On the next screen, select the Trillium Add-on Package, then click 
Continue.

Figure F-34  CRM Add-On Manager Package Selection
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 11.   To lock CRM online users while the package is applied, click Confirm 
and then click Continue.

Figure F-35  Lock CRM Online Users
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 12.   To confirm that users have been notified of the logoff, click Confirm 
then click Continue.

Figure F-36  Notify Users
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 13.   Ensure that all messages are processed. click Execute; on the next 
window click Back and then click Continue. 

Figure F-37  Messages Processed
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 14.   A confirmation of import is requested. Click the check mark  
button to begin importing the Add-On.

Figure F-38  Confirmation Request Screen for the 
Add-On Installation
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 15.   A message reports that the Add-on will be imported. Information 
messages will display; click the check mark button to continue. 

Figure F-39  Import Message
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 16.   To regenerate runtime objects, click Execute and then Continue.

Figure F-40  Regenerate Runtime Objects
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 17.   Restart CRM inbound queues, click Confirm, then click Continue.

Figure F-41  Restart CRM Inbound Queues
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 18.   Unlock CRM online users, click Confirm and then click Continue.

Figure F-42  Unlock CRM Online Users
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 19.   On the CRM Add-On Manager screen, click Continue.

Figure F-43  CRM Support Package Manager
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 20.   On the next screen, click Complete to finish the installation.

Figure F-44  Install Confirmation
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 21.   The Installed Add-Ons window opens. Click Cancel to return to the SAP 
menu.

Figure F-45  Installed Add-Ons Window
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SAP Add-On Support Package Installation (CRM)
Trillium Software periodically delivers support packages. To install a TS 
Connector for SAP Add-On support package, run transaction  
/nSPAM (SAP Support Package Installation Tool).

 To install the TS Connector for SAP Add-On Support Package

 1.   Log into the SAP system, client 000 (zero-zero-zero), as a user who 
has the SAP_ALL profile.

 2.   Invoke the SAP Support Package Installation Tool by running 
transaction /nSPAM. The Support Package Manager initial screen 
opens.

Figure F-46  Support Package Manager Initial Screen

 3.   From the menu bar of the Support Package Installation Tool screen, 
select Support Package > Load packages > From the frontend.
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 4.   Browse to the Support Package location and click Open.

Figure F-47  Select CAR/SAR Archive Dialog Box
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 5.   The Decompress Tool screen opens. Click Decompress.

Figure F-48  Decompress Tool
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 6.   From the menu bar of the Support Package Installation Tool screen, 
select Environment > Support Package Manager for EBP/CRM. 

Figure F-49  CRM Support Package Installation Tool
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 7.   On the CRM Support Package Manager screen, click Continue.

Figure F-50  CRM Support Package Manager Steps Information
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 8.   On the next screen, select the TRILLIUM software component, then 
click Continue. 

Figure F-51  CRM Support Package Management List Screen
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 9.   Select the Trillium Support Package, then click Continue.

Figure F-52  CRM Support Package Management Select Screen
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 10.   Read the Further Processing Steps message. Click Confirm and 
Continue.

Figure F-53  Further Processing Steps
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 11.   Read the Lock CRM Online Users message. Click Confirm and 
Continue.

Figure F-54  Lock CRM Online Users
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 12.   Read the Log Off Users Currently Logged On message. Click Confirm 
and Continue.

Figure F-55  Log Off Users
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 13.   Read the Make Sure All Messages Are Processed message. Click 
Execute, Back and Continue.

Figure F-56  Process All Messages
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 14.   On the SPAM Import Queue screen, click the check mark button to 
continue. 

Figure F-57  CRM Import Queue Confirmation
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 15.   On the Regenerate Runtime Objects on Template Changes screen, 
click Execute and Continue.

Figure F-58  Regenerate Runtime Objects
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 16.   Read the Restart CRM Inbound Queues message. Click Confirm and 
Continue.

Figure F-59  Restart Queues
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 17.   Read the Unlock CRM Online Users message. Click Confirm and 
Continue.

Figure F-60  Unlock Users
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 18.   On the next screen, review the information, then click Continue.

Figure F-61  CRM Support Package Management Steps Performed and Results
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 19.   A confirmation screen will open. Click Complete to finish the 
installation. 

Figure F-62  Complete the Installation
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 20.   You can check your system status to confirm that the Trillium Support 
Package is installed.

Figure F-63  Check Status

Additional Post-Installation Steps for CRM 7.0 Ehp1, 
Ehp2, Ehp3 and Ehp4
If you are installing CRM 7.0 Ehp1, Ehp2, Ehp3 and Ehp4, proceed with the 
following steps. All other users can proceed to “CRM WebClient Components” 
on page 322.

 1.   CRM 7.0 Ehp1, Ehp2, Ehp3 and Ehp4 users only: Apply the 
following OSS Notes:

 1599111 Incorrect check status after address validation (Ehp1 only)
 1623772 Address validation: Dynamic usage creation for popups 

(Ehp1 and Ehp2)
 1693004 Postal validation for standard address not done second 

time (Ehp1 and Ehp2)
 1919171 Important Address fields are not passed during fuzzy 

search (Ehp1, Ehp2 and Ehp3)
 2283873 (Ehp4)
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 2.   CRM 7.0 Ehp1, Ehp2, Ehp3 and Ehp4 users only: Deactivate BADI 
implementation MDG_BS_ADR_SEARCH_INITIAL_LOAD. 
 
You will need to obtain a repair key for object R3TR ENHO MDG_BS_
ADR_SEARCH_INITIAL_LOAD. 
 
In transaction SE19, change new BADI implementation MDG_BS_ADR_
SEARCH_INITIAL_LOAD. Uncheck the Implementation is active 
check box and activate the BADI.

Figure F-64  Activate the BADI
After activation, you should see that the Runtime Behavior is “The 
implementation will not be called.”
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Figure F-65  Implementation Not Called

 3.   CRM 7.0 Ehp1, Ehp2, Ehp3 and Ehp4 users only: Optionally, 
remove the message text from the address check pop-up view 
configuration for roles other than the IC WebClient.

 4.   CRM 7.0 Ehp1, Ehp2, Ehp3 and Ehp4 users only: Using transaction 
SM30, reduce the threshold on object type BUS1006 from 90.0 to 10.0 
in view BSV_DUPL_OBJ.

Figure F-66  Reduce Threshold
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CRM WebClient Components
If you will be using the CRM WebClient, import the following transport request 
into the SAP Client that you will be using to run the CRM WebClient 
application:

 For CRM 2007 (6.0) import transport C7DK900088
 For CRM 7.0 import transport R7DK900032
 For CRM 7.0 Ehp1, Ehp2, Ehp3 and Ehp4, import transport C71K900047

The transports are delivered in the SAR files for the add-on installation or 
upgrade. The appropriate transport should already be in your transport 
directory. Manually add the transport to your import queue and import it into 
the SAP client that you will be using to run the CRM WebClient applications.

For CRM 7.0 Ehp1, Ehp2, and Ehp3 when importing the request in STMS be 
sure to check the import options Ignore Non-permitted Transport Type 
and Ignore Invalid Component Version.

Figure F-67  Import Options

For CRM 7.0 Ehp4 when importing the request in STMS be sure to check the 
import options Ignore Invalid Transport Type and Ignore Invalid 
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Component Version.

Figure F-68  Ehp4 - Import Options

For more information on installation and implementation of the CRM 
WebClient, refer to the TS Connector for SAP Products Reference Guide.

Post-Installation Checklist
 If you installed the TS Quality Connector on Windows, reboot your 

computer.
 Activated BC-SET in SAP with no errors.
 Able to access Address Management with Trillium and can make 

modifications in this section.
 Activated required countries.
 Activated Index Pool.
 Installed all TS Quality Connector components with the correct 

parameters:
•   Path used: Absolute/Relative
•   Port number:
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•   Host name:
•   SAP Gateway Host name:
•   SAP Gateway Service name:

 RFC Server user and password created and defined in the TrilSAP.cfg.
 Configuration in SAPRFC.INI file matches RFC destination 

configuration in SAP.
 Windows – TS Quality services starts by using either the:

•   Director for TS Quality System Manager 
-or-

•   Administrative Tools -> Services
 UNIX – Confirm that the TS Quality services start by using either: 

•   The Director for TS Quality Console 
-or- 

•   The UNIX console using command: ps -ef | grep rill.
 Check permissions.
 Test the connection using transaction /nSM59.
 Check the number of threads available using transaction /nSMGW.
 Test to ensure that out-of-the-box is successful.
 Modify the path to postal tables and project or project template to 

utilize the complete version of postal tables and word patterns.
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